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Abstract 

ORA is a network analysis tool that detects risks or vulnerabilities of an organization’s design structure. 
The design structure of an organization is the relationship among its personnel, knowledge, resources, and 
tasks entities. These entities and relationships are represented by the Meta-Matrix. Measures that take as 
input a Meta-Matrix are used to analyze the structural properties of an organization for potential risk. 
ORA contains over 100 measures which are categorized by which type of risk they detect. Measures are 
also organized by input requirements and by output. ORA generates formatted reports viewable on screen 
or in log files, and reads and writes networks in multiple data formats to be interoperable with existing 
network analysis packages. In addition, it has tools for graphically visualizing Meta-Matrix data and for 
optimizing a network’s design structure. ORA uses a Java interface for ease of use, and a C++ 
computational backend. The current version ORA1.2 software is available on the CASOS website: 
http://www.casos.ece.cmu.edu/projects/ORA/index.html.  
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Release Notes 

Latest Version 

ORA 2.0 (January 2010) 

Notes 

The ORA help pages are in a constant state of revision. As the program 
evolves, grows and improves, the help files and examples attempt to follow 
suit as soon as possible. However, due to the rapid development of ORA, not 
every change reflected in the most recent version of ORA, will be listed here, 
only the major revisions. 

More recent screen shots will include the ORA software version. This should 
be a clear indication of the lag time between a particular section of help and 
the supporting documentation that accompanies it. Keep in mind: core 
functionality such as running reports, visualizing a model, building a model, 
and the math behind the algorithms may change in nuance or material 
presentation but should remain relatively stable from version to version.  

If you should encounter a feature that appears to be entirely without 
supporting documentation and instruction is needed immediately, please 
contact the CASOS Center immediately.  

 
Running ORA in Batch Mode 

January, 2010 
ORA Batch Mode XML 
Version 2.0.0 

I. Command Line Arguments 
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The program ora.exe (henceforth called ORA) takes one or more of the 
following command line arguments as input: (1) Measures File to be used, 
(2) the Script File to use, and (3) the Log File to use.  

If you installed the front-end of ORA, then the executable can be found as:  
[ORA installation directory] \include\OraFiles\bin\ora.exe 

Likewise, the Measures file can be found as: 
[ORA installation directory] \include\OraFiles\xml\ora_xml_measures.xml 

Measures File 

The Measures File is distributed with ORA and contains an XML encoded 
description of all the measures available to ORA. This is distributed with ORA 
and is usually called ora_xml_measures.xml. The following command line 
parameter specifies the filename: 

-measures <filename> 

Script File 

The Script File is an XML file created by the user and tells ORA where to load 
the input network data and which reports to generate. Section II - ORA 
Script XML Specification - describes in detail the format of this XML script. 
The following command line argument specifies the filename: 

-script <filename> 

Log File 

The Log File is generated by ORA to record the progress and problems of 
ORA in processing the Script File. The log file is a text file, and the following 
command line argument specifies its filename: 

-log <filename> 

Help 

A listing of the above parameters is available by using the following 
command line parameter: 

-help 

Version 
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The ORA version can be obtained by the following command line parameter: 

-version 

II. XML Script 

The batch mode script is a user supplied XML document that is input to ORA 
(see the -script command line parameter above). It tells ORA what network 
data to load and what reports to generate. 

Please note the following general guidelines for the script: 

1. camel case capitalization is used for element names: therefore element 
names begin lower case and the first letter of each word is capitalized. For 
example, Meta-Matrix is MetaMatrix. 

2. default values are used: therefore a short, simple script can initially be 
used to run ORA. Advanced users can change the default values. 

The root node is <ora>, which has two child elements <input> and 
<output>. The input element describes the network data to load, and the 
output section describes the reports to generate.  

Example: an empty script 
<ora> 
<input/> 
<output/> 
</ora> 

A. Input Section 

The main unit of input to ORA is the Meta-Matrix, and therefore the input 
section of the XML script tells ORA how to load one or more Meta-Matrices. A 
Meta-Matrix is simply an organization modeled as a collection of matrices. 
The entire Meta-Matrix can be loaded from a single data file, or each matrix 
can be loaded from separate data files with possibly different data formats.  

1. Meta-Matrix Specification 

A Meta-Matrix is specified by the <MetaMatrix> element. It accepts a single 
attribute called id which must be unique across all the Meta-Matrix elements.  
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The child elements describe the location and format of its matrix data. There 
are two cases: (1) all data for the Meta-Matrix is stored in a single file, (2) 
the data for matrices of the Meta-Matrix are located in separate files. 

1.1 Meta-Matrix data in a single file 

The first case is only possible for a data file in the DyNetML format. In this 
case, the <filename> and <format> children are required, and the 
<properties> child is optional. The child elements are described below:  

filename : location of the data 
format : must by DyNetML 
properties : [optional] Describes how ORA should interpret the data read 
from the file, but does not cause ORA to modify the input data in any way. 
Each graph in the Meta-Matrix is given the property.  

Properties are specified with the attributes below, each of which takes 
values: yes or no 

1. sparse: indicates whether the data is sparse 

2. binary: indicates whether the data should be treated as binary (i.e. 
ignore edge weights) 

3. symmetric: indicates whether the unimodal graphs should be 
considered symmetric 

4. diagonal: indicates whether the diagonal values of unimodal graphs 
should be used 

Example: 
<MetaMatrix id="Organization"> 
<filename>data/organization.xml</filename> 
<format>DyNetML</format> 
<properties binary="yes"/> 
</MetaMatrix> 

1.2 Meta-Matrix data in multiple matrix files 

The second case has the Meta-Matrix data located in multiple files. In this 
case, the script must describe how to assemble the Meta-Matrix from 
different data files.  
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Matrix data describes a relationship between two sets of nodes, called the 
source and target node sets. Therefore, in specifying a matrix, these 
nodesets must be specified. A unique id for the matrix is also specified. This 
id must be unique across all matrices in the meta-matrix. 

The <matrix> element defines a matrix and has the following case-
insensitive attributes: 

sourceType : type of the source node set  
source : [optional] unique identifier of the source node set  
targetType : type of the target node set 
target : [optional] unique identifier of the target node set  
id : [optional] id of the matrix 

The above attributes can be any string.  

The sourceType and targetType attributes specify the class or general 
category of the node sets. By convention, these are taken from Agent, 
Knowledge, Resource, Task, Location, or Organization, but any string can be 
used. 

The source and target attributes uniquely identify the source and target 
node sets, and if they are not specified the sourceType and targetType are 
used. To have more than one node set of a given type (e.g. "blue" agents 
and "red" agents), the source attribute must be used. 

The id uniquely identifies the matrix within the collection of matrices that is 
the meta-matrix. By default, the id is constructed from the source and target 
types. 

Examples: 
<matrix sourceType="agent" targetType="agent" id="reports to"/> 
<matrix sourceType="agent" source="employee" targetType="agent" 
target="employee" id="works with"/> 
 
As in the first case, the <matrix> element must have the child elements 
<filename> and <format> that describe the location and format of the 
matrix data. The <properties> element is optional, and pertains only to the 
matrix. 

The <format> element takes one of the following values: 

DyNetML : DyNetML specified data 
ucinet : UCINET binary format (refer to UCINET documentation) 
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dl : UCINET text format (refer to UCINET DL documentation) 
csv : CSV (Comma Separated Values) allows row and/or column labels 
raw : space, comma, or semi-colon separated data (no labels allowed) 

Example: 
<MetaMatrix id="SampleOrganization"> 
<matrix sourceType="agent" targetType="agent" id="communication"> 
<filename>data/organization_agent_agent.dl</filename> 
<format>dl</format> 
</matrix> 
</MetaMatrix> 

Multiple <matrix> elements are used to define the constituent matrices of 
the Meta-Matrix. Note that <MetaMatrix> has no immediate <filename> and 
<format> children since the data is described under the <matrix> child 
elements. 
 
Example: 
<ora> 
<input> 
<MetaMatrix id="SampleOrganization"> 
<matrix sourceType="agent" targetType="agent" id="social"> 
<filename>data/organization_agent_agent.dl</filename> 
<format>dl</format> 
</matrix> 
<matrix sourceType="agent" targetType="knowledge"> 
<filename>data/organization_agent_knowledge.dl</filename> 
<format>dl</format> 
</matrix> 
</MetaMatrix> 
</input> 
</ora> 

In the example, the Meta-Matrix contains two matrices: the first of type 
Agent x Agent and named social, and it is populated with data from the 
specified file of the specified format. The second has type Agent x 
Knowledge, and no name is specified. 

1.3 Multiple Meta-Matrices 

Multiple Meta-Matrices can be specified in the <input> section using unique 
id attributes. 
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Example: multiple meta-matrices differentiated by id attribute 
<ora> 
<input> 
<MetaMatrix id="SampleOrganization1"> 
<matrix sourceType="agent" targetType="agent" id="social"> 
<filename>data/organization_agent_agent.dl</filename> 
<format>dl</format> 
</matrix> 
<matrix sourceType="agent" targetType="agent" id="friendship"> 
<filename>data/organization_agent_agent_friend.csv</filename> 
<format>csv</format> 
</matrix> 
<matrix sourceType="agent" targetType="knowledge"> 
<filename>data/organization_agent_knowledge</filename> 
<format>ucinet</format> 
</matrix> 
</MetaMatrix> 
<MetaMatrix id="SampleOrganization2"> 
<filename>data/organization2.xml</filename> 
<format>DyNetML</format> 
</MetaMatrix> 
</input> 
</ora> 

1.3 Meta-Matrix Directories 

If there are multiple DyNetML files in a single directory, then one can specify 
the directory and ORA will create a meta-matrix from each file. The 
<metaMatrixDirectory> element is used, whose only attribute is name that 
specifies the path of the directory. Each file must have .xml extension. A 
<transform> element can be used within the element to apply to each meta-
matrix. The id for each meta-matrix is its filename. 

Example: load all meta-matrices from a directory 
<ora> 
<input> 
<metaMatrixDirectory name="data/sample/"> 
<transform> 
<conform method="union"/> 
</transform> 
</metaMatrixDirectory> 
</input> 
</ora> 
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B. Output Section 

The second section of the script file is the <output> element, and it 
describes which reports to generate. The reports available in ORA and how 
to specify them in the ora-script is documented in the file ORA-batch-mode-
parameters.xml, which is an XML specification in Relax-NG. 

ORA-Script Report Generation 
To tell ORA to create a report, the <reports> child element is used in the 
ora-script. The <reports> child element contains a collection of <report> 
elements. Each report element specifies any input parameters, the output 
filename, and the output file type/format. Each <report> is uniquely 
identified by its id attribute. 

The <filename> child specifies the name of the output file to create. The 
filename should NOT have an extension. The <formats> child contains one 
or more <format> children which specify the format of the report output. 

For each report, the possible formats are: text, html, csv, DyNetML 

Example: generating a report in multiple output formats 
<report id="intelligence"> 
<filename>reports/intelligence</filename> 
<formats> 
<format>text</format> 
<format>csv</csv> 
</formats> 
</report> 

Any report specific parameters are designated within the <parameters> 
child. The parameters for each report are documented in the file: 
ora_xml_measures.xml 

Example: specifying report parameters 
<report id="intelligence"> 
<parameters> 
<numberOfKeyEntities>10</numberOfKeyEntities > 
</parameters> 
<filename>reports/intelligence</filename> 
<formats> 
<format>html</format> 
<format>csv</format> 
</formats> 
</report> 
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Example: shorter script if only one output format is specified 
<report id="intelligence" filename="reports/intelligence" format="text"> 
<parameters> 
<numberOfKeyEntities>10</numberOfKeyEntities > 
</parameters> 
</report> 

3. Saving Meta-Matrices 

The input Meta-Matrices can themselves be saved to files. This allows for 
converting between matrix formats and for saving transformed or conformed 
input data. 

Example: saving a specific meta-matrix 
<ora> 
<output> 
<metaMatrices> 
<MetaMatrix id="sample"> 
<filename>data/output/sample.xml</filename> 
<format>DyNetML</format> 
</MetaMatrix> 
</metaMatrices> 
</output> 
</ora> 

Only the specified Meta-Matrices will be saved. Individual matrices can be 
saved using the syntax identical to that of the <matrix> element in the input 
section. The following, for example, saves the agent x agent matrix: 

Example: saving a specific matrix from a meta-matrix 
<ora> 
<output> 
<metaMatrices> 
<MetaMatrix id="sample"> 
<matrix sourceType="agent" targetType="agent"> 
<filename>data/output/sample_agent_agent.dl</filename> 
<format>dl</format> 
</matrix> 
</MetaMatrix> 
</metaMatrices> 
</output> 
</ora> 
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In addition, network set operations (union, intersection, difference) can be 
performed on the input networks and then saved. The sample below 
assumes that there were two meta-matrices specified in the <input> 
section, namely, A and B, and the set operations all pertain to them. Union 
and Intersect operate on one or more input meta-matrices, and the 
parameter method indicates how to handle common edges. The method 
attribute takes on one of the following values: binary, sum, maximum, or 
minimum. The difference between two meta-matrices is taken with respect 
to edges only, and thus no nodes are removed. 

Example: saving union of multiple input meta-matrices 
<output> 
<metaMatrices> 
<!--Union--> 
<MetaMatrix id="A Union B"> 
<filename>data/output/A-union-B.xml</filename> 
<format>DyNetML</format> 
<union method="sum"> 
<MetaMatrix id="A"/> 
<MetaMatrix id="B"/> 
</union> 
</MetaMatrix> 
<!--Intersect--> 
<MetaMatrix id="A Intersect B"> 
<filename>data/output/A-intersect-B.xml</filename> 
<format>DyNetML</format> 
<intersect method="minimum"> 
<MetaMatrix id="A"/> 
<MetaMatrix id="B"/> 
</intersect> 
</MetaMatrix> 
<!--Difference (edges only)--> 
<MetaMatrix id="A Minus B"> 
<filename>data/output/A-minus-B.xml</filename> 
<format>DyNetML</format> 
<difference> 
<MetaMatrix id="A"/> 
<MetaMatrix id="B"/> 
</difference> 
</MetaMatrix> 
</metaMatrices> 
</output> 
</ora> 
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4. Transform Element 

The transform element is used to pre-process a Meta-Matrix or an individual 
matrix of a Meta-Matrix before generating reports. It transforms its parent 
element. For example, if the <transform> element is a child of a <matrix> 
then it applies to that matrix. If it is a child of <MetaMatrix>, then it 
transforms the entire Meta-Matrix: for node set modifications (removeNodes, 
subsetNodes, conform), these apply to the Meta-Matrix as a whole, but 
transformations of edges (symmetrizing, dichotomizing) are applied to each 
matrix independently. 
 
The <transform> element has the following child elements that define the 
transformation: 

<transpose> : transpose the graph 

<removeIsolates> : remove isolate nodes  
 
<removePendants> : remove pendant nodes  

<symmetrize method=””> : symmetrize using one of two methods 
“union” : symmetrize using the union/maximum method 
“intersect” : symmetrize using the intersect/minimum method 
Default is “union”. 

<subsetNodes> : defines a subset of nodes to create a subgraph 
contains one or more of the following child elements: 
<nodeSet type=””/> : adds all nodes in the specified node set to the subset.  
 
The type attribute can have values: agent, knowledge, resource, task, 
organization 

<node type=”” id=”” radius=””/> : adds the specified node to the subset 
The type attribute is identical to that of the <nodeSet> element.  
 
The id attribute is the node’s unique id within the node set. 
 
The radius attribute is optional (by default it is zero), and includes all nodes 
within a distance <= radius of the node. This is useful for defining ego node 
sets. 

<removeNodes> : defines a subset of nodes to remove 
contains the same <nodeSet> and <node> child elements as subsetNodes 
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<conform method=""/> : creates an identical set of nodes across meta-
matrices. This is useful for time-series data to give each Meta-Matrix the 
same node sets. The union method adds isolates to achieve identical sets, 
and the intersect method removes nodes. 

The method attribute can have one of two values: 
union: create union of node sets  
intersect: create intersection of node sets 
Default is "union". 

By default the agent, knowledge, resource, task, and organization node sets 
are conformed. This can be customized by adding <nodeSet> child elements 
to specify specific node sets, as in subsetNodes above. 

<dichotomize criteria="" cutoff=""/> : creates a binary graph according to 
the criteria and cutoff. Any edges whose value does not satisfy the criteria 
and cutoff are given a value of 0, otherwise a value of 1. 
 
The criteria attribute takes one of the following values: 
lessThan, lessThanEquals, equals, greaterThanEquals, greaterThan 
 
The cutoff attribute can be any numerical value. 

Precedence 
The order (i.e. precedence) in which the transformations occur is as follows: 
(1) individual matrices, (2) meta-matrices, (3) across meta-matrices. Each 
of these usages is in the examples below. 

The precedence of operations within a transform (for example, is the graph 
symmetrized before dichotomizing, etc.) is defined to be the same as they 
are specified in the <transform> element. Thus, if the <symmetrize> child 
is before the <dichotomize> child, then the transformation first symmetrizes 
and then dichotomizes. 

Example: remove all agent nodes and the specified knowledge nodes from 
the meta-matrix 
<MetaMatrix id="test"> 
<transform> 
<removeNodes> 
<nodeset id="agent"/> 
<node nodesetId="knowledge" id="physics"/> 
<node nodesetId="knowledge" id="mathematics "/> 
</removeNodes> 
</transform> 
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<filename>data/sample.xml</filename> 
<format>DyNetML</format> 
</MetaMatrix> 

Example: symmetrize a single matrix of the meta-matrix 
<MetaMatrix id="test"> 
<matrix sourceType="agent" targetType="agent"> 
<filename>data/aa.csv</filename> 
<format>csv</format> 
<transform> 
<symmetrize method="union"/> 
</transform> 
</matrix> 
<matrix sourceType="agent" targetType="knowledge"> 
<filename>data/ak.csv</filename> 
<format>csv</format> 
</matrix> 
</MetaMatrix> 

This example creates a sub-Meta-Matrix as follows: a set of nodes is defined, 
and then the Meta-Matrix induced by the nodes (that is, all the edges 
incident upon those nodes). The set of nodes consists of all nodes within 
distance 2 of agent Andy and within distance one of Sam. Because the 
transform is part of the Meta-Matrix, knowledge, task, or organization nodes 
can be connected to these agents, and would therefore be part of the set. 

Example: define a subset of nodes 
<MetaMatrix id="test"> 
<transform> 
<subsetNodes> 
<node nodesetId="agent" id="Andy" radius="2"/> 
<node nodesetId="agent" id="Sam" radius="1"/> 
</subsetNodes> 
</transform> 
<filename>/data/myorg.xml</filename> 
<format>DyNetML</format> 
</MetaMatrix> 

 
This example makes the agent nodes in the meta-matrices conformable by 
creating the union of all the agent node sets across the meta-matrices. 
Currently, only agent nodes can be made conformable. 
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Example: conform nodesets across meta-matrices 
<input> 
<transform> 
<conform method="union"/> 
</transform> 
<MetaMatrix id="org1"> 
<filename>data/org1.xml</filename> 
<format>DyNetML</format> 
</MetaMatrix> 
<MetaMatrix id="org2"> 
<filename>data/org2.xml</filename> 
<format>DyNetML</format> 
</MetaMatrix> 
<MetaMatrix id="org3"> 
<filename>data/org3.xml</filename> 
<format>DyNetML</format> 
</MetaMatrix> 
</input> 

 
Glossary 

A | B | C | D | E | F | G | H | I | J | K | L | M | N | O | P | Q | R | S | T | U | 
V | W | X | Y | Z  

A | Top 

Adjacency Matrix – A Matrix that is a square actor-by-actor (i=j) matrix 
where the presence of pair wise edges are recorded as elements. The main 
diagonal, or self-tie of an adjacency matrix is often ignored in network 
analysis. 

Aggregation – Combining statistics from different entities to higher entities. 

Algorithm – A finite list of well-defined instructions for accomplishing some 
task that, given an initial state, will terminate in a defined end-state. 

Attribute – Indicates the presence, absence, or strength of a particular 
connection between entities in a Matrix. 

B | Top 
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Betweenness – Degree an individual lies between other individuals in the 
network; the extent to which an entity is directly connected only to those 
other entities that are not directly connected to each other; an intermediary; 
liaisons; bridges. Therefore, it's the number of entities who an entity is 
connected to indirectly through their direct links. 

Betweenness Centrality – High in betweenness but not degree centrality. 
This entity connects disconnected groups, like a Go-between. 

Bimodal Network – A network most commonly arising as a mixture of two 
different unimodal networks*. 

Binarize – Divides your data into two sets; zero or one. 

Bipartite Graph – Also called a bigraph. It's a set of entities decomposed 
into two disjoint sets such that no two entities within the same set are 
adjacent. 

C | Top 

Caesar III – An application for the design of information processing and 
decision making organizations. An application for the design of decision 
making organizations at the operational and tactical levels; it takes into 
consideration cultural differences in coalitions and of adversaries. This tool is 
under development by George Mason University.  

Categorical – An Attribute Type used primarily used for grouping nodes. 

Centrality – The nearness of an entity to all other entities in a network. It 
displays the ability to access information through edges connecting other 
entities. The closeness is the inverse of the sum of the shortest distances 
between each entity and every other entity in the network. 

Centralization – Indicates the distribution of connections in the employee 
communication network as the degree to which communication and/or 
information flow is centralized around a single agent or small group. 

Characteristic Path Length – The median of the average shortest 
distances (number of links) connecting each employee to all other 
employees.  

Interpretation 
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Characteristic path length gives a insight into how information spreads. It 
reflects the communication performance of the entire network and is 
important for diffusing information and routing information to the right 
people. A small average path length results in fewer "hops" where 
individuals or groups don't get information. 

Classic SNA density – The number of edges divided by the number of 
possible edges not including self-reference. For a square matrix, this 
algorithm* first converts the diagonal to 0, thereby ignoring self-reference 
(an entity connecting to itself) and then calculates the density. When 
there are N entities, the denominator is (N*(N-1)). To consider the 
self-referential information use general density. 

Clique – A sub-structure that is defined as a set of entities where every 
entity is connected to every other entity. 

Clique Count – The number of distinct cliques to which each entity belongs. 

Closeness – Entity that is closest to all other Entities and has rapid access 
to all information. 

Clustering coefficient – Used to determine whether or not a graph is a 
small-world network. 

Cognitive Demand – Measures the total amount of effort expended by each 
agent to do its tasks. 

Column Degree – see Out Degree*. 

Complexity – Complexity reflects cohesiveness in the organization by 
comparing existing links to all possible links in all four networks (employee, 
task, knowledge and resource).  

Complementarily – The idea that people seek others with characteristics 
that are different from and complement their own, aka the idea that 
opposites attract. 

Concor Grouping – Concor recursively splits partitions and the user selects 
n splits. (n splits -> 2n groups). At each split it divides the entities based 
on maximum correlation in outgoing connections. Helps find groups with 
similar roles in networks, even if dispersed. 

Congruence – The match between a particular organizational design and 
the organization's ability to carry out a task. 
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Construct – A reduced form of Construct is found in ORA in the Near Term 
Impact Report. 

Continuous – A Attribute Type primarily used for values that are numerical 
so that statistical analysis can be performed (Average, Minimum, Maximum, 
and Standard Deviation). 

Count – The total of any part of a MetaMatrix row, column, entity, edge, 
isolate, etc. 

CSV – File structure meaning Comma Separated Value. Common output 
structure used in database programs for formatting data. 

D | Top 

Degree – The total number of edges to other entities in the network. 

Degree Centrality – Entity with the most connections. (i.e. In the know). 
Identifying the sources for intel helps in reducing information flow. 

Density –  

• Binary Network: The proportion of all possible edges actually present 
in the Matrix. 

• Value Network: The sum of the edges divided by the number of 
possible edges. (i.e. the ratio of the total edge strength that is 
actually present to the total number of possible edges). 

Dyad – Two entities and the connection between them. 

Dyadic Analysis – Statistical analysis where the data is in the form of 
ordered pairs or dyads. The dyads in such an analysis may or may not be for 
a network. 

Dynamic Network Analysis – Dynamic Network Analysis (DNA) is an 
emergent scientific field that brings together traditional Social Network 
Analysis* (SNA), Link Analysis* (LA) and multi-agent systems (MAS). 

DyNetML – DyNetML is an xml based interchange language for relational 
data including nodes, ties, and the attributes of nodes and ties. DyNetML is a 
universal data interchange format to enable exchange of rich social network 
data and improve compatibility of analysis and visualization tools. 
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E | Top 

Edge – See Link. 

Entity – A who, what, where, how, why, or thing that is being studied such 
as people, agents, organizations, beliefs, expertise, resources, tasks, events, 
or locations. Node the representation of a single entity (a who, what, where, 
how why item). 

Entity Class – A set of entities of one type. 

Entity Level Metric – is one that is defined for, and gives a value for, each 
entity in a network. If there are x entities in a network, then the metric is 
calculated x times, once each for each entity. Examples are Degree Centrality*, 
Betweenness*, and Cognitive Demand*. 

Entity Set – See Meta-Node. 

Eigenvector Centrality – Entity most connected to other highly connected 
entities. Assists in identifying those who can mobilize others 

F | Top 

FOG – (F)uzzy (O)verlapping (G)roups. Gives a better understanding of 
individuals spanning groups. Fuzzy groups are a more natural and 
compelling way of thinking of human social groups. 

G | Top 

General density – The number of edges divided by the number of possible 
edges including self-reference. For a square matrix, this algorithm* includes 
self-reference (an entity connecting to itself) when it calculates the 
density. When there are N entities, the denominator is (N*N). To ignore self-
referential information use classic SNA* density. 

Geodesic Distance – A generalization of the notion of a straight line to 
curved spaces. In presence of a metric, geodesics are defined to be 
(locally) the shortest path between points on the space. 

Gini coefficient – The measure of inequality of a distribution of income. 
Uses a ratio with values between 0 and 1: the numerator is the area 
between the Lorenz curve of the distribution and the uniform (perfect) 
distribution line; the denominator is the area under the uniform distribution 
line. 
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Graph Level Metric – A metric defined for, and gives a value for, the 
network as a whole. The metric is calculated once for the network. 
Examples are Centralization, Graph Hierarchy, and the maximum or 
average Betweenness. 

GraphML – GraphML is a comprehensive and easy-to-use file format for 
graphs. It consists of a language core to describe the structural properties of 
a graph and a flexible extension mechanism to add application-specific data. 

Group – a collection of things (entities, nodes, ties, networks).   A group 
might at times be represented as a meta-node.   Nodes may be classified in 
to groups on the basis of a shared attribute, type, id-range, label, user 
selection, etc.   For example, if you have a set of people and know their 
gender, then their might be two groups - men and women.   In addition the 
nodes representing those people could be displayed as a meta-node for men 
and a meta-node for women.   Nodes may be classified in to groups on the 
basis of a grouping algorithm.   For example, if you have a network showing 
connections among members of an organization and you run a grouping 
algorithm it will return clusters of nodes that fit together on some 
mathematical criteria.   This cluster is a group and can be represented as a 
meta-node. 

H | Top 

Hamming Distance – Number minimum number of substitutions required 
to change one string into another string of equal length. (i.e. "toned" and 
"roses" is 3.) 

Heuristics – Problem-solving by trial and error: a method of solving a 
problem for which no formula exists, based on informal methods or 
experience, and employing a form of trial and error iteration. 

Homophily – (i.e., love of the same) is the tendency of individuals to 
associate and bond with similar others. 

• Status homophily means that individuals with similar social status 
characteristics are more likely to associate with each other than by 
chance. 

• Value homophily refers to a tendency to associate with others who 
think in similar ways, regardless of differences in status. 

HTML – HyperText Markup Language. 
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I | Top 

In-Degree – The sum of the connections leading to an entity from other 
entities. Sometimes referred to row degree. 

Influence network – A network of hypotheses regarding task performance, 
event happening and related efforts. 

Interstitial – An interstitial (something "in between") is a node situated 
within but not restricted to or characteristic of a particular group. It provides 
extra information to the analysis. 

Isolate – any entity which has no connections to any other entity 

L | Top 

Latent Semantic Analysis – Latent semantic analysis (LSA) is a technique 
in natural language processing, in particular in vectorial semantics, of 
analyzing relationships between a set of documents and the terms they 
contain by producing a set of concepts related to the documents and terms. 

Lattice Network – A graph in which the edges are placed at the integer 
coordinate points of the n-dimensional Euclidean space and each entity 
connects to entities which are exactly one unit away from it. 

Link – The representation of the tie, connection, relation, edge between two 
nodes. 

Link Analysis – A scientific area focused on the study of patterns emerging 
from dyadic observations. The relationships are typically a form of co-
presence between two entities. Also multiple dyads that may or may not 
form a network. 

Link Class – A set of Links of one type. A set of links of one type can be 
represented as a meta-link. 

M | Top 

Main Diagonal – in a square matrix this is the conjunction of the rows and 
cells for the same entity. 

Math Terms 

These mathematical terms and symbols are used: Let S be any set: 
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• card(S) = |S| = the cardinality of S (the cardinality of the entity-sets 
is represented as |A|, |K|, |R|, |T|) 

• ℜ denotes a real number 

• Z denotes an integer 

Matrix Algebra – The part of algebra that deals with the theory of matrices. 

Measure – A measure is a function that maps one or more networks to Rn. 
Measures are often scalar (n=1) or vector valued with n=|V| or n=|U|. 

Meta-Link – The representation of a Group of Links. 

MetaMatrix – See Meta-Network 

Meta-Network – The representation of a Group of Networks. 

Meta-Node – A representation of a Group of nodes. 

Monte Carlo – A random optimization of your organization 

MRQAP - This describes a report in ORA. See Reports for more information. 
For multivariate cases, if your dependent variable is continuous or count 
data (like in a negative binomial case), you should use MRQAP. If your 
dependent variable is binary, you should use ERGM (P*) which is 
forthcoming in ORA. One can perform MRQAP on data that have a 
dichotomous dependent variable (basically, this is equivalent to using a 
linear probability model). You do need to interpret your results accordingly. 

Multi-Agent System – A loosely coupled network of problem-solver entities 
that work together to find answers to problems that are beyond the 
individual capabilities or knowledge of each entity 

Multi-entity – More than one type of entity (people, events, locations, 
etc.). 

Multi-plex – Network where the links are from two or more relation classes. 

Multimode Network – Where the entities are in two or more entity classes. 

N | Top 

Neighbors – Entities that share an immediate edge to the entity selected. 
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Network – The representation of a set of nodes (including meta-nodes) of 
one type and the links (including meta-links) of one type between them. 

A network N is a triple consisting of two sets of entities, called U and V, and 
a set of edges E⊂UxV. Thus, we write N=(U,V,E). An element e = (i,j) in E 
indicates a relationship or tie between entities i∈U and j∈V. A network where 
U=V and therefore E⊂VxV is called unimodal*; otherwise the network is 
bimodal*. We write G=(V,E) for unimodal* networks. For our purposes, 
unimodal networks will not contain self loops, which means that (i,i)∉E for 
i∈V. 

Network Class – A set of Networks on one type. This can also be 
represented as a Meta-Network. 

Network data format – usually comes in the form of NodeSet 1 listed 
vertically in column A starting in row 2 and NodeSet 2 listed horizontally in 
row 1 starting with column B. All the intersecting cells are the links between 
each of the nodes. 

Newman Grouping – Finds unusually dense clusters, even in large 
networks. 

Node – A representation of a real-world entity (a who, what, where, how, 
why item. 

Node Class – A set of nodes of one type. Note a set of nodes of one type 
can be represented as a meta-node. 

Normalized Sum – Otherwise known as the Average. 

Notation: 

The following matrix notation is used throughout the document for an 
arbitrary matrix X: 

• X(i,j) = the entry in the ith row and jth column of X 

• X(i,:) = ith row vector of X 

• X(:,j) = jth column vector of X 

• sum(X) = sum of the elements in X (also, X can be a row or column 
vector of a matrix) 
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• dich(X) = dichotomize (make binary) X, so that dich(X)(i,j) = 1 iff 
X(i,j) > 0 

• X' = the transpose of X 

• ~X = for binary X, ~X(i,j) = 1 iff X(i,j) = 0 

• X@X = element-wise multiplication of two matrices (e.g. Z=X@Y => 
Z(i,j) = X(i,j)*Y(i,j)) 

O | Top 

ODBC – (O)pen (D)ata (B)ase (C)onnectivity is an access method developed 
by the SQL Access group in 1992 whose goal was to make it possible to 
access any data from any application, regardless of which database 
management system (DBMS) is handling the data. 

Ontology – "The Specifics of a Concept". The group of entities, 
resources, knowledge, and tasks that exist in the same domain and are 
connected to one another. It's a simplified way of viewing the information. 

Organization – A collection of networks. 

Out-Degree – The sum of the connections leading out from an entity to 
other entities. This is a measure of how influential the entity may be. 
Sometimes referred to as column degree. 

P | Top 

Pajek – A visual tool for analyzing large networks (networks having 
thousands of vertices). 

Path – A set of nodes and links that form a single unbroken chain, such that 
no node or link is repeated. i.e. A ⇒ B ⇒ C ⇒ D ⇒ E 

Pendant – Any entity which is only connected by one edge. They appear to 
dangle off the main group. 

Percolation Theory – The behavior of connected clusters in a random 
network. 

Pythia – Program used to create Influence Nets. Pythia is a timed influence 
net application. This tool can downloaded at the following URL: 
http://sysarch.gmu.edu/main/software/. 

http://sysarch.gmu.edu/main/software/�
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Q | Top 

QAP Correlation – Calculates measures of nominal, ordinal, and interval 
association between the relations in two matrices, and uses quadratic 
assignment procedures to develop standard errors to test for the significance 
of association. 

QAP is designed as a bivariate test (only two variables). Generally, QAP is 
perfectly fine for almost any bivariate network problem. 

R | Top 

Random Graph – One tries to prove the existence of graphs with certain 
properties by assigning random edges to various entities. The existence of a 
property on a random graph can be translated to the existence of the 
property on almost all graphs using the famous Szemerédi regularity lemma*. 

Reciprocity – The percentage of entities in a graph that are bi-directional. 

Redundancy – Number of entities that access to the same resources, are 
assigned the same task, or know the same knowledge. Redundancy occurs 
only when more than one agent fits the condition. 

Relation – The way in which entities in one class relate to entities in 
another class. 

Robustness – Two different definitions:  

• Networks – Concerned with the reliability (Kim & Madard, 2004) and 
continued functioning of a network following an intervention. The 
robustness of a network is particularly relevant in communication-type 
and flow-oriented networks. The purpose for understanding robustness 
of a network has more of a management of the network connotation. 

• Measures – This meaning has more of a statistical connotation. 
Studying the robustness of a measure of a network can also be 
referred to as conducting a sensitivity analysis on the measure. In 
keeping with the terminology of the most-recently published research 
in this area, in lieu of using the term sensitivity, we too will use the 
robustness term, although the terms can be used interchangeably. 
A measure is robust if a slight perturbation in its input 
produces a slight change in its output. 

Row Degree – see In Degree*. 
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S | Top 

Scale-Free Network – Some entities act as highly connected hubs (high 
degree), although most entities are of low degree. Scale-free networks' 
structure and dynamics are independent of the system's size N, the number 
of entities the system has. A network that is scale-free will have the same 
properties no matter what the number of its entities is. 

Self-Loop – An entity with a connection to itself. 

Shapefile - The GIS Visualizer can view overlay a Meta-Network over a 
map. The map is a shapefile: a digital vector storage format for storing 
geometric location and associated attribute information. A "shapefile" 
commonly refers to a collection of files with ".shp", ".shx", ".dbf", and other 
extensions on a common prefix name (e.g., "lakes.*"). For example, 
Shapefiles could represent water wells, rivers, and lakes, respectively. Each 
item may also have attributes that describe the items, such as the name or 
temperature. 

Simmelian Ties – Two entities are Simmelian Tied to one another if they 
are reciprocally and strongly tied to each other and strongly tied to at least 
one third party in common. 

Simulated Annealing – A method of finding optimal values numerically. 
It's a search method as opposed to a gradient based algorithm. It chooses a 
new point, and (for optimization) all uphill points are accepted while some 
downhill points are accepted depending on a probabilistic criteria. 

The term Simulated Annealing draws its inspiration from metallurgy, 
where atoms within a metal are heated thereby dislodging them from a 
metal's internal structure transforming the metal into another atomic state. 
In this way, your organization is heated changing its components in the 
attempt to arrive at an optimized state. 

Slow Measures – As the name implies these measures generally take 
longer to run. 

Small-World Network – Small-World Networks will have sub-networks that 
are characterized by the presence of connections between almost any two 
entities within them. 

Social Network Analysis – The term Social Network Analysis (or SNA) is 
used to refer to the analysis of any network such that all the entities are of 
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one type (e.g., all people, or all roles, or all organizations), or at most 
two types (e.g., people and the groups they belong to). 

Sphere of Influence – One entity's direct relationship with one of it's 
neighbors as a function of specified path length. 

Standard Deviation – The square root of the variance where variance is 
the average of the squared differences between data points. 

.stl file format – This file format is native to the stereolithography CAD 
software created by 3D Systems. STL files describe only the surface 
geometry of a three dimensional object without any representation of color, 
texture or other common CAD model attributes and can us both ASCII and 
binary representations 

Szemerédi's Regularity Lemma – A fundamental structural result in 
external graph theory due to Szemerédi (1978). The regularity lemma 
essentially says that every graph can be well-approximated by the union of a 
constant number of random-like bipartite graphs, called regular pairs. 

T | Top 

Table data format – Table data usually contains a column with referencing 
IDs and headers denoting column names. 

Tie – see Link 

Topology – The study of the arrangement or mapping of the elements 
(links, nodes, etc.) of a network, especially the physical (real) and logical 
(virtual) interconnections between nodes. 

Total Degree Centrality – The normalized sum of an entity's row and 
column degrees. 

Trail – A set of nodes and links that form a single unbroken chain that can 
revisit nodes but not links. i.e. A ⇒ B ⇒ C ⇒ A ⇒ D 

Transpose – In linear algebra, the transpose of a matrix A is another matrix 
AT (also written Atr, tA, or A') created by any one of the following equivalent 
actions: 

• write the rows of A as the columns of AT 

• write the columns of A as the rows of AT 
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• reflect A by its main diagonal (which starts from the top left) to obtain 
AT 

See The Transpose Wikipedia Entry for formulas, examples and more 
information. 

U | Top 

Unimodal networks – These are also called square networks because their 
adjacency matrix* is square; the diagonal is zero diagonal because there are 
no self-loops*. 

W | Top 

Walk – A set of nodes and links that form a single unbroken chain that can 
revisit both nodes and links. i.e. A ⇒ B ⇒ C ⇒ B ⇒ D. 

 
Getting Started 

Welcome to ORA's Help File system! The ORA Help and examples contained 
herein are written with a specific data set in mind: Stargate-SG1. More 
information on this dataset can be found further down in this section 

It is suggested, though not necessary, that the end user work through the 
examples with this data set. This data set is included with the ORA download 
and also from the CASOS home page at the following URL: 
http://www.casos.cs.cmu.edu/computational_tools/datasets/inter
nal/stargate/index2.html 

As an added data set to use, a network model of The Tragedy of Julius 
Caesar will be employed to demonstrate additional examples. In some 
cases, both data sets may be used to demonstrate the same technique used 
on two different data sets for added clarity as well to show ORA's 
unparalleled versatility in the field of Dynamic Network Analysis.  

In this data set, we set out to build a network model of the people, 
resources, tasks, events and knowledge that comprised the world of Julius 
Caesar as portrayed by The Great Bard, also known as William Shakespeare.  

How to use ORA help 

http://en.wikipedia.org/wiki/Transpose�
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If you are not familiar with Social Network Analysis we encourage you to 
read through the beginning sections of the help set. The ORA help set is 
broken up into six primary parts, which are designed for varying levels of 
user expertise. 

Getting Started : provides an overview of Social Networks and how they 
pertain to ORA. 

The Main Interface : details working with the data within the Networks. 
This includes loading, saving, merging, performing various math functions on 
the Networks, generating a variety of networks, and running reports. 

The Visualizer : takes these Meta-Networks and turns them into graphical 
representations. There are tools for creating / deleting nodes and links, 
displaying information in different formats, and helping to analyze the data. 

ORA Measures : explains the various measures used in ORA. They contain 
a short explanation. It also describes the type, input, and output. 

ORA Reports : contains a description of what each report is and what it will 
tell you about your data. 

Lessons : are designed to teach specific functions and how to carry out 
many types of useful network analytical tasks that can be accomplished by 
using ORA. 

 
What is ORA? 

An Overview 

The Organizational Risk Analyzer (ORA) is a statistical analysis package 
for analyzing complex systems as Dynamic Social Networks.  

Many complex systems such as organizations, intra-state alliances, food 
webs, etc. can be represented as an ecology of interlinked networks. Within 
ORA any complex system is represented as a Network. What follows is a 
general description of ORA's primary capabilities. Specific instruction is 
provided under the correlating folders in this help system. 

See Basic Terms for additional definitions relating to Social Networks. 
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The ORA Visualizer 

The ORA Visualizer renders conceptual images of social networks. Nodes 
such as Agents, Task, Knowledge and Organizations represent real-
world Entities like the president of a company, driving to the airport, or how 
to wash your clothes. Nodes which share the same attributes can be further 
grouped together creating Meta-Node. Links connect nodes that share a 
direct relationship. Such relationships are derived from the Network. ORA's 
single unit of data input, and are referred to as graphs. The ORA Visualizer is 
interactive. You can zoom, rotate, isolate, add and remove Meta-
Nodes, and much more. 

Reports 

ORA can run many reports: Risk, Intelligence, and Sphere of Influence 
to name a few. Multiple organizations can be compared against each other, 
network structure can be optimized, subgroups within a network can be 
identified, and scenarios involving the removal of nodes or links can be 
examined. Reporting capabilities are constantly being refined and updated. 

Charts 

Four chart types are available: Bar Chart, Scatter Plot, Histogram, and 
Heat Map. Each one in turn presents a different statistical profile of a 
selected nodeset. Examples of these reports and how to access them can be 
found under Basic Usages. 

 
Overview 

Contact Information 

Kathleen M. Carley 

CASOS, Carnegie Mellon University 

kathleen.carley@cs.cmu.edu 

tel: 412 268 6016 

ORA 
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ORA is an analysis tool designed to help the user evaluate one or more 
networks. It can be used to assess the nature of, features of, change in, and 
determinants of complex networks. A large variety of networks can be 
assessed including, but not limited to, social networks, activity networks, 
task networks, knowledge networks, supply chains, and communication 
networks. Using ORA questions such as the following can be addressed: 
what is critical, are there groups of interest, are there patterns of interest, 
how might interventions impact the network, who is critical, are there 
emerging groups, how is the network changing. 

What is a network? In any data there are relations among things such as 
two people are cousins, or a set of people are all members of the same club. 
These networks might be psychological or cultural as when two people share 
the same belief. They might be physical as in two resources being in the 
same location or two computers being connected by a line, or they might be 
social as in people being related. There are many reasons why networks 
exist. Networks are ubiquitous. Everyone and everything is constrained and 
enabled by the networks in which they are embedded. Everyone and 
everything is embedded in multiple networks; e.g. you are connected to 
some people due to work, others due to school, others due to your kids, and 
so on. ORA lets you visualize, assess, and reason about these networks. 

What kinds of networks? 

ORA can assess any type of network. Anything that can be represented as a 
set of nodes and relations can be assessed. Typical networks are: social 
networks (who interacts with whom), financial networks (who lends money 
to whom); gant charts (what task needs to be done before what), supply 
chains (what resources are needed to build what other resources)., semantic 
networks (what ideas are linked to what ideas), proximity networks (what 
states border on what states), and so on. ORA can assess any data that can 
be represented as nodes and relations regardless of what the nodes are or 
what the relations are. 

What if there are many networks? 

ORA can be used to assess the interlocks among networks. For examples, 
imagine that the following networks exist: who works with whom; who has 
what skills, what skills are needed for what tasks, who is doing what tasks 
then ORA can assess whether in fact the right people have been assigned to 
those tasks or where there are problems because there is insufficient skills 
available for the task. ORA can assess "multi-mode multi-link" data. 



 

 
32 

 

What if the networks change? 

ORA can be used to assess change in networks over time. Over time, the 
shape or topology of a network might change; e.g., start up companies 
move from a collaborative to a hierarchical structure, terrorists change what 
weapons they use to attack sites, scholars cite different papers, and so on. 
Consequently, over time, who or what is critical in a network might change. 
ORA can assess change in networks, and forecast possible ways in which the 
network might change in the future. 

What if information is incomplete? 

ORA can assess networks even when information is incomplete. ORA has 
been built to gracefully degrade so that it calculates all and only those 
metrics for which there is information. 

Illustrative applications 

ORA has been applied in numerous settings. Examples include the following. 
Assessment of team-x leadership structure at NASA. Comparison of terror 
networks. Identification of vulnerabilities in insurgency and terror networks. 
Assessing change in political elite structures in Korea and early identification 
of emergent leaders. Designing teams for war games. Assessing the impact 
of turnover and retirement on public health organizations in Duchess 
County, NY. Identifying reports with AIS data. Organizations where ORA has 
been used include: AFIT, SOCOM, USMA, CIA, many universities. 

Tool Evolution 

There are still many challenges in the area of dynamic network analysis. Key 
challenges include handling streaming data, locating confidence intervals for 
metrics, uncertainty assessment, and so on. As these challenges are met, 
new algorithms are implemented, tested and added to ORA thus further 
meeting the user's needs. 

 
Social Network Analysis (SNA) 

Social Network Analysis* is a scientific area focused on the study of relations, 
often defined as social networks.  
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In its basic form, a social network is a network where the people entities 
and the relations links are a form of connection such as friendship. Social 
Network Analysis takes graph theoretic ideas and applies them to the social 
world.  

The term social network was first coined in 1954 by J. A. Barnes (see: 
Class and Committees in a Norwegian Island Parish). Social network 
analysis is also called network analysis, structural analysis, and the study of 
human relations. SNA is often referred to as the science of connecting the 
dots. 

Today, the term Social Network Analysis (or SNA) is used to refer to the 
analysis of any network such that all the entities are of one type (e.g., all 
people, or all roles, or all organizations), or at most two types (e.g., 
people and the groups they belong to). The metrics and tools in this 
area, since they are based on the mathematics of graph theory, are 
applicable regardless of the type of nodes in the network or the reason for 
the connections. 

For most researchers, the entities are actors. As such, a network can be a 
cell of terrorists, employees of global company or simply a group of friends. 
However, entities are not limited to actors. A series of computers that 
interact with each other or a group of interconnected libraries can comprise 
a network also. 

Where to find out more on SNA 

• Scott, John, 2000, Social Networks, Sage (2nd edition) 

• Wasserman, S. & K. Faust, 1994, Social Network Analysis: Methods 
and Applications 

 
Dynamic Network Analysis 

Dynamic Network Analysis (DNA)* is an emergent scientific field that brings 
together traditional social network analysis (SNA), link analysis (LA) and multi-agent 
systems (MAS)*. There are two aspects of this field. The first is the statistical 
analysis of DNA data. The second is the utilization of simulation to address 
issues of network dynamics. DNA networks vary from traditional social 
networks in that are larger dynamic multi-mode, multi-plex networks, and 
may contain varying levels of uncertainty. 
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DNA statistical tools are generally optimized for large-scale networks and 
admit the analysis of multiple networks simultaneously in which, there are 
multiple types of nodes (multi-nodes)* and multiple types of links (multi-plex)*. 
In contrast, SNA statistical tools focus on single or at most two mode data 
and facilitate the analysis of only one type of link at a time. 

DNA statistical tools tend to provide more measures to the user, because 
they have measures that use data drawn from multiple networks 
simultaneously. From a computer simulation perspective, nodes in DNA are 
like atoms in quantum theory, nodes can be, though need not be, treated as 
probabilistic.  

Whereas nodes in a traditional SNA model are static, nodes in a DNA model 
have the ability to learn. Properties change over time; entities can adapt: A 
company's employees can learn new skills and increase their value to the 
network; Or, kill one terrorist and three more are forced to improvise. 
Change propagates from one entity to the next and so on. DNA adds the 
critical element of a network's evolution and considers the circumstances 
under which change is likely to occur.  

Where to learn to more: 

• Kathleen M. Carley, 2003, Dynamic Network Analysis” in Dynamic 
Social Network Modeling and Analysis: Workshop Summary and 
Papers, Ronald Breiger, Kathleen Carley, and Philippa Pattison, (Eds.) 
Committee on Human Factors, National Research Council, National 
Research Council. Pp. 133-145, Washington, DC. 

• Kathleen M. Carley, 2002, Smart Agents and Organizations of the 
Future” The Handbook of New Media. Edited by Leah Lievrouw and 
Sonia Livingstone, Ch. 12, pp. 206-220, Thousand Oaks, CA, Sage. 

• Kathleen M. Carley, Jana Diesner, Jeffrey Reminga, Maksim Tsvetovat, 
2005-forthcoming, Toward an Interoperable Dynamic Network Analysis 
Toolkit, DSS Special Issue on Cyberinfrastructure for Homeland 
Security: Advances in Information Sharing, Data Mining, and 
Collaboration Systems. 

 
ORA and DNA 

In general, you may want to use ORA in conjunction with other 
computational tools to advance DNA theory. The CMU CASOS tools that 
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work with ORA to form tool chains are AutoMap (extracts networks from 
texts) and various DNA simulators including both Construct and DyNet. 
These tools are often used in a number of real world applications, including 
the following areas: 

• Designing adaptive teams for Command and Control Networks 

• Estimating the impact of organizational downsizing 

• Estimating the effectiveness of new structures 

• Evaluating risk in organizational designs 

• Examine impact of IT effectiveness 

• Impact analysis of actions in asymmetric warfare simulation 

• Impact analysis of weaponized biological attacks on cities 

ORA is interoperable with a number of other SNA and link-analysis tools: 
UCINET, KeyPlayer, and Analyst Notebook. Additional information is 
listed under data import and export. 

Where to learn more about CASOS tools and this tool 
chain: 

Kathleen M. Carley, Jana Diesner, Jeffrey Reminga, Maksim Tsvetovat, 2004, 
An Integrated Approach to the Collection and Analysis of Network Data, In 
Proceedings of the NAACSOS 2004 Conference, Pittsburgh, PA 

Kathleen M. Carley, 2004, Estimating Vulnerabilities in Large Covert 
Networks Using Multi-Level Data, In Proceedings of the NAACSOS 2004 
Conference, Pittsburgh, PA 

Kathleen M. Carley, 2003, Dynamic Network Analysis in Dynamic Social 
Network Modeling and Analysis: Workshop Summary and Papers, Ronald 
Breiger, Kathleen Carley, and Philippa Pattison, (Eds.) Committee on Human 
Factors, National Research Council, National Research Council. Pp. 133-145, 
Washington, DC. 

Kathleen M. Carley, Jana Diesner, Jeffrey Reminga, Maksim Tsvetovat, 2005-
forthcoming, Toward an Interoperable Dynamic Network Analysis Toolkit, 
DSS Special Issue on Cyberinfrastructure for Homeland Security: Advances 
in Information Sharing, Data Mining, and Collaboration Systems. 
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CASOS: Center for Computational Analysis of Social and Organizational 
Systems (http://www.casos.cs.cmu.edu/index.html) 

 
System Requirements 

ORA performs best on machines that meet or exceed the following 
specifications: 

Spec Windows Mac (running XP) 

System XP OSX 10.4.x 

RAM 256 MB 1GB 

Processor Pentium 4 Intel Core 2 Duo 

Speed 1.0 GHz 2.0 GHz 

Java 6.0 6.0 

Extra   Parallels for Dual Booting 

NOTE : When working with extremely large data sets, increasing processing speed 
and RAM is highly recommended. 

 
Files Formats 

ORA can read in a multitude of file formats. Below is a list, with examples of 
the code, of those formats. 

DyNetML – .dl – UCINET – comma delimited (.csv) – text files (.txt) – Pajek (.net) – 
GraphML – GMU model (.stl) – Pathfinder (.lo). 

DyNetML (the native ORA xml format): DyNetML is an xml based 
interchange language for relational data including nodes, ties, and the 
attributes of nodes and ties. DyNetML is a universal data interchange format 
to enable exchange of rich social network data and improve compatibility of 
analysis and visualization tools. 

<node id="col_jack_o'neill"> 
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  <properties> 

    <property name="ally" type="string" value="yes"/> 

    <property name="gender" type="string" value="male"/> 

  </properties> 

</node> 

<graph sourceType="Agent" source="Agent" targetType="Agent" 
target="Agent" id="agent x agent" isDirected="true"> 

  <edge source="A01" target="A11" type="double" value="1"/> 

  <edge source="A02" target="A01" type="double" value="1"/> 

</graph> 

 

.dl: DL (for "data language") is a very powerful and (fairly) simple language 
that allows the creation of quite complex and large UCINET data sets with 
minimal data entry. DL language files are plain ASCII text files that can be 
created with any editor (be sure to store the results as plain text). 

dl n=9, format=edgelist1 

labels: 

    A,B,C,D,E,F,G,H,I 

data: 

    1    1    1 

    1    2    1 

    1    6    1 

          . 

          . 

          . 
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    8    7    1 

    9    9    1 

 

.##h and ##d (UCINet): UCINET datasets are stored in a special (Pascal) 
format, but can be created and manipulated using both UCINET's and other 
software tools (text editors and spreadsheets). Each UCINET dataset 
consists of two separate files that contain header information (e.g. 
myfile.##h) and the data lines (e.g. myfile.##d). Because of this somewhat 
unusual way of storing data, it is best to create data sets with the internal 
spreadsheet editor or DL language tools, or to import text or spreadsheet 
files and save the results as UCINET files. 

 

.CSV (comma separated values): The CSV ("Comma Separated Value") 
file format is often used to exchange data between disparate applications. 
The file format, as it is used in Microsoft Excel, has become a pseudo 
standard throughout the industry, even among non-Microsoft platforms. File 
most commonly created from an Excel spreadsheet using the Save As… 
option 

• Each record is one line… but — A record separator may consist of a 
line feed (ASCII/LF=0x0A), or a carriage return and line feed pair 
(ASCII/CRLF=0x0D 0x0A)… but — fields may contain embedded line-
breaks (see below) so a record may span more than one line. 

• Fields are separated with commas. 

• Leading and trailing space-characters adjacent to comma field 
separators are ignored. 

• Fields with embedded commas must be delimited with double-quote 
characters. 

• Fields that contain double quote characters must be surrounded by 
double-quotes, and the embedded double-quotes must each be 
represented by a pair of consecutive double quotes. 

• A field that contains embedded line-breaks must be surrounded by 
double-quotes 
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• Fields with leading or trailing spaces must be delimited with double-
quote characters. 

• Fields may always be delimited with double quotes. 

• The first record in a CSV file may be a header record containing 
column (field) names 

,A01,A02,A03,A04 

A01,0,0,0,0 

A02,1,0,0,0 

A03,1,0,0,0 

A04,1,0,0,0 

 

.txt (text files): Otherwise referred to ASCII files which contain no 
extemporaneous formatting. 

 

.raw:  

 

.net (Pajek): The file format accepted by Pajek provides information on the 
vertices, arcs (directed edges), and undirected edges. A short example 
showing the file format is given below: 

*Vertices 3 

1 "Doc1" 0.0 0.0 0.0 ic Green bc Brown 

2 "Doc2" 0.0 0.0 0.0 ic Green bc Brown 

3 "Doc3" 0.0 0.0 0.0 ic Green bc Brown  

*Arcs 

1 2 3 c Green 
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2 3 5 c Black 

*Edges 

1 3 4 c Green 

 

.graphml: GraphML is a comprehensive and easy-to-use file format for 
graphs. It consists of a language core to describe the structural properties of 
a graph and a flexible extension mechanism to add application-specific data. 
Unlike many other file formats for graphs, GraphML does not use a custom 
syntax. Instead, it is based on XML and hence ideally suited as a common 
denominator for all kinds of services generating, archiving, or processing 
graphs. 

<xs:annotation> 

  <xs:documentation 

    source="http://graphml.graphdrawing.org/" 

    xml:lang="en"> 

    Simple type definitions for the new graph attributes. 

  </xs:documentation> 

</xs:annotation> 

 

.stl (GMU model): This file format is native to the stereolithography CAD 
software created by 3D Systems. STL files describe only the surface 
geometry of a three dimensional object without any representation of color, 
texture or other common CAD model attributes and can us both ASCII and 
binary representations 

An ASCII STL file begins with the line: 

solid {name} 

where name is an optional string. The file continues with any number of 
triangles, each represented as follows: 



 

 
41 

 

facet normal n1 n2 n3 

  outer loop 

    vertex v11 v12 v13 

    vertex v21 v22 v23 

    vertex v31 v32 v33 

  endloop 

endfacet 

where n1-n3 and v11-v33 are floating point numbers in sign-mantissa'e'-
sign-exponent format and concludes with: 

endsolid {name} 

 

.lo (pathfinder):  

 
Stargate Summit - Synopsis 

Story Background 

The data for this scenario is based on the Sci-Fi tv show, Stargate SG-1 and 
specifically the episodes Summit / Last Stand. Following is a synopsis of 
the episodes if you have an questions regarding the dataset. 

The DataSets 

The Agents – Colonel Jack O'Neill, Major Samantha Carter, Doctor Daniel 
Jackson, Teal'c, Jacob Carter/Selmak, Lt Elliot, Ren'al, Aldwin, Janet Frazier, 
Major Mansfield, General Hammond, Lantash, Narim, Travell, Osiris, Yu 

The Short of it 

The Tok'ra are planning an attack which would kill all of the head Gou'ald 
in one fell swoop by infiltrating a summit and poisoning them all 
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simultaneously. With the help of Stargate Command and the U.S. Military 
they are able to infiltrate the summit. The plan is going fine until new 
information is disclosed which changes everything. 

The Story 

The Tok'ra have information regarding a secret Gou'ald summit of all the 
System Lords. They devise a plan to destroy the organization once and for 
all by poisoning their symbiotes, but they have need of one thing. A human 
(tauri) who speaks fluent Gou'ald. 

Ren'al (the head of the Tok'ra council) travels to Earth to meet with Stargate 
Command in order to recruit Dr. Daniel Jackson. Dr. Jackson is a human who 
is fluent in Gou'ald. The System Lords have declared a truce for the summit 
and each System Lord can bring one human servant. 

SG-1 journeys to the Tok'ra homeworld, Revanna. Jacob Carter, previously 
of the U.S. military but now a Tok'ra, presents the plan to Colonel O'Neill 
and SG-1. He's established himself as a minor Goa'uld in the service of Yu. 
He can help get Daniel inside Yu's home base by using the Reole memory-
altering chemical to convince Yu that he is his closest human slave, Jarren. 

Elsewhere, the Goa'uld Zipacna, a servant of the new and very powerful 
Goa'uld, welcomes a guest, Osiris. Zipacna offers her a position in service of 
the Goa'uld, Anubis. 

Osiris prepares to depart Zipacna's ship for the summit, as Anubis' official 
representative. Zipacna, meanwhile, has learned the location of the new 
Tok'ra homeworld, Revanna, from a captured spy and plans to launch a full-
scale invasion. 

Jacob and Daniel successfully dispose of Jarren, and, using the Reole drug, 
trick Yu into believing Daniel is his faithful servant. Yu and Daniel depart to 
the summit. 

Six of the galaxy's most powerful System Lords are waiting: Ba'al, Olokun, 
Morrigan, Bastet, Kali the Destroyer, and Svarog. They are waiting, though, 
for another guest, the powerful Goa'uld who has been dealing them all heavy 
defeats in battle, but who refuses to make his identity known. 

As the attack begins on Revanna SG-1 and SG-17 try to help the Tok'ra, but 
little can be done. The Goa'uld have dialed into Ravenna’s Stargate, thusly 
preventing their escape. Zipacna continues bombing the surface of Revanna, 
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in an attempt to flush out the resistance. As the tunnels collapse many 
Tok'ra are killed along with Major Mansfield. 

Ren'al encrypts the symbiote poison formula onto a data crystal but is killed 
by falling debris shortly after. Major Samantha Carter takes the data crystal 
for safe keeping. A large holding tank, where the symbiote Lantash is being 
kept alive, is destroyed and Lantash takes refuge in the dying Lieutenant 
Elliot as a host. 

Colonel O'Neill, Teal'c and the Aldwin do a scouting run on the surface of the 
planet only to find Zipacna has amassed an army of Jaffa troops on the 
surface. Aldwin is killed on their way back to the tunnels. SG-1 regroups but 
more tunnel collapses prevent their escape to the ring room. Their path to 
the surface is blocked. 

Back at the summit Osiris, the final guest, arrives. Daniel is caught by 
surprise. Osiris had taken possession of his friend Sarah Gardner a year ago. 
Osiris recognizes Daniel, but does not reveal this to the System Lords. 

In private Daniel communicates her arrival to Jacob. Her arrival presents a 
large problem. Osiris confronts Daniel Jackson and demands to know what 
he's is planning. Daniel manages to prick her with his ring containing the 
Reole memory drug and convinces her that he is but Yu's human servant. 
The drug takes affect and she leaves, somewhat confused. Col. O'Neill and 
Teal'c find a set of Tok'ra tunneling crystals which they use to grow new 
tunnels. Major Carter tries to help Lt. Elliot stay alive. 

Osiris tells the System Lords she represents the Anubis, who had been 
believed to be dead for 1,000 years. Anubis has dealt blows to each and 
every System Lord. Anubis wants entrance back into the System Lords. The 
Goa'uld vote to allow Anubis to rejoin them, and for Osiris to represent him. 

Daniel reports this to Jacob Carter. They both agree that the plan to poison 
the System Lords must be aborted. If they wipe out the seven most powerful 
System Lords now, Anubis will be free to conquer the galaxy. 

SG-1 and Lt. Elliot make it to the surface but must still must avoid the Jaffa 
army. They begin the 25-mile walk to the Tok'ra beacon to send a signal to 
Daniel and Jacob. At the beacon Maj. Carter sends a signal to Jacob and 
Daniel. 

Jacob tells Daniel to get off the space station. But Daniel decides to attempt 
to kidnap Osiris (still hoping to free her from the Gou'ald). When she arrives, 
he locks her in the hold and readies to steal the ship. But Yu intervenes 
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saying that his servant Jarren has betrayed him. He releases Osiris. But 
believing that Yu plotted to kidnap her she stabs Yu. As she prepares to kill 
Daniel he reveals who he really is. This cause her to hesitate. That, and the 
attack by Yu gives him the opportunity to escape. 

On their return to Revanna Jacob and Daniel are shot down by the Jaffa 
army and crash. SG-1 finds them shaken but unhurt. Lt Elliot/Lantash, 
knowing he's dying anyway, volunteers to sacrifice himself by taking the 
symbiote poison and wait to be captured. He'll then release the poison 
clearing the way for SG-1 to escape through the Stargate. 

Colonel O'Neill hates to leave his man behind, but sees that there is no other 
choice. The team goes into hiding. Elliot places the poison in his pocket, and 
listens as the footfalls of the approaching Jaffa army loom ever closer. 

 
Network Drives 

If you are running on a network drive then the help system needs a drive 
letter in order to work correctly. There are 2 possible solutions to this: 

1. Copy the ORA folder to each local machine. 

2. If at all possible Map a Network Drive. Right click on the shared folder 
and select Map Network drive. 

Mapping a Network Drive 

In an Explorer window select My Network Places. Find the name of the 
network which contains ORA. 

 

Go back to My Document. 
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From the menu select Tools ⇒ Map Network Drive. This brings up the 
dialog box below. 

 

Select the [Browse] button in order to select the network drive. 

 

Select the correct network drive and press [OK]. 
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Select [Finish]. 

 

Your computer now has the Network drive with ORA mapped on the desktop. 

 
ORA's Main Interface 

The ORA interface is organized into five sections. The menu, the main 
icons, and three re-sizable panes which are dockable. On each tab are two 
buttons: undock and close. In the upper right corner of each pane are 
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three buttons: undock, maximize, and close. This will allow you to 
arrange the interface to suit your needs. 

 

1 - The Menu 

The main source for accomplishing your tasks within the editor. It contains 
all the functions for managing the Meta-Networks, generating reports and 
doing analysis. 

2 - The Icons 

Contains the main functions for adding or deleting Meta-Networks, 
NodeClasses, and Networks and importing existing Meta-Networks. Clicking 
the down-facing triangle brings up a window which allows you to add buttons 
to the GUI for the functions you use the most. 

3 - Meta-Network Manager Pane 

This pane contains a tree directory of the current Meta-Network(s) loaded 
into ORA. This contains the Meta-Networks currently active plus all their 
Meta-Nodes and Networks. Clicking on the plus icon will expand the Meta-
Network showing all the Meta-Nodes and Networks and clicking on the 
minus icon condenses the Meta-Network. Hovering the pointer over a graph 
it will display information about that Network. 
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4 - Editor Pane 

Contains the basic information about the highlighted Meta-Network such as 
how many nodes are represented. This panel also allows quick access to 
ORA's Visualizer, Reports and Chart tools. By selecting the Visualize button, 
the currently loaded Network will render in the ORA Visualizer, which will 
load in a separate window. 

With the Meta-Network selected panel 2 displays the information 
regarding the Meta-Network itself. The Meta-Network name and pathway at 
the top. In the bottom, under statistics, are information regarding the actual 
Meta-Network including source, node, link, and network counts. 

When a Meta-Network is expanded it reveals nodeclasses and networks. 
Highlighting any of these will reveal information these items. 

The Info Tab : Display relevant information whether a nodeclass or 
network is highlighted. 

The Editor Tab : Displays the information in a matrix which can be 
edited in multiple ways. The data can be directly manipulated in the grid, 
nodes and attributes can be  

With the Nodes and Attributes buttons you create, delete, or merge nodes 
and attributes. The Find box assists you in locating particular nodes and 
attributes. 

5 - Reports Pane 
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This pane is initially empty when ORA is first started up. As reports are run 
they will be contained within this panel.  

NOTE : All three panes can be resized to your preference. 

 
Main Interface Tasks 

There are a number of tasks that are performed from within the Main 
Interface to assist in controlling your Meta-Networks, NodeSets, and 
Networks. These are mostly functions not associated with any of the Menu 
Items. 

For example, renaming Meta-Network, tool tips displayed while hovering, 
and creating and deleting Nodes & Attributes. 

 
Attributes 

An attribute* is an extra container that can be attached to an Meta-Node. 
You can add a value to this container. To add an attribute to an Meta-Node 
right-click on the Meta-Node name. This will bring up the contextual menu 
below. 

Add Attribute 

 

Type in the name for your new attribute and select [OK]. Let's say we want 
to add other languages spoken by the nodes. 

 

The attribute you added will be inserted alphabetically in the editor. 
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You can now assign any text to this attribute for any of the rows in the 
Network which can be used later to help define your Network. 

 

Add attribute (second option) 

There is a second way to add attributes in the Editor tab. Below the matrix 
is a section called Attributes which contains two buttons, [Create] and 
[Delete]. 

 

Selecting [Create] brings up a dialog box and asks you to input the name 
for the new attribute. 

 

The new attribute is then inserted within the matrix. 

 

Delete Attribute 
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And attributes can be removed just as easily by pressing the Delete button. 
The dialog box will present you with a dropdown menu where you can 
choose which attribute to delete. 

 

Import Attribute 

The [Import] button allows for the quick importing or an attribute(s) 
through the Editor panel. Use a .csv file with rows as nodes and columns as 
attributes. This can be done with, or without, an ID column. 

 

1. Use the Textbox and Browse button to navigate to the csv file with the 
new attribute(s). 
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2. Select the radio button to use either 1) an ID column, or 2) a file in 
the same order as NodeSet. 

3. This section contains all the attributes in the file. If one was chosen to 
identify the NodeSet then it will be grayed out. For attributes NOT 
grayed out you can chose to make then Categorical* or Continuous*. 

4. Select All / Clear All buttons places a checkmark in all columns or 
removes same. 

5. Placing a checkmark in the Create new nodes for unrecognized 
nodes creates new nodes into the select NodeSet if no node for an 
attribute currently exists. 

6. Import / Cancel tells ORA to begin the import or cancel the 
operation. 

Note: Whenever you set a Node Display Attribute for a Nodeset, the 
info is also set as an attribute of the nodeset.  In other words, Node 
Display Attributes are now encoded in the data, allowing it to be 
retained from session to session. 

 
Use Links As Attributes 

The following instruction demonstrates how to add a document attribute 
or a URI to a Node. 

Adding a document links in the Editor 

Load a Meta-Network into ORA. Then expand the Meta-Network using the 
[+] icon to display all the NodeClasses and Networks in the Meta-Network. 
Then right-click on a NodeClass and this will access the contextual menu. 
From here, select Add Attribute. Give the new attribute a name. 

In Pane 2 click the Editor tab to display the matrix and find the new attribute 
just created. All cells will be empty. A new pathway can be inserted in the 
cell at this time. 

Once the node title has been changed, you can now enter a URI directly 
inside the corresponding blank field. This can either be an absolute pathway 
to a document on the user's hard drive or a web URL. 
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NOTE : When using a absolute path to a document the link will not work if 
the Meta-Network is opened on another computer. It's much safer to use 
URIs from the internet to connect documents. 

Adding a URI in the Visualizer 

Visualize a Meta-Network, select a node, and right-click to access it's 
contextual menu. From the contextual menu select, choose URI submenu 
> Attach URI. This brings up the Add URI box where the new URI can be 
entered. 

When viewing the Meta-Network in the Editor a new column appears with 
the title you inserted in the field Name:. 

The same document pathway can be used for multiple nodes. 

When the Meta-Network is displayed in the Visualizer the document URI will 
appear in the Node Status tooltip. You can go to this URI by right-clicking a 
node and use the URI submenu to Go To URI. A new explorer window will 
be launched showing the location of the document file. It can then be 
opened with the appropriate program. 

Multiple URIs/URLs 

A node can have multiple URIs and you can still launch from the URI 
SubMenu. The preferred method for launching URIs is through the Node 
Status dialog where you can choose an individual URI to launch. 

There’s a new URI tab that allows you to view URI’s, launch them, and add 
new ones.  When adding new ones, the current convention is to create a 
new Attribute with name “URI-X”, where X is the earliest number that 
doesn’t already exist.  So, adding a URI to nodes will create results such as 
“URI-1”, “URI-2”, etc.  Currently, when finding URI’s to launch, only those 
that follow the above convention are included, but it will be expanded to 
include any attribute with URI or URL in it anywhere. 

 
Contextual Menus 

Right-clicking on any Meta-Network, NodeSet, or Network brings up a 
contextual menu with the functions available such as add or delete. And 
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within each contextual menu are specialty functions for Meta-Networks, 
NodeSets, and Networks. 

 

The first four are self-explanatory. Transform… opens up the Meta-Network 
Transform… dialog box. 

 

The first two are self-explanatory. Add Attribute … opens up the attribute 
function in order to add attributes to a nodeset. 

 

The first two are self-explanatory. 

• Set Diagonal… : Used on a square network to set cells 1,1 through 
x,x to the same value. In binary view the choice are 1: True (+1) 2: 
True (-1) 3: False (0). In Numeric view you can put any value into 
the diagonal. 

• Fold Network… : This function creates a new network using matrix 
algebra. Below are four variations of a four x four network and the 
results when each is folded. 
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• Save Network… : (also called Exporting a Network) Any 
Network can be saved individually to a file in one of the 
following formats: CSV*, DL, DyNetML*, or UNCINET (.##h). Also 
check File Formats for more information 

• Binarize Network : Turns all non-zero numbers to [1] and leaving 
all [0] untouched. 

• Remove Links… : Removes links in accordance to the selection in the 
dropdown menu (as seen in the images below). 

 

• Symmetrize… :  

 
Contextual Menus - Multi Files 

Includes: Union Meta-Networks, Intersect Meta-Networks, Conform Meta-
Networks 
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There's also a separate contextual menu when you've got two or more Meta-
Networks selected. Open up multiple Meta-Networks in the Main Interface. 
Load two or more files into Panel 1. We'll demonstrate this on two Meta-
Networks containing Bob, Carol Ted, & Alice. The agents are identical but the 
tasks in each are different, except for driving which appears in both and has 
slightly different values. In between the time of cookingIn and eatingOut 
Alice's feelings for Ted have grown. 

CookingIn and 

 

EatingOut 
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Highlight both of them by holding down the [Control] while clicking on each 
file. Then Right-click on one of the files. This brings up the contextual 
menu. 

 

The Add New Meta-Network& Remove Selected Meta-Network are 
self-explanatory. 

The Union Meta-Network will create a new Meta-Network using one of 
five actions: sum, binary, average, minimum, or maximum. 

 

• Sum : In any identical network all values from all networks are added 
together. (i.e. bob's score of 4.0 in both meta-networks are added 
together for a total of 8.0). 

 

• Binary : Then in the binary option it doesn't matter what numbers 
appeared in either meta-network as it uses only 1 or 0 as a result. If 
any cell has a non-zero it will contain a 1 as a result. 
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• Average : This option takes the sum of all identical cell values and 
divides them by the number of cells used. In cookingIn ted x 
alice contained a 2 while in eatingOut the value for ted x alice was 
a 1. This was averaged out to 1.5. 

 

• minimum : This function finds the smallest value in any identical cells 
and uses that in the final result. (i.e. for ted x carol and ted x alice 
both cells use the smaller value of "1" even though they are from 
different meta-networks. 

 

• Maximum : This function finds the largest value in any identical cells 
and uses that in the final result. (i.e. for ted x carol and ted x alice 
both cells use the larger value of "2" and "3" respectively, each taken 
from a different meta-network. 

 

Intersect Meta-Network works similar to the Union function and has the 
same five options. But in creating the new Meta-Network only nodes that 
appear in all Meta-Networks are carried over to the new Meta-Network. 
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For example: All four agents appear in both Meta-Networks and are brought 
over into the new Meta-Network. But though there were six tasks in the 
cookingIn and three tasks in eatingOut there is only one task (driver) in 
the new Meta-Network created from the intersect function. Only nodes found 
in all Meta-Networks are brought over. 

 

And even though bob has a value for driver in cookingIn only carol has a 
value for driver in both Meta-Networks. 

 

Conform Meta-Network alters the selected Meta-Networks and makes 
them equal. union adds nodes that are found in one Meta-Network but not 
the other. intersect removes nodes that are not common to both. 

 
Create a New Meta-Network 

What follows are procedures for creating a new Meta-Network. 

There are times you need to run measures on or visualize only part of an 
existing Meta-Network. This section will show you the easy way to create 
sub-sets of an existing Meta-Network. 

First duplicate the Meta-Network. Highlight the Meta-Network then from the 
main menu select Edit ⇒ Copy Meta-Network. Then from the main menu 
select Edit ⇒ Paste Meta-Networks. It would be a good idea to rename 
this new Meta-Network immediately so as to not get it confused with the 
original. You can do this in the Editor tab, see Renaming. 

Next, expand the Meta-Network you want by clicking the [+] if it isn't 
expanded already. Highlight the nodeset with the nodes you want to 
remove. 
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In panel 2 select the Editor tab which brings up the matrix with nodes on 
the vertical and attributes on the horizontal. Below each attribute is a <set 
filter>. Below left is the stargate_summit meta-network along with the 
ally attribute. I wish to make a new meta-network of the good guys only. 
In the dropdown menu under ally I select no. These are the nodes I want to 
remove. 

 

Place a checkmark in the box of each node. Below the matrix in the section 
called Nodes are three buttons. Click the [Delete] button. The nodeset now 
contains only the nodes that had yes in the attribute ally. 

 

With this same procedure I created a Meta-Network of only the allies. 
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Find 

Find a Sub-set within a NodeSet 

What follows are procedures for using the Find feature in ORA.  

By using the Find: textbox and the AND/OR selector you can display only 
the nodes you want to work with. This works by searching for Sub-Strings 
within the values. 

NOTE : A search for "male" will find all values of "male" as well as "female" 
because "male" is a sub-string of "female". 

 

Here is the whole NodeSet with only the gender and race attributes 
displayed. The AND/OR toggle is in it's default AND setting. 
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First female is typed into the textbox and ORA will display all nodes where 
gender=female. 

 

Next tauri is typed into the textbox (make sure there's a leading "space") 
and ORA will now only display nodes with gender=female and race=tauri. 
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But if the AND/OR setting is switched to OR the NodeSet who display 
everything with EITHERgender=female OR race=tauri. 

 

 
Hovering - Tooltips 

Hovering the pointer over various parts of the panels will reveal information 
about the Meta-Network.  

Hovering over the parts in Panel 1 will reveal different information about the 
Meta-Networks, Meta-Nodes, and Networks. 
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Node Buttons 

 

Node Buttons 

What follows are images and descriptions of some common button items and 
other interface elements in the ORA gui.  

Create inserts a new node(s) into the NodeClass. You will be asked for the 
number of new nodes to create and a node ID. If multiple nodes are to 
created then a number will be appended to each new node. 

Move Moves node(s) to another NodeClass. ORA will prompt you for the 
movement of links associated with these node(s). 
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Delete Removes node(s) and all associated link(s) from the Meta-Network. 

Merge removes all selected nodes and replaces them with a single node 
with all previous links and attributes. This is used primarily when data needs 
to be consolidated. 

Example : A NodeClass contains two nodes, jack and col_o'neill. And 
these are actually the same person. Merge will combine their information 
into one node which could be named col_jack_o'neill. 

 

Clean finds all nodes whose IDs are within the edit distance of the selected 
node. An edit is a change of a single character. 

 
Info Tab - Nodeset 

Panel 2 contains two tabs, Info and Editor. The Info tab is mainly 
designed to display information regarding the Meta-Networks, NodeSets, and 
Networks. But this is the area where you can rename the Node Class ID 
and the Node Class Type. Place the cursor in the box, make sure the entire 
name is highlighted, and type in your new name. 

This area also gives you the Node Count of the selected Node Set as well as 
the Attribute Names contained within the NodeSet. 



 

 
66 

 

 

The Editor tab contains most of the editing functions. 

 

1. The Search box for finding particular node(s) in a set. 

2. The <set filter> for displaying only a particular sub-set of node(s). 

3. The Checkboxes to designate which nodes to Delete or Merge. 

4. The Nodes buttons: Create, Delete, Merge, and Clean. 

5. The Attributes buttons: Create, Delete, and Import. 

6. Use the Select/Clear buttons to place, or remove, all checkmarks 
from section 3.  
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Info Tab - Network 

When a Network is selected there are also two tabs, Info and Editor. 

The Info tab contains a textbox, Network ID in which you can change the 
name of any network, The Source and Target Nodesets, and whether this 
network is directed or not, the Link Count, and the Density. 

The two buttons underneath allow the choice of Visualize this Network 
which will send the entire Meta-Network to the Visualizer or Visualize Only 
this Network which display only the currently selected Network. 

Below is an image of InfoTabs and Editor Tabs in ORA.  

 

The Editor tab has two views: Binary and Numeric. 

Binary view is used when you only need to establish a connection between 
two nodes with no weights. It's a simple Yes or No arrangement. 
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The Numeric view allows you to treat links between various nodes with more 
or less importance. Notice that all the row nodes have a check marked 
connection to the column containing [yu] in the binary mode. This 
denotes they know one another. But in the numeric mode this value is a 0.5 
which is used to denote previous acknowledgement but is an adversary. 
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Create Meta-Network from Excel File 

If you don't have a Network, you can create one from scratch. Below is step-
by-step instruction on how to do this in ORA. 

We will create an square, agent-by-agent Network. We say it is square 
because all row headings correspond directly to column headings. This is 
important as it relates to specific measures ORA can run on a graph. If the 
graph is not square, some measures will not work. 

Open a blank Microsoft Excel work book. In column A we will enter the 
name of all the nodes that make up our social network or organization. 

NOTE : When creating your spreadsheet, do not add any additional titles, notes, or 
other headings, which will interfere with the "square" properties of the Network. 

 

Next, create column headings using the correlating names as they appear in 
row headings. Again, this will ensure that our Network will be square. 

 

Next we will create links between each agent. We do this by entering a 1 if 
a direct connection or relationship exists and a 0 if it does not. Please note 
that headings that cross-reference themselves are considered redundant and 
thus are left blank or 0. 
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In the example below, Redundant cells are filled in with red strips to 
illustrate the self-loops. This redundancy should continue as a smooth 
diagonal line from the top left corner of your Network to the bottom right. 

 

NOE : If you don't end up with a diagonal line then your graph is not square. 

Using 1s and 0s to establish link, complete your spreadsheet. 

In the Network example, we have assigned links randomly. Within your 
organization or network, however, you can describe any direct connections 
or relationships you are interested in analyzing. For instance, you may 
determine that a direct connection exists if agents within your network 
consult with each other at least once a month; literally, it can be anything 
you decide. 

Below is our completed Network (The red fill illustrates cells that do not 
require input due to their redundancy*). 

 

Now that we have essentially built a Network from scratch using Excel, the 
next step is to save it in a compatible file format ORA can interpret. For 
Excel spreadsheets this will be the CSV* file format. 

From the main menu select File ⇒ Save As 

Make sure you save this file as a CSV (comma delimited) 

You have now created a Network from scratch which can be loaded into 
ORA. 
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Now return to ORA and load up your new Network. Below is a our new 
Network rendered in the ORA Visualizer. Notice the arrows only point from 
one node to another if there is a 1 in the column for a particular node. i.e. 
There is a "1" in the bob column for ted but a "0" in the ted column 
for bob. So an arrow points from ted to bob but NOT from bob to ted. 

 

For a more in-depth explanation for creating Meta-Networks see the lessons 
section under Meta-Network. 

 

 
ID Names 

Working with ID Names 

Each Meta-Network, NodeClass, and Network can be given a distinct ID 
Name. At times this can be very helpful when working with multiple Meta-
Networks it can also cause problems with certain functions. 

 

Here I renamed one of the Meta-Nodes to those guys. It is also reflected 
throughout all of Meta-Network Panel. You can rename any Meta-Network, 
NodeClass, or Network for better readability. 
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Areas where it's important to maintain Name ID integrity 

View Measures Over Time : This function allows an analyst to see how a 
network measures change over multiple time periods. So in order to track 
measures over time it is necessary that the ID Names of the Networks are 
the same in all instances. 

View Networks Over Time : This function allows you to set up multiple 
Networks that encompass various time frames and view them in succession. 
Since you want to see what happens over the same Network Over Time it 
becomes virtually important to make sure the ID Names of these Networks 
are all the same. Else ORA will not be able to analyze them correctly. 

Comparing Networks : When ORA runs measures on Networks it's 
sometimes necessary to do have identical Network names. This will be listed 
in the Measures section. 

 

 
Visualize Buttons 

There are two Visualize buttons and they work slightly different.  

 

The Visualize this Network visualizes the chosen Network. In the Legend 
dialog box all NodeSets and LinkSets are available. 
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The Visualize Only this Network visualizes the chosen Network. But in the 
Legend only the NodeSet and LinkSet chosen are displayed. This is a much 
quicker means to display a Network. ORA only makes computations for the 
chosen Network. 
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File Menu 

Below is an image of the File Menu accessible from ORA's main title bar 
menu. Further below are descriptions of the various tools accessible through 
the File Menu.  

 

Open Meta-Network : opens a single Network with the following 
formats: DyNetML* (the native ORA xml format), .dl, .##h 
(UCINet), .csv* (comma separated values, Excel spreadsheet out), 
.txt (text files), .raw, .net (Pajek), .graphml*, .stl* (GMU model), 
and .lo (pathfinder). 

 

Data Import Wizard : Contains additional options for importing 
Networks such as multiple file importing. See Lessons for more 
comprehensive information regarding this function. 

 

Data Export... : Allows you to export a Meta-Network into a 
different format: CSV, UCINET-Binary, UCINET-DL, Netdraw 
VNA, Text, Pajek, DyNetML, or C3Trace. 
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 Import CASOS Database… 

 

Open Workspace…Allows you to open an entire workspace that 
you were previously using. A workspace consists of a set of Meta-
Networks that were all open at the same time, and saved as a 
workspace. 

 CEMAP...Opens up the CEMAP Parser. 

 AutoMap...Opens up the program AutoMap. 

 
Pile Sort...Opens up the program Pile Sort. Used to sort nodes 
into individual categories. 

 

Save Meta-Network : This item is initially grayed out. It only 
becomes active when you've made a change to a Network. You 
can use it as an indicator whether you've made a change to the 
active Meta-Network. Notice as you highlight each Meta-Network 
the icon in the toolbar will be grayed out (no changes) or colored 
(changes made to that Meta-Network). 

 
Save Meta-Network As... : Allows you to save the changes in a 
Meta-Network under a new filename. 

 
Save Workspace : Saves the active Meta-Networks into a 
Workspace which can be opened up at a later date. 

 Exit : Closes the program. 

 

 
Open Files 

ORA is designed to work with DyNetML files. However, data in a format 
other than DyNetML can be imported and converted. 
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 Open Meta-Network 

From the Main Menu select File > Open Meta-Network. to bring up the 
initial open dialog box. Navigate to the folder with your DyNetML file and 
click [OK]. 

The selected file will then appear in Panel 1 of the main interface. 

 

 Data Import Wizard 

The Data Import Wizard imports files in a variety of File Formats. The idea 
behind the data import wizard is that users come to ORA with a variety of 
file formats from various different network analytical tools. Very rare is it 
that an analyst has a Meta-Network ready to load. Moreover, network data 
may exist in a separate file or in a variety of file formats, which then need to 
be merged together. 

The Data Import Wizard is used to convert the user data from their native 
format and separate files and convert it into Meta-Networks and then into a 
DyNetML file. 

The files can be in any of the following formats: CSV, UCINET, GraphML, 
or Pajek. ORA uses the file extension to determine the native file format to 
assign to your network. Therefore, if you change a file extension from its 
native extension (e.g., GraphML file such as "example.gml" to 
"example.dot" ORA will not recognize the data format). 

This section will review the basics of the Data Import Wizard. See the lesson 
Creating a Meta-Network for more comprehensive information on 
importing. 

Data Import Wizard is accessed either File > Data Import Wizard or the 
icon in the toolbar. You are presented with a dialog box showing all the file 
format options to import. Each contains a description on the right-side of the 
box. 
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Other Functions Besides Importing 

• Create a meta-network from separate network files: Use this 
option to select multiple networks in one of the several native file 
formats indicated above and pull them into ORA. The file formats don't 
have to match. ORA will then combine all the network files into one 
Meta-Network, which will then be saved as a DyNetML* file (ORA's 
native file format). 

• Create a meta-network from table data: Text files in the form of 
rows of Nodes and columns of Attributes will be used to populate 
existing NodeSets.  

• Import node attributes from table data: Text files used to import 
Attributes to a Node. 
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Saving 

 Save Meta-Network 

This option is initially grayed out when you first load a Meta-Network. This 
signifies that the Meta-Network is currently unchanged. Whenever you make 
ANY change within he Meta-Network the option will become full-color 
indicating it is time save changes.  

After clicking the icon in the toolbar, or selecting the menu item, it will 
become grayed out again till you change your Meta-Network once again. 

No change needs saved in the Meta-Network 

 

Changes made to Meta-Network and need saved 

 

Save Meta-Network As... 

If you need to save a Meta-Network under a different name use select File 
> Save Meta-Network As.... This will leave the original file intact and 
create a new Meta-Network with the new file name. 

 Save Workspace 

While working with multiple Meta-Networks you may want to retain the 
information of what files you had open for later use. Saving your workspace 
creates a file which can be opened later and will recreate your workspace as 
before. 
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From the Main Menu select File > Save ORA Project. After selecting [OK] 
on the initial dialog box the Save ORA Project dialog box will appear. 
Navigate to the folder where you want to save your workspace. 

This Workspace can then be called up with the Load Workspace in a future 
session. 

 

Pile Sort 

The PileSort module allows a user to load a series of entities such as 
concepts or people's names. These entities are displayed in a deck, which 
can then be organized and grouped into a pile, which will contain entities 
that are similar to one another. The output of the PileSort module will be a 
network in DyNetML format. 

The user can use either a text editor of a spreadsheet to create a two-
column comma-separated file (i.e. a .csv file). The first column contains 
the concept and must not be blank. The second column is optional and can 
contain metadata. 

NOTE : Concepts can not contain embedded commas. 

Pile Sort GUI 
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Pile Sort Interface : consists of two panes: The Side Deck and the Canvas. 
The Side Deck displays cards that have not been organized into piles, such 
as initially when the input file in read. The Canvas contains the piles where 
the cards are placed from the Side Deck. 

Pile Sort Menus 

 

File > Load a File :  

 

File > Exit :  

 

Edit > Add an Empty Pile : creates an additional empty pile on 
the canvas. 

 

Generate > Create a Network DyNetML File : Creates a 
DyNetML file from the current state of organization. All cards in a 
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pile are fully connected and cards remaining in the deck are 
isolates. 

 

Help > Show Help Topics : Accesses the ORA Help files 

Other Functions 

 

Add Card : takes the concept that has been filled into the text 
field next to the [Add] button and creates a card with that 
name at the end of the card deck. 

 

Transfer All Cards to Another Pile : Click and hold the icon of 
a pile and drag it to another pile. All cards in the first pile will be 
transfered to the new pile. 

 

Cycle Through the Cards in the Pile : Rotates the cards in a 
pile that the card currently beneath the currently highlighted 
card becomes highlighted. The newly highlighted card becomes 
the pile's representative. 

 

Return Cards to the Side Deck : Removes all cards from a pile 
and returns them to the side deck. 

 

Mark a Card as a Pile's Representative : marks the currently 
highlighted card as a pile's representative. 

 

Move Card to Another Pile : Click and hold a card in a pile and 
drag it to another pile. 

 

Click to Add a Title : allows the entire pile to be given a name. 
Either click on the title bar or use the drop down menu item. 
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Drag and Drop Here : allows the user to drag cards from the 
side deck onto a pile. 

Loading a list of concepts :  

All piles are initially empty. The concepts appear in the side deck to the left. 
A scrollbar will appear if the number of concepts is greater than the screen 
length. An empty pile contains the banner drag and drop here signifying 
an empty pile. Once a concept is placed in a pile it will all concepts will be 
displayed in it's window. 

NOTE : To have duplicate concepts in more than one pile requires the 
creation of duplicate cards. 

NOTE : You can leave cards in side deck. Any card not so placed will become 
an isolate in the resulting network. 

 

Viewing in ORA 
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Saving a sorted Pile : Sorted piles are saved to the DyNetML format. 
Networks are formed from the individual piles which include the metadata 
from each card. 

Viewed in the Editor you can see all the saved information from Pile Sort. 
The column containing_pile is the name you gave the pile into which a 
card was placed. meta-information is the optional second column from the 
.CSV file originally loaded into Pile Sort. If that was empty, then the meta-
information cell would also be empty. 

 

Clicking the [Visualize this Network] button displays your Pile in the ORA 
Visualizer. How networks are formed is based upon the cards placed in each 
pile. The four cards not placed into a pile (cuttlefish, seal, sea horse, and 
shark) became isolates in the Visualizer. 



 

 
84 

 

 

 

 

 
Edit Menu 

Below is an image of the Edit Menu. Further below is a description of the 
Edit Menu functions accessible through the Edit Menu.  

 Copy Editor Values : Copies the selected values in the Editor. 

 

Paste Editor Values : After values have been copied, these can 
be pasted either into a different section of the matrix or the Matrix 
of different Meta-Network. 

  The copied size can be identically sized (allowing you to paste an 
entire column in) or a smaller, subset allowing you to choose only 
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a portion of the original set. 

 
Copy NodeClass(es) : Copies one or more an entire NodeClass 
to the clipboard. 

 

Paste NodeClass(es) :  

Creates a copy of the NodeClass(es) from the clipboard. Used to 
quickly creating duplicate NodeClasses. 

 
Copy Meta-Network : Copies an entire Meta-Network to the 
clipboard. 

 

Paste Meta-Network :  

Creates a copy of the Meta-Network in the clipboard. Used to 
quickly creating duplicate Meta-Networks. 

 Copy Network : Copies one or more Networks to the clipboard. 

 

Paste Network :  

Creates a copy of the Network(s) in the clipboard. Used to quickly 
creating duplicate Networks. 

  
When you first start the program the Paste Meta-Networks is 
grayed out. It will only become active once you've used the Copy 
Meta-Network menu item. 

 

 
Copy / Paste 

ORA offers multiple options for copying Meta-Networks, NodeClasses, and 
Networks. 
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 Copy/Paste Editor Values : Highlight values in the Editor and 
select Copy Editor Values to copy them. Highlight a new cell in the editor 
and select Paste Editor Values to paste them. This can be used when you 
create a new NodeClass and only need specified values placed into the new 
NodeClass. 

NOTE : Highlighting and copying a 4x4 block of cells then pasting these in a 
new location will replace the same size block. 

  Copy / Paste Meta-Network : Copy Meta-Network copies a 
Meta-Network and Paste Meta-Network creates a duplicate in ORA. 

NOTE : ORA does not ask you for new names for duplicated Meta-Networks. 
It is advisable to give the new Meta-Network a different name in the Meta-
Network ID field in order to distinguish it from the original. 

  Copy / Paste NodeClass(es) : Copy NodeClass(es) copies a 
NodeClass and Paste NodeClass(es) creates a duplicate it into ORA. After 
pasting ORA will ask you for a name for the new NodeClass. If you copy 
multiple NodeClass(es) ORA will ask you for multiple names. 

  Copy / Paste Network : Copy Network copies a Network and 
Paste Network creates a duplicate into ORA. 

NOTE : The last three menu items change as is determined by what is 
selected in Pane 1. Currently the icons are identical 
 

 
Preferences 

 Preferences are global variations which control aspects of how ORA 
works. 
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General 

Tooltips : Marking the checkbox shows tooltips when hovering over items. 
Remove the checkmark to disable tooltips. 

Docking Layout : Marking the checkbox will retain the custom layout when 
ORA is restarted. No checkmark will fall back to the default layout. 

Look and Feel : Sets the style of the ORA GUI. 

Large Icons : Placing a checkmark toggles between using the 16x16 or 
24x24 icons. 

Data Sets 

Maximum Data Files to Load : Tells ORA the maximum number of files to 
load upon start-up. 

What To Load : You have three options for loading files when ORA is 
started up. 

1. Do not load any files at startup : Ignores any files that were loaded 
during the last session. 



 

 
88 

 

2. Restore previously loaded workspace at startup : Loads the files 
that were current when ORA was last shutdown. 

3. Load specified files below: Loads the files specified in the box below 
the option. 

Reports 

Selecting Reports to Display : Any reports with a checkmark will appear 
in the report generator window. 

Changing/Resetting Report Names : Right-Clicking on a report name 
allows you to change the name. The Reset report names button resets all 
the names to their default 

Import/Export Settings : If multiple people work on the same computer 
individual report settings can be saved for each user with Export Settings. 
Each user can use the Import Settings use their custom report names. 

Report Headers : You can specify a header to print on the top of your 
reports. 

Report Footers : You can specify a footer to print on the bottom of your 
reports. 

 

 
Data Management 

These sets of menu items enable you to control the addition or removal of 
Meta-Networks, Meta-Nodes, and Networks as well as adding Attributes to a 
Meta-Node. 

Matrix Algebra, Meta-Network Transform, and Meta-Network Union... also 
create new Meta-Networks, Meta-Nodes, and Networks but do it with 
Mathematical operations. 

 
Meta-Network Algebra... : Performs mathematical operations on 
two Meta-Networks. 
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Meta-Network Transform... : Cleans up a Visualizer display 
making it easier to read. 

 
Meta-Network Anonymize… – Resets the NodeID (and 
optionally the Node Title) to anonymous values. 

 
Meta-Network Union – Creates a single Meta-Network from two 
(or more) existing Meta-Networks. 

 
Add New Meta-Network : Used for adding or removing Meta-
Networks from use. 

 
Remove Selected Meta-Network : Removes any Meta-Network 
which is currently selected. 

 

Add New Node Class... : Enables you to add, remove Node sets, 
as well as, change the size of the Node set. You can also add an 
Attribute to an existing Node Set. Depending on what you have 
selected different options may be grayed out. 

 

Remove Selected Node Class : Removes all selected 
NodeClasses from the Meta-Network along with any associated 
Networks. 

 

Add Attribute... : Creates a new attribute in a NodeClass. You 
need to give the attribute a name and also what type of attribute 
it is: Text, Text Category, URI, Number Category, Number, 
Date. 

 

Add Blank Network... : Similar to Node Class in that you can 
add or remove Networks. This function also enables you to Set 
the Diagonal of a graph to either -1, 0 or +1. Useful for setting 
consistent values on an agent-by-agent Network. 

 Remove Selected Network : Removes all selected Networks 
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from the Meta-Network. 

 

Set Diagonal : Allows user to constant values to the diagonal of a 
square network. If Binary View is chosen you can pick True (+1), 
False (0), or True (-1). If Numeric View is chosen you can set 
the diagonal to any value. 

 
Attribute Partition Tool : Creates new Meta-Networks from 
existing Meta-Networks using a node attribute. 

 Beliefs :  

 

Randomize Links : A new Meta-Network is created with identical 
NodeClasses, and with networks of the same size and density, but 
with links distributed randomly according to Erdos-Renyi. 

 

 
Network Algebra 

 Network Algebra allows you to perform mathematical operations on 
two Meta-Networks. The options in ORA are addition, subtraction, and 
multiplication. These functions help spot strong and weak connections 
within a Meta-Network. 

NOTE : The term Network Algebra is synonymous with Matrix Algebra in 
computational parlance. Also, the following images display Matrix Algebra 
in the title bar. This may or may not be the case for the most recent version 
of ORA. 

I start with one Network loaded. 
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From the menu select Data Management ⇒ Network Algebra… 

The Network Algebra dialog appears. There are six areas which you can 
manipulate. These are each described below the dialog box. 

Note : Both Networks should be the same dimensions. 

1. Select a Meta-Network 

 

This dropdown menu will show all the Networks you currently have 
active. To perform a math function on a Meta-Network, highlight it in 
the dropdown menu. 

2. Select an Operation 



 

 
92 

 

 

This option allows you to choose which operation, Add, Subtract, or 
Multiply, you want to perform on the Networks. 

o Add: Adds together corresponding cells of two different 
Networks. 

o Subtract: Subtracts corresponding cells of two different 
Networks. 

o Multiply: Multiplication is slightly different than the add or 
subtract. The number of rows in the first Meta-Network must 
equal the number of columns in the second. A Meta-Network can 
be multiplied by itself to help reveal specific strong and weak 
areas. 

 Add Networks:  

 Subtract Networks:  

 Multiply Networks:  

 Dot Products Networks:  

 Set the Diagonal:  

 Add by a Scalar:  

 Subtract by a Scalar:  

 Multiply by a Scalar:  

 Divide by a Scalar:  

 Transpose:  

3. Select Network 1: 
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Next select the first Network you want to work with. 

 

4. Select Network 2: 

Then select the second Network to do the algebra on. 

 

5. Add Network: 

If you wish, you can add additional Networks to the equation. Different 
selections in the previous choices will give you different options in each 
dropdown. 

 

6. Enter a name for the new Network: 

When everything is set, type in the name for your new Network. 

Finally, select [OK] to create you new Network. You can then create 
more Networks if desired. When done, select [Cancel] to remove the 
dialog box from the screen. 

Your new Network will now appear in the box with your Meta-Network. 
Next highlight the Network you just created. 
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Next, select the [Visualize Only this Network] button 

 

You will get a warning box asking if you're sure you want to visualize only 
one Network. Select [OK] to run the Visualizer or close the box. 

 

This will bring up the Visualizer displaying the Network. Your display will 
depend on the Network selected. In this particular example there are only 
Agents and Links connecting Agents displayed in the Visualizer and the 
Legend. 
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Now we'll create a second Network by using the multiply operation. The 
second Network will put knowledge into the mix. 

Note : Remember to name your file something different. 
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Highlight your newly created Network and select the Visualize Only this 
Network once again and select OK in the dialog box. 

 

This time, since a Network with knowledge was selected the Visualizer and 
Legend display both Agents and Knowledge and also the Links 
connecting them all. Also the Matrix Algebra selected was multiplication it 
creates links which were not in the original Network. 
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Matrix Transform 

 On some occasions the display in the Visualizer is too cluttered to make 
much sense of your network model. ORA offers a variety of ways to clean up 
the display in order to make it easier to view your data. 

In the main menu select Data Management ⇒ Meta-Network 
Transform…. 
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The Meta-Network Transform dialog box will appear. It consists of three 
sections. The top section display a dropdown menu with all the currently 
active Meta-Networks. Use this menu to select the Meta-Network. The 
bottom section has two tabs. The Entire Meta-Network contains choices 
on how to transform the Meta-Networks. The Individual Networks tab 
allows you to select to work on only individual networks. 

The "Entire Meta-Network" tab 

Remove Isolates 

Removes any isolates* from the selected meta-network. 

Remove Pendants 

Removes any pendants* from the selected meta-network. 
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Symmetrize by Method 

Symmetrize turns directed or asymmetric network data into undirected 
or symmetric data. All three methods use a pair of values from the upper 
and lower portions of the table (e.g. cell 1, 3 is compared to cell 3, 1). If 
a network had a link from A to B but not from B to A then symmetrizing the 
network would create a reciprocal link from B to A. 

• Maximum Compares the values and uses the larger of the values. 
This is called using the strongest value. 

• Minimum Similar to Maximum only it uses the lower, or weaker, 
value. 

• Average takes the two values and averages them. 

Symmetrize bipartite graphs: 

Symmetrize bipartite graphs* combines networks in the Meta-Network that are 
transposes of each other; for example, if there is an Agent x Location 
Network and a Location x Agent Network, then a single Agent x Location 
Network is created by combining the edges from both Networks. 

This is used to reduce the number of Networks in a Meta-Network when Link 
direction does not matter. 

Remove Links: 

When using weighted links this functions allows for links to be removed 
from view. You can choose form six options for the removal of links. 

 

Binarize (set link weights to one): 

Binarize* takes all links weighted greater than 0 and make them all equal to 
"1". All links will be either 1 or 0. 

Create partition Networks by attribute: 
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This partitions the Node Set according to the values of the specified entity 
attribute and then creates a group of new graphs based on the partitioned 
Meta-Node. This kind of grouping is often done in network analysis to 
understand how some Meta-Nodes are embedded in various social roles or 
how they interact within larger Meta-Nodes. The dropdown menu will contain 
all the attributes in the meta-network. 

Example, if you have an Agent Meta-Node that has a gender attribute for 
each node that takes on values male and female, then using this feature 
four new Agent x Agent Networks would be created that contained links from 
males to males, males to females, females to males, and females to 
females. No new Meta-Node is created and no data is changed. 

Create union matrices 

This creates new graphs that are the union of all graphs of the same type. If 
the Meta-Network had two Agent x Agent Networks, then using this feature 
would create a new Agent x Agent Network which would contain all the links 
that were present in the original two Networks. 

Create a meta-matrix (one matrix with one node class) 

Creates a new Meta-Network with a single NodeClass and a single 
Network. The nodes are prefixed with the name of the NodeClass they were 
taken from. 

The "Individual Networks" tab 

Choose one or more networks to transform by placing a checkmark 
in the box. If you want to exclude a network, remove the checkmark. 

Then select one or more transformations to apply : 

 

Symmetrize by method :  
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Symmetrize is a tool that is used to turn directed or asymmetric network 
data into un-directed or symmetric data. All three methods use a pair of 
values from the upper and lower portions of the table (e.g. cell 1, 3 is 
compared to cell 3, 1) 

Remove links :  

When using weighted links this functions allows for links to be removed from 
view. You can choose form six options for the removal of links. 

Binarize (set link weights to one) :  

Will take any weighted link and make them all equal to "1". 

Transpose the given matrix :  

 
Meta-Network Anonymizer 

 Meta-Network Anonymize tool removes IDs (and optionally Titles) 
from any chosen NodeClass. This is particularly helpful if you are discussing 
sensitive network information about real people and wish to remove their 
names from the network model.  

The Visualizer 

Visualizer Before Anonymizing : When you load your network model into 
the Visualizer, you will see (by default) the names of your agents or 
applicable entity class nodes. You may, for a number of confidentiality 
reasons, wish to hide this information from your audience yet still show 
them visually what the network can reveal.  
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Visualizer After Anonymizing : None of the nodes have recognizable 
names and only the link and network information is known. 
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Meta-Network Anonymizer dialog 

From the main menu select Data Management > Meta-Network 
Anonymize.... 

The Meta-network Anonymizer tool will appear in a pop-up window. Here 
you can select a number of parameters pertinent to the node classes you 
wish to anonymize.  
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1. Select a Meta-Network : All active Meta-Networks appear in the 
drop-down menu. Select the Meta-Network to anonymize. 

2. Friendly names : The user can create a list for each NodeClass of 
names that will not be anonymized. 

3. Anonymizer values :  

4. Options :  

o Remove alias attribute :  

o Remove latitude/longitude attributes : Removes geospatial 
attributes from the Meta-Network. 

o Anonymize only titles :  

o Create anonymized name attribute : If you would like to use 
descriptions other than Titles or IDS, you can generate your own 
terms. This is intended to be used with the friendly Anonymizer 
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tool but can be used for whatever reasons you deem fit. To do 
so, be sure the create Name Attribute is checked then enter 
your own term. 

5. Anonymize button : Click the button when you are ready to crate an 
anonymized file. 

Writing an Anonymized file : When the [Anonymize] button is selected 
ORA writes a .CSV file. The Save box allows the user to navigate to a 
directory to save the file. 

Encoded ID,Original ID 
A-1,A01 
A-2,A02 
A-3,A03 
A-4,A04 

Node Title : If the Anonymize node title is selected then ORA will also 
write the original Title to the file. 

Encoded ID,Original ID,Title 
E-1,E01,revanna_meeting 
E-2,E02,summit_meeting 
E-3,E03,revanna_bombardment 
E-4,E04,sgc_meeting 
 

 
Meta-Network Union 

 Meta-Network Union is used to combine two or more Meta-Networks 
together. There are tools to select which Meta-Networks to use or exclude 
and how to combine the link weights. ORA can save out the result as an 
entirely new Meta-Network file.  
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Select a collection of meta-networks : allows the user to define the 
Meta-Networks to combine. It has two options. 

1. Currently loaded in ORA : will create a new Meta-Network using all 
the currently loaded Meta-Networks. 

2. All files in the directory : will create a new Meta-Network from all 
the files in a specified directory. 

Select filters : narrows the Meta-Networks to use. If the Use only meta-
networks in the date range: is checked you will need to fill in the Begin 
and the End dates. This will filter out Meta-Networks which fall outside those 
dates. 

Select how to combine edge weights: contains the options for how to 
reduce the amount of edges within a Meta-Network. The options are 
Minimum, Maximum, Average, Binary, and Sum. 
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Treat the meta-networks as semantic networks :  

Union link sources and properties :  

Example 

There are two Meta-Networks currently in ORA, stargate_summit_allies 
and stargate_summit_badGuys. These will be joined together into a 
single Meta-Network using the Sum option. Both the existing Meta-Networks 
contain 15 nodes. 

 

There will appear in Pane 1 a new Meta-Network called Union which is a 
combination of the two other Meta-Networks. 

 

 
Attribute Partition Tool 

 To create new Meta-Networks which are a subset of nodes use the 
Attribute Partition. Select an Node-Class(es), select the Attribute set, then 
select the individual attribute(s) to form a new Meta-Network. 
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There are four sections to the dialog box: 

Select a Meta-Network: The dropdown menu lists all the currently open 
Meta-Networks 

Select Node Class(es): Place a checkmark in the box(es) of the NodeSets 
you want included. 

Select an attribute: This drop-down menu shows all the attribute(s) 
contained within the selected NodeSet(s). If you change the NodeSet(s) the 
choice of attribute(s) will be reflected in this dropdown. 

Attribute Value: Place a checkmark in the box(es) of the attributes you 
want included in the new Meta-Networks. Each attribute check marked will 
create a separate Meta-Network. 
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When you click the [Compute] button ORA will tell you how many new 
Meta-Networks were created and you will see them in pane 1 of the GUI. 

Example 

I selected the Stargate Meta-Network and used the ally attribute. In the 
value section I selected Yes. IN the new Meta-Network I selected the agent 
x location network. 

 

Below is the original Stargate agent x location network with the nodes and 
links not in the new network grayed out. 
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With the partition attribute network only the nodes associated with ally=yes 
are shown in the new network.  

 
Randomize Existing Network 

 Randomizing Links is commonly done to test a hypothesis about a 
given network. If after conducting experiments, there is no significant 
difference between a hypothesis and a random graph, the evidence 
supporting the hypothesis could be weak. 

A Random Graph : is obtained by starting with a set of n nodes and 
adding Links between them at random. Different random network models 
produce different probability distributions on networks. 

The theory of random networks studies typical properties of random 
networks, those that hold with high probability for networks drawn from a 
particular distribution. For example, we might ask for a given value of n and 
p what the probability is that G(n,p) is connected. In studying such 
questions, researchers often concentrate on the limit behavior of random 
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networks-the values that various probabilities converge to as n grows very 
large. Percolation theory characterizes the connectedness of random 
networks, especially infinitely large ones. 

Random networks are widely used in the probabilistic method, where one 
tries to prove the existence of networks with certain properties. The 
existence of a property on a random network implies, via the famous 
Szemerédi regularity lemma, the existence of that property on almost all 
networks.  

Creating a Random Graph : is a function which randomizes the Links in a 
Network. From the main menu select Data Management > Randomize 
Links. From the dialog box select from the drop-down menu. A new Meta-
Network will appear in Pane 1 and it's name will denote it has been 
randomized. 

 

The original Meta-Network is selected and the Network agent x agent is 

chosen. From the Info Tab in the Editor the button is 
clicked. This displays the Network as it appears in the original Meta-Network. 
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Now select the newly created randomized Network and select the agent x 

agent Network. From the Info Tab in the Editor the 
button is clicked. This displays the Network as it appears in the randomized 
Meta-Network. 

As shown in the Visualizer the links have been randomized. 
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Generate Network 

 
Create New Meta-Network : Creates a new blank Meta-
Network. 

 
Influence Network Generator : Creates an Influence Network 
file for use in the external program Pythia. 

 
Command and Control Structure Generator : Creates Network 
files for use in the external program Caesar III. 

 

Create New Meta-Network In Visualizer : Creates a blank 
Meta-Network in the Visualizer which can be populated with 
NodeClasses and Networks from scratch. 

 Create Stylized Network : Generates new Networks using 
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various Mathematical formulas including Erdős-Rény, Core-
Periphery, Scale-Free, Cellular, Lattice, and Small-World 
Networks. 

 

Create Expected Interaction Network : Predicts the expected 
interaction of a network given known tasks and other available 
network data. You can create an Expertise Correlation, a 
Similarity Correlation, a Distinctiveness Correlation, or a 
Resemblance Correlation. 

 

 
Influence Network Generator 

Influence Network : is a hypotheses regarding tasks, performance, 
event happening, and related events. This functions covers how to 
generate an influence network from a social network using ORA and 
examines the probability of event happenings based on the state and 
influence of supporting nodes. 

The Influence Network Generator tool in ORA takes a Meta-Network and 
outputs an influence network that is readable by another software program, 
Pythia. Pythia, a software tool developed by George Mason University, has 
the ability to reason about an influence network's structure extracted by 
ORA. Therefore, ORA and Pythia can work in conjunction to perform an 
influence network analysis. Essentially, ORA generates the network and 
Pythia tells you something about it.  

ORA generates influence nets for Pythia from Meta-Networks. ORA can also 
read in a Pythia influence net and assess its structure. After ORA generates 
an influence network, the user then has to work with Pythia and a SME 
(subject matter expert) to get the probability distributions to make sense. 
The key advantage is by inferring the influence network from the meta-
network via ORA you save a lot of the start-up time in performing an 
influence network analysis. 

The ORA file generated by this function is directly loadable in Pythia. It is not 
a complete influence network and the user will need to make adjustments to 
the generated networks. It uses basic ontological interpretations and 
inferred baseline probabilities where the user specifies positive/negative 
probability. 
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We create an influence network based on: Extracting a task network which 
directs the target task to analyze. Then examine the complexity, 
importance, personnel/resource/expertise assignment of the tasks. 

The examinations become influence network nodes containing ontological 
interpretation when: The task is done — the task is complex — the task is 
important — there are sufficient actors associated with the task — resources 
are available — expertise is available. 

Then links are created as in the task network and background hypotheses 
nodes link to a task node. 

Running the Routine : From the main menu: File > Influence Network 
Generator. This brings up the Influence network step by step creation 
dialog box. There are three options: Task Based, Event Based, and Belief 
Based.  

 

After selecting the creation type and clicking [Next] you will be presented 
with a number of steps depending on what information needs created. 
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Information on the thresholds you want and other data will be input in the 
dialog boxes until the final screen is reached. 

 

When all the information is input a dialog box with the results will display. 
This is the final check before clicking the [Convert] button and saving the 
file. 

Il-Chul Moon, Destabilization of Adversarial Organizations with Strategic 
Interventions, PhD Thesis, School of Computer Science, Carnegie Mellon 
University 

 

Extracting a Task Network for the Influence Network 
Generator 

What follows are procedures to extract a Task Network for the Influence 
Network Generator. 

In a Meta-Network there is an event-to-event network and a task-to-task 
network. Choose one task to analyze. 
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Here we look at bomb preparation. Find the tasks that need completed to 
accomplish the objective. Then trace from provide_money, get_money, 
purchase_oxygen.  

 

The complexity of the task depends on three items. Resources / Expertise 
required and number of person required.  
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• Very Low (default baseline=1.0): 0 resource/expertise required / 1 
person required. 

• Low (default baseline=0.9): 1 resource/expertise required / Less 
than 3 persons required. 

• Medium (default baseline=0.8): Less than 4 resource/expertise 
required / Less than 4 persons required. 

• High (default baseline=0.7): Less than 8 resource/expertise 
required / Less than 7 persons required. 

• Very High (default baseline=0.6): More than 7 resource/expertise 
required / More than 6 persons required. 

 

The importance of the task is determined by using standardized degree 
centrality and betweenness (ranging (0~1): 

• Very Low (default baseline=0.4): Not connected to other tasks 

• Low (0.5): Low out-degree density and low betweenness in task 
network 

• Medium (0.6): Medium out-degree density and low betweenness in 
task network 

• High (0.7): High out-degree density or medium betweenness in task 
network 

• Very High (0.8): High out-degree density in task network 
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The actor assignment of the task is determined by sufficient actors, which 
are associated with the task. 

• No personnel (default baseline=0): No assigned actors 

• Insufficient (0.25): Only 75% of resources/expertise are covered by 
assigned actors. 

• Almost sufficient (0.5): More than 75% of resources/expertise are 
covered by the assigned actors. 

• Sufficient (0.7): At most one person associated with each resource 
and each expertise connected to the task. 

• More than sufficient (0.8): More than one person associated with 
some resources and expertise connected to the task. 
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Resource / Expertise availability 

Finds if Expertise and Resource are directly accessible. The availability is 
determined as follows: 

• Redundantly available/accessible baseline probability=0.75): 
More than one person with the expertise associated with the task. 

• Available/accessible (0.6): One person with the expertise/resource 
is associated with the task. 

• Unavailable/unaccessible (0.25): No person with the 
expertise/resource is associated with the task. 

Learn more... 

Il-Chul Moon, Kathleen M. Carley, and Alexander H. Levis, Inferring and 
Assessing Informal Organizational Structures from an Observed Dynamic 
Network of an Organization, Management Science, 2008, Submitted and 
under review 

Il-Chul Moon, Kathleen M. Carley and Alexander H. Levis, Vulnerability 
Assessment on Adversarial Organization: Unifying Command and Control 
Structure Analysis and Social Network Analysis, SIAM International 
Conference on Data Mining, Workshop on Link Analysis, Counterterrorism 
and Security, Atlanta, Georgia, Apr. 26, 2008 

 
Pythia 

Pythia is a timed influence net application. Conversely, data from Pythia can 
be loaded into ORA using the Data Import Wizard.  

In conjunction with the Pythia application from George Mason University, 
data from ORA can be loaded into Pythia to create organizational displays.  

What follows is a brief example of creating an organizational display using 
ORA with Pythia.  

Start from an ORA Task Network (shown below) 



 

 
121 

 

 

The data can be loaded into Pythia to create an organizational display. 
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Reference at the George Mason University web site: 
http://sysarch.gmu.edu/main/software/ 

Contact George Mason at the above URL for instructions on downloading 
Pythia and additional instructions on how to use the tool.  

Learn more... 

Il-Chul Moon, Destabilization of Adversarial Organizations with Strategic 
Interventions, PhD Thesis, School of Computer Science, Carnegie Mellon 
University 

  
Command and Control Structure Generator 

C2 Structure and Meta-Network 

A Meta-network is a representation of a complex adaptive system. This 
system it has agents, expertise, resources and tasks. And inherent in this 
data are Meta-networks that contain the C2 structure of an organization, 
which are the links of a social network among commanders represented in 
the following ways: 

• Command chains 

• Information sharing relations 

• Result/response sharing relations 

However, meta-networks may only have one commander-to-commander 
network without classifying the nature of links. An analyst oftentimes needs 
a method to infer the nature of relations among commanders based on a 
given meta-network. That is where this tool can help. ORA uses the task 
assignment and communication directions to infer the nature of a link. 

C2 structure in CAESAR III : Design View and Analysis View can be 
generated from a series of matrices describing the communications among 
decision makers (agents). The goal should be producing the matrices out of 
a social network. The analysis view has cognition aspects The nature of a 
link is determined by the timing of communication during the decision 
making process. 

http://sysarch.gmu.edu/main/software/�
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Meta-Network : Network among people (, knowledge, resources, tasks, 
etc). Data for statistical analysis, not exactly an analysis tool. Reveal the 
organizational structure, influence propagation, command and control 
structure, etc. Widely used in organizational science, counter-terrorism, 
structure reformation, etc. 

C2 structure extraction in ORA : ORA provides a function, Command and 
Control Structure Generator. Automatic generation of C2 structure based on 
a target task and a social network among decision makers. Generated 
influence network is directly loadable in CAESAR III. It is not a complete C2 
structure but a reasonable inference (or approximation). 

C2 Structure Generation Procedure 

Determine a target task to analyze. Extract the task network of the target 
task. Extract the related (assigned) agents of the task network. The other 
agents are aggregated and represented as the outside world (IN and OUT). 
Regard the agent-to-agent network as a information sharing network. 
Determine the network level based on the link directions and network 
topology. Then, extract a command chain from links bridging different 
network level. Determine the result sharing requirement based on the task 
network (i.e. the link direction between the two tasks indicate the result 
sharing requirement) Then, create a result sharing network based on the 
requirements. 

 

 

Extracting a Task Network for the Command and 
Control 

What follows are procedures and an overview of extracting a task network 
for command and control analysis using ORA in conjunction with Caesar III, 
an external software tool for task network analysis.  

In a Meta-Network, there are event-to-event networks and task-to-task 
networks contained in most data sets. We select one task to analyze and use 
ORA's command and control tool to discover the steps needed to complete 
this task from beginning to completion.  

In the images below, we are extracting a task network needed for the 
bomb_preparation task node. 
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The idea is to find how tasks should be completed to accomplish the 
objective, bomb_preparation (e.g., find the trace to a purchase_oxygen 
task. Provide_money —> get_money —> purchase_oxygen). 

 

Assigned Agents 

Identify the task network. Find all the assigned agents. Agents directly 
linked to a task in the task network. 
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Approximated Information Sharing Network 

Just the agent-to-agent network in a meta-network. 

 

Inferred Command Chain 

Determine the network level. Find the inferred hierarchy of the organization. 
Find the command chain from the hierarchy. 
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Red arrows are command chains. Purple arrows are social network links. 

 

Inferred Result Sharing Network 

The task network defines the task prerequisites. Then, the result of a task 
should be informed to the agents doing the next task. Create a result 
sharing network by using the above inference rule. 
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Ahmed_ghallani should inform the result of purchase_oxygen to the agents 
doing bomb_preparation. Purchase_oxygen is a prerequisite of 
bomb_preparation. 

Visualization by CAESAR III 

Generated by ORA. Target task : surveillance. Design view and analysis view 
in CAESAR III. 

 

Learn more... 
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Il-Chul Moon, Kathleen M. Carley, and Lee W. Wagenhals, Estimating Task 
Success Likelihood by an Influence Network Generated from an 
Organizational Structure, Organization Science, 2008, Submitted and under 
review 

Il-Chul Moon, Eunice J. Kim and Kathleen M. Carley, Automated Influence 
Network Generation and the Node Parameter Sensitivity Analysis, 
International Command and Control Research Technology Symposium 
(ICCRTS’08, DOD CCRP conference), Bellevue, WA, Jun 17-19, 2008 

  

 
Create Stylized Networks 

Stylized Networks : are models built upon common network structures 
evident in many real world environments.  

Create Erdős-Rényi Network : A model for generating random graphs by 
setting an Link between each pair of nodes with equal probability, 
independently of other Links. 

Create Core-Periphery Network : The core-periphery structure of the 
network has a dense central core of key agents and a large periphery of 
marginal agents. 

The core-periphery structure is an ideal typical pattern that divides both the 
rows and the columns into two classes. One of the blocks on the main 
diagonal (the core) is a high-density block; the other block on the main 
diagonal (the periphery) is a low-density block. The core-periphery model is 
indifferent to the density of ties in the off-diagonal blocks. 

When we apply the core-periphery model to actor-by-actor data 
(Core/Periphery), the model seeks to identify a set of actors who have high 
density of links among themselves (the core) by sharing many events in 
common, and another set of actors who have very low density of ties among 
themselves (the periphery) by having few events in common. Actors in the 
core are able to coordinate their actions, those in the periphery are not. As a 
consequence, actors in the core are at a structural advantage in exchange 
relations with actors in the periphery. 

Create Scale-Free Network : Some nodes act as highly connected hubs 
(high-degree), although most nodes are of low degree. Scale-free 
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networks' structure and dynamics are independent of the system's size N, 
the number of nodes the system has. In other words, a network that is 
scale-free will have the same properties no matter what the number of its 
entities is. 

Their most distinguishing characteristic is that their degree distribution 
follows a power law relationship, \mathbf{P(k) \sim k^{- \gamma}}, 

 

Where the probability P(k) that a node in the network connects with k other 
nodes was roughly proportional to , and this function gave a roughly good 
fit to their observed data. The coefficient may vary approximately from 2 to 
3 for most real networks. 

Create Cellular Network :  

Create Lattice Network : A Lattice Network is a large-world network where 
nodes are placed at the integer coordinate points of the n-dimensional 
Euclidean space and each node connects to nodes which are exactly one unit 
away from it. (i.e. if the lattice is two dimensional and the length of 
the lattice is 2 along the first and 2 along the second dimension, 
then it has 4 nodes and they're placed at coordinates (1,1), (1,2), 
(2,1), (2,2)) The two nodes are connected if the difference of one of their 
coordinates is one or minus one and all their other coordinates are exactly 
the same. 

Create Small-World Network : A type of graph in which most nodes are 
NOT neighbors of one another, but most nodes can be reached from every 
other node by a small number of hops or steps. A small world network, 
where nodes represent people and links connect people that know each 
other, captures the small world phenomenon of strangers being linked by a 
mutual acquaintance. 

The small-world behavior is characterized by the fact that the distance 
between any two inks is of the order of that for a random network and, at 
the same time, the concept of neighborhood is preserved. 

A Small-World Network is a regular network with a degree of random long 
range connections. It is rarely disrupted by the elimination of one node. 

Fixed Degree-Distribution Network : A random graph is constructed by 
specifying as input: (a) the number of nodes in the network, and (b) the 
number of link for each node. The graph is random according to the input, 
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however it should be noted that not all degree sequences are illogical so this 
algorithm may produce an empty graph as a result. read more… 

 
Fixed Degree-Distribution Network 

Create Fixed Degree Distribution : creates a random graph constructed 
by specifying as input: (a) the number of nodes in the network, and; (b) 
the number of links for each node. The graph is random according to the 
input, however it should be noted that not all degree sequences are illogical 
so this algorithm may produce an empty graph as a result. 

 

Allow self-loops : Checked allows the generation of a node tied to itself. 
Unchecked disallows the generation of a node tied to itself 

Construct directed-tie network : Checked generates directed network. 
Unchecked generates an undirected network 

If directed, then count is inbound, else outbound : Checked the 
degree list is incoming ties. Unchecked the degree list is outgoing ties 

Degree list : Enter the degree listing – in the desired node order. The input 
for the degree sequence is a comma delimited list of the number of edges. 
Correspondingly, the number of nodes is determined by the number of 
parameters entered.  

To facilitate simplified entry, a shortcut can be made by specifying the 
number of nodes at a specific number of edges. Further, the node id in the 
generated graph will correspond with the position in the input string. 
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Degree sequences that are illogical will be impossible to generate, e.g., 
2@20 (two nodes with 20 ties each; impossible because the maximum ties a 
node can have in this network of size two is 1 tie.) Further, some networks 
can be difficult to produce due to the specific degree distribution and the 
random process used to construct the network, so the algorithm is designed 
to make up to 10 separate attempts at constructing the exact distribution. 
After 10 attempts, the algorithm will return the error meta-network. The 
user may chose to resubmit the same request for another up-to-10 attempts 
at making the network. 

For example, the following are valid input strings (with self-loops off and 
undirected): 

• 1,5,3,0,1 - produces a 5 node network with one isolate and 2 
pendants, etc. 

• 3@2, 0, 0 - produces a 5 node network with 2 isolates and 3 nodes 
with 2 edges. 

• 10@5,10@3 - will produce a 20 node network 

The following are valid input strings but illogical: 

• 100,0,1 - is illogical and will produce a null meta-network named with 
an error message 

• 3@2,1 - is illogical and will produce a null meta-network named with 
an error message 

• 10@5,10@3,1 - is illogical will produce a null meta-network named 
with an error message 

 
Create Expected Interaction Networks 

• Below is an image of the Expertise Correlation tool in ORA and 
procedures on using the various options it contains: 
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•  
• Below are links to the Measures section pertaining to each 

Correlation. 
• Expertise Correlation… : Measures the complementarity of two agents 

based on their knowledge. 

•  
• Similarity Correlation 
• Measures the degree of similarity between agents based on the 

number of knowledge bits they both have. 

•  
• Distinctiveness Correlation… : Measures how distinct are two agents 

based on the number of knowledge bits they hold oppositely. 

•  
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• Resemblance Correlation… : Measures the degree of resemblance 
between agents based on the number of knowledge bits they both 
have or both do not have. 

•  

 

 
Analysis Menu 

 

Generate Reports – Brings up a dialog box that enables you to 
run any report on any currently active Meta-Network then select 
the format you want the results. 

 
Report Selection Wizard – Assists you in selecting the best 
reports for the selected Meta-Network. 

 

Measures Manager – The option allows you to choose which 
measures are to be used in generating reports for the selected 
Meta-Networks. The dropdown menu allows you to chose 
measures lists which divide them up into categories such as: 
Slow Measures, Critical Risk Employees, and Resource 
Allocation Risk. 

 

Latent Semantic Analysis – Latent semantic analysis (LSA) is a 
technique in natural language processing, in particular in vectorial 
semantics, of analyzing relationships between a set of documents 
and the terms they contain by producing a set of concepts related 
to the documents and terms. 

 Correspondence Analysis :  
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Geary-C & Moran-I Analysis... : This function performs Moran's 
I test using phylogenetic and spatial link matrix (binary or 
general). It uses neighboring weights so Moran's I and Geary's c 
randomization tests are equivalent. 

 

 
Generate Reports 

 Creates reports on the selected Meta-Networks. These reports are 
detailed in the Reports Section. 

You can choose an individual report from the drop-down menu or use the By 
Category drop-down menu which forms them into groups by function. All 
measures are in both drop-downs. 

 

Transform : allows you to select the method the Meta-Networks are 
changed prior to running the report which can be seen by clicking the 
[Options >>] button. 
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General mathematical transformation :  

Remove node :  

Partition nodes into separate Meta-Networks by attribute value :  

Click [Next>] 

This next screen will differ depending on which report was chosen. For some 
reports you will be taken directly to the print screen. For others there will be 
additional information you need to specify. 

The Final Print Screen : allows you to chose whether to write the file to a 
Text, HTML, CSV, or PowerPoint file and tell ORA where to save it. You 
can also choose to use a different filename for all the reports written. 

 
Report Selection Wizard 

 There are a lot of reports to choose from in ORA and you may have 
difficulty, at least initially, in determining which one is exactly right for you, 
especially if you are new to ORA. Likewise, the Report Selection Wizard 
helps you pick the right report by first prompting you with a series of 
questions relevant to the type of analysis you are seeking. Based on your 
answers, this tool will tell you the type of report to run and then it will run it. 
To access this tool in ORA, follow this path: 

From the main menu select Analysis > Report Selection Wizard 

Then you will see the following pop-up window (screen shot below): 
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Check the box(es) for the Meta-Network you need to analyze. Then click the 
[Next] button. 

This will bring up a screen asking Which of the following aspects do you 
want to focus on?. This is the Who, What, Where, or When choice. 
Select one and click the [Next] button. 

The next dialog box presents you with the question: Please select one of 
the following:. Choose one of the questions and click the [Next] button. 

Do you want to know about the critical actors? The key word here is 
critical. This report will then find and rank the actors that are the most 
critical to your network, which can lend insight to who, if removed, might 
potentially impact the network the most. 

Do you want to find a path between actors? The key word here is path. 
Path refers to the connections between any two actors in your network. For 
example, if Bob is connected Carol and Carol is connected to John, then 
Bob's path to John is 2 links (via Carol).  

Do you want to know who someone influences or could possibly 
influence? The key word is influence. Typically one has influence, to some 
degree at least, on other people one connects to in a network. This is to say, 
if you have a connection to Joe and you are removed from the network, then 
Joe's connections to you are altered. You would be said to have a form of 
influence over Joe. However, some individuals may have influence that 
extends beyond a path length of 1.  
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Do you want to know if there is possible missing data? The key word 
her is missing. This report will help identify possibly segments of missing 
data in your network if it appears certain conclusions are without proper 
network justification. Again, this is accomplished through algorithmic 
calculation. On a simple level, it might be said that if Peter, an accountant, 
has access to certain resources that only Susan, a director, has official 
access to; yet Peter uses those resources as well, it may be we are missing 
a link in our network data from Peter to Susan.  

Do you want to know if there are groups? The key word here is 
Groups. Groups can sometimes be hard to spot visually, especially giving a 
complex and large Meta-Network. This report will reveal the groups present 
in the existing Meta-Network. 

The group choices are as follows:  

• Newman 

• Concor 

• FOG 

Do you want to know what type of network this is? This question 
pertains to the topology of the network, or what sort of common network 
pattern your model could be classified into. This option will give you the 
type. For example, cellular, lattice, small world, etc. 

ORA will display another information pop-up box, which tells you exactly the 
report ORA has determined to be most appropriate based on your data and 
your answers as to what information you are seeking to obtain about your 
network model. 

After selecting [Finish] ORA will generate it's reports and open them in both 
your browser and also in panel 3 of the main interface. Below is the 
beginning of the report run on the Stargate data set. Since this function has 
such a large number of possibilities, we will only show part of the beginning 
of the report in the interest of brevity. 

 
Measures Manager 
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 Before you run any measures on a Meta-Network you can use the 
Measures Manager to set exactly the measures you wish to compute. 

Form the main interface menu select Analysis > Measures Manager. 

 

The dialog box has multiple sections: 

Filter Commands : 

This section comprises two radio buttons (Match at least one filter | 
Match all filters) which allow for complex filtering, a [Reset Filters] button, 
and a Search text box used for inputting your search. Whatever searches 
you input in this section are reflected in the Tabbed Window below. It will 
display only the nodes which match the search(es). 
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item(s) Selected | Visible | Total 

When first called up the All Measures tab defaults to showing every 
measures available. When started there were 137 item(s) selected, 137 
visible, 137 total. 

Selecting the Slow Measures tab this changes to 16 item(s) selected, 16 
visible, 16 total. 

Typing Cognitive into the search text box reduces this to 16 item(s) 
selected, 8 visible, 16 total showing that only 8 out of the 16 Slow 
Measures contain the word Cognitive. 

Furthermore you can deselect measures by removing the checkmark next to 
the measure's name. With each measure deselected the number of selected 
items will reduce by one. 

With these tools you can select only the measures you want to run reports 
on. 

Buttons 

• Reorder 

• Select All : Selects (puts a checkmark in the box) all visible 
measures 

• Clear All : De-Selects (removes checkmarks) from all visible 
measures. 

Tabbed Window 

This section contains tabs which sort the measures into various categories. 

Each of the nine tabs sorts out the measures in different categories. This is 
very useful for large Meta-Networks when you'd prefer not run, say the Slow 
Measures* cause it would put too much a drain on your machine. By removing 
the checkboxes for the Slow Measures they are taken out of the mix and the 
reports will effectively ignore them. You can turn them back on when you're 
finished by placing a checkmark back in the box. 

In the Tabbed Window there are four columns: 
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1. Last Name : Deals the general type of measure (Congruence, 
Exclusivity, Cognitive...). Most entries in this column will display one 
row as they are singular in what they need to show. Others will display 
two rows as it's nearly the same measure run on both knowledge 
and resources. Then a few (like Centrality) will display quite a few 
rows the types of measures written for that type of measures are 
somewhat varied. 

2. First Name : Deals with the category of the measure (Betweenness, 
Closeness, Centrality...). This is a secondary factoring. 

3. Graph Level : Graph Level* produces a single number as output. 

4. Entity Level : Entity Level* produces one number per entity. 

Drop-Down Menu 

Gives the user the ability to select which currently active Meta-Network to 
run the measures on, as well as, which individual networks. 

 
Moran-I and Geary-C 

Description 

 Moran's-I : The measure of spatial autocorrelation to study stochastic 
phenomena which are distributed in space in two or more dimensions. The 
values of Moran's I range from +1 meaning strong positive spatial 
autocorrelation, to 0 meaning a random pattern to -1 indicating strong 
negative spatial autocorrelation. This particular statistic is designed for the 
measurement of spatial autocorrelation of ordinal, interval or ratio data. 

 Geary's-C : Based upon a paired comparison of juxtaposed map values 
and ranges between 1 and 2. Positive spatial autocorrelation is found with 
values ranging from 0 to 1 and negative spatial autocorrelation is found 
between 1 and 2. However, values can be found greater than 2 on occasion 
(Griffith, 1987). As similar values are in juxtaposition the numerator which 
measures the absolute difference squared between juxtaposed values will 
tend towards zero. Whereas, as non-similar values become juxtaposed the 
statistic will tend towards larger values in the numerator and thus towards 
its maximum value of two. 
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Select Proximity Network : Select a Meta-network from the first 
dropdown menu. The second dropdown menu will contain all the networks in 
the selected Meta-Network. 

Create Values Vector : There are three ways to select a value 

1. Use the values of attributes : uses an attribute within the Meta-
Network. 

2. Load values from file : browses for a file previously constructed. 

3. Use combined degree centrality of the networks : Place a 
checkmark for one (or more) networks within the selected Meta-
network to use. Combines the centrality to use in the formulas. 

Results : Displays the Moran-I and Geary-C results. 
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Simulations 

 

Near-Term Analysis : The Near Term Analysis (NTA) is a tool 
that allows for the removal of nodes from a given organizational 
structure to evaluate how the organization will likely perform as a 
result. 

 OrgAhead :  

 

 
Near Term Impact Analysis 

The Near Term Analysis (NTA) is a tool that allows for the removal of 
nodes from a given organizational structure to evaluate how the organization 
will likely perform as a result. The Near Term Analysis tool uses a multi-
agent model as input, DyNetML*. 

The goal is to provide an answer to the question on how an organization will 
behave and change after considering a sequence of strategic interventions or 
personnel loss by way of agent removal. In other words, we want to know 
what happens when we remove nodes from an organization, be they people, 
places, resources, knowledge sets or other common Node Classes*. 

This example will use the Stargate dataset (SG-1). This dataset is 
included with the version of ORA downloaded and can be found online at the 
following url: 
http://www.casos.cs.cmu.edu/projects/ora/sample.php. 

From the menu bar select File ⇒ Open Meta-Network then select SG1.xml. 

In this example, we will remove two agents: daniel_jackson and 
maj_samantha_carter 

1. Open the SG1 Meta-Network into ORA. 

2. Highlight the SG1 Meta-Network before starting NTA in the ORA Meta-
Network Manager panel. 
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3. From the main menu select Analysis ⇒ Near-Term Analysis. 

NOTE : If your dataset contains an Organization nodeset ORA will display the NTA 
main window. If not, it will ask for you to chose a substitute Organization nodeset. 

 

When a Meta-Network is first loaded into ORA's the Near Term Analysis, a 
pop-up may appear asking for a location node. Select Cancel and proceed 
with the Near Term Analysis. 

 

The NTA main window consisted of four sub panels: Input Data, Settings, 
Simulation time line and Cases to simulate. Below is a brief description 
of each panel:  
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1. Input Data 

In this section is the file name of the Meta-Network loaded. 

2. Settings (Global Parameters) 

In the Setting area are two text boxes. The first, The Number of 
replications informs ORA how many times to run the simulation. The 
second, The number of simulated time-points defines the range in the 
section Simulation time line.  

In the settings area, there are two critical factors: 1) the number of 
replications and 2) the number of simulated time points. 

Why is this important? 

The number of replications if set at a higher versus lower value, will result in 
more experiments being conducted on the scenario the tool is presented. 
Therefore, the more replications the more likely the results will mirror those 
in a real world example. 
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The number of time points determines the length of the Near Term Analysis 
iterations. If this number is also set to a relatively high value, the simulation 
will take longer.  

NOTE : Be mindful of any memory considerations when running high value 
replications or time points. 

3. Simulation time line 

This are of the Near Term Analysis tool shows a visual representation of the 
time points selected in Settings area above. 

4. Cases to simulate 

After the settings (global parameters) are set, the virtual experiment cells 
need set. 

Initially, there is a pre-defined simulation cell, the Baseline. The Baseline is 
the cell without any entities removed as is the control situation when the 
organization does not experience any interventions. Besides Baseline, any 
other cells need set up. Start by selected Add new simulation instances, 
the leftmost of the four buttons. 

Add new simulation cases 

To run a Near Term Analysis, we will begin by selected the Add new 
simulations cases button from the main Near Term Analysis Tool (see area 
highlighted in red ellipse below).  
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After selecting Add new simulation instances button, a dialog box titled 
Near Term Analysis– Simulation scenario create wizard will appear. 
This wizard supports the creation of virtual experiment cells in three 
different ways. The First allows for the most freedom of choice. The second 
and the third options will ask for a set of criteria for selecting important 
agents in the network and make experiment cells according to the selection. 
Therefore, the first option gives full flexibility to users, and the second and 
the third option provides a systematic analysis setup method. To proceed 
this demonstration, select the first option and select [Next]. 
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There are four options: 

The next section explores all four of the Near Term Analysis Options: 

Run the Step-by-Step Wizard – This process will help walk through setting up a 
near term analysis experiment on the Meta-Network loaded into the Near 
Term Analysis tool. 

Create one simulation case – In this simulation experiment, events and user-
specified time can be applied to agents. 

Create a set of cases by isolating agents – This scenario isolates one agent and 
perform an experiment. Then the experiment can be performed again with 
the agent removed. 

Create a set of cases by isolating a set of agents relating to a specific measure. – Based on 
measures contained in the ORA intel report, a set of agents can be isolated 
and a simulation case can be created. 
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Near Term Impact Menu 

 

Save the current simulation setting: Brings up a save box where you can 
navigate to a directory and save all the current simulation settings. 

Load a simulation setting from a file: Navigate to a directory to load a 
previously saved simulation setting. 

NOTE : This will remove any settings that are currently active. 

Close: Closes the Near TermAnalysis window. 

 

Execute simulation cases: Begins running the simulation. Same function 
as the [Execute] button at the bottom of the window. 
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Show the add simulation wizard: Brings up the creation window. same as 
the [Add new simulation cases] button. 

Add ORA-Intel report based simulation cases: Same as [Add ORA-
Intel report based simulation cases] button. 

Edit the highlighted case: Brings up the dialog box to edit parameters for 
selected event. 

Remove the selected cases: Removes selected event from simulations. 

Remove all of the cases: Same as the [Remove all the simulations] 
button. 

 

 

These menu items will display in the Near Term Results menu:  

Generate evolved Interaction Matrix:  

Generate evolved Agent-to-Agent Matrix: Displays how agents interact 
with one another. 

Generate evolved Agent-to-Knowledge Matrix: Displays how knowledge 
is diffused within the agent network 

Generate evolved Agent-to-Task Matrix: Display how tasks are used 
within a network. 

 
Near Term Impact Option 1 

Step-by-Step wizard 

Selecting the first option brings up the step-by-step creation dialog box. 
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Under Options select whether to isolate an agent, knowledge, or 
resource. We'll leave it at agent. Then select the [Next] button. 

 

Under Options select the agent to isolate. Here we select daniel_jackson. 
The select the [Next] button. 
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Under Options select the time-step to isolate the agent. For this simulation 
we select 5. The select the [Next] button. 

 

At this point you are asked if you want to add more events to the simulation 
or not.  

You can add as many events as you wish. But for this example we'll only 
use only one event. Select [No] to continue. 

 

Now repeat the steps above and add a second simulation. But this time let's 
remove daniel_jackson at time-step 25. 
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Now proceed to Analysis Results. 

 
Near Term Impact Option 2 

Apply events to specified agents 

The second option for creating simulation files is to create one simulation 
case and apply events to specified agents, knowledge, or resource nodes. 

Select the [Add new simulation cases] button to bring up the wizard. 
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1. Type in a search criteria to highlight only the agents to work with (i.e. 
typing in dan brought up only daniel_jackson. 

2. Place a checkmark on the line. Notice that when you placed a 
checkmark in the box the Event automatically changed to Isolation. 

3. Double-click in the Timing cell to select it and type in a number from 
0 to the highest number you selected for your simulation. In this case 
we'll repeat with the timing of "5". 

4. Select the [Add events] button. This places the event in the 
Simulation event edit list section. 

5. If there were more events to add you could continue with the same 
procedure. When you are done, select the [Add a simulation] button 
at the bottom. 

The two buttons beneath the Simulation event edit list section to remove 
events from the list. The [Remove all the events] button obviously 
removes everything in the Simulation event edit list but the Remove the 
selected events from the event list only removes the events with a 
checkmark beside them. 

The [Reset selection] button removes all checkmarks placed in the bottom 
table and sets the Event to No Event. 

The [Previous] button returns to the main Wizard screen. 

When you have finished you will have created the same two simulations as 
in Option 1. 

 

Now proceed to Analysis Results. 

 
Near Term Impact Option 3 
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Create set of cases using Measures 

Option 3 allows for selecting agents/knowledge/resources based on their 
ranking when certain measures are run on them. 

 

Here are three examples run with the same Isolation Time and Cut-offs. 
Only the measures were changed. 

Centrality, Total Degree 

 

Cognitive Demand 

 

Clique Count 
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When you have run the measures proceed to Analysis Results. 

 
Near Term Impact Option 4 

A set of agents by a set of cases by measure(s). 

 

Option 4 allows the addition of adding Time gaps between the isolations 
and whether to isolate them in descending, Ascending, or Random order. 

Now proceed to Analysis Results. 

 
Near Term Impact Results Menu 
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Save the Construct launch scripts : Information on Construct can be 
obtained at the following URL: 
http://www.casos.cs.cmu.edu/project/construct/index.html. 

Show text report on the ORA main window : Displays the report in 
Panel 3 of the ORA Main Interface. 

Save the completely evolved MetaMatrices : Will save as an ORA Meta-
Network any of the simulation cases with a checkmark in the Select column. 

Save the html report : Navigate to a directory to save an html file that 
can be displayed in a browser. 

Save the text report : Navigate to a directory to save an text file. 

Save the Knowledge Diffusion line chart : Saves the chart as a .png file 
that can be used in other documents. 

Save the Task Accuracy line chart : Saves the chart as a .png file that 
can be used in other documents. 

Save the Energy Task line chart : Saves the chart as a .png file that can 
be used in other documents. 

Save the Knowledge Diffusion result CSV file : Saves the results as a 
.csv file that can be used in other programs. 

Save the Task Accuracy result CSV file : Saves the results as a .csv file 
that can be used in other programs. 

Save the Energy Task result CSV file : Saves the results as a .csv file 
that can be used in other programs. 

Close :  

 

Copy the chart in the clipboard : Copies the window to the clipboard that 
can be pasted into other programs. 
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Standard Deviation ranges : Standard Deviations* displays the range of 
values for a particular instance. 

Grid lines in the chart : Displays the grid lines for values. 

Legends in the chart : Displays the legend underneath the chart. 

Event annotations in the chart : Displays the event annotations within 
the chart. 
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Deviation from the baseline : Using the baseline numbers the chart 
shows the offset for the simulation. 

Show actual values : Uses he actual calculated values in the chart. 

 

Background color : choose the background color of the chart of either 
white or gray. 

 
Near Term Impact Results 

Now we're ready to Execute the simulations. But before that you must select 
the type of Output Options you want. From the Near Term Analysis menu 
select Output Options ⇒ {any or all of the four options}. 
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Now select the [Execute] button in the bottom-right corner. This will bring 
up two dialog boxes asking you to confirm you're selected output options 
and then an alert telling you that, this may take a while with a large Meta-
Network and a lot of simulation runs. 

 

An alert box will display advising you that the near term calculation may 
take a long time depending on settings of your experiment.  

 

After selected [Execute] the Processing Near Term analysis dialog will 
show you the progress. 

 

Next will be displayed the Near Term Analysis results window. 
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The results of the experiment will compare against the baseline data 
established prior to the removal of any isolated agents. In the example 
above, we can see how the network was impacted in the time line when we 
isolated daniel_jackson and removed this node from the data set. 

Further information can be obtained form the following 
references: 

For knowledge diffusion and energy task 

Schreiber, C. (2006) Human and Organizational Risk Modeling: Critical 
Personnel and Leadership in Network Organizations, PhD Thesis, Carnegie 
Mellon University, CMU-ISRI-06-120 

For binary task accuracy 

Lin, Z., K. Carley. 1997. Organizational response: The cost performance 
tradeoff. Management Sci. 43(2) 217-234.  
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Visualization 

 

Measure Charts – When run this function will plot the three 
graphs, Bar Chart, Scatter Plot, and Histogram on the chosen 
Network. 

 

View Measures Over Time – Requires multiple Networks. First 
plots points for measure selected on each of the Networks active 
with the option to see a direct line from the earliest to the latest 
point. 

 
View Network Over Time – Requires multiple Networks. 
Displays nodes and links for each of the active Networks. 

 
Network Drill-Down– Allows for quick, plotting of nodes 
connected to a chosen node. 

 
Node Cloud : Create an image with higher used concepts showing 
up in larger font sizes. 

 
Color Grid : Creates a colored grid representing the networks. 
White cells represent no connections. 

 

GeoSpatial Networks – Analyze, forecast, and visualize a wide 
variety of spatial interactions and networks within a global-scale. 
See GeoSpatial/Loom > GeoSpatial for more information 

 
View Trails – Works with nodes moving between places over 
time. Requires the use of a trailset. See Loom for more information 

View Networks 
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3D Visualization : Visualizes the selected network in the 3D 
Visualizer 

 
2D Visualization : Visualizes the selected network in the 2D 
Visualizer 

 
Path Finder : is used to find, not only, the shortest path between 
two nodes but also paths to other nodes when particular situations 
occur. 

 

Sphere of Influence : Each node within a network has a unique 
Sphere of Influence or Ego Network. Essentially it's a direct 
relationship with it's neighbors as a function of specified path 
length. The ORA Visualizer allows you to focus on this relationship 
by creating an Ego Map centered on any particular node you 
choose. 

 
Key Set Selector : uses information input by the user to create a 
simplified visualization. 

 

Blank Visualization : Opens the Visualizer with no active Meta-
Network. Allows you to create NodeClasses and Networks from 
scratch. 

 

 
Charts Types 

 Below are examples of each type of ORA charts: Bar Chart, Scatter 
Plot, and Histogram. 

Bar Chart 

A bar chart contains horizontal bars representing the individual nodes in 
the set. These rectangular bars are usually proportional to the magnitudes 
or frequencies of what they represent.  
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Bar charts are used for comparing two or more values. The bars can be 
horizontally or vertically oriented. Sometimes a stretched graphic is used 
instead of a solid bar. 

 

Scatter Plot 

A scatterplot uses Cartesian coordinates to display values for two 
variables. The data is displayed as a collection of points, each having one 
coordinate on the horizontal axis and one on the vertical axis. 

A scatterplot does not specify dependent or independent variables. Either 
type of variable can be plotted on either axis. Scatterplots represent the 
association (not causation) between two variables. 
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A scatterplot can show various kinds of relationships, including positive 
(rising), negative (falling), and no relationship. If the pattern of dots 
slopes from lower left to upper right, it suggests a positive correlation 
between the variables being studied. If the pattern of dots slopes from upper 
left to lower right, it suggests a negative correlation. A line of best fit can be 
drawn in order to study the correlation between the variables. An equation 
for the line of best fit can be computed using the method of linear 
regression. 

 

Histogram 

In statistics, a histogram is a graphical display of tabulated frequencies. A 
histogram is the graphical version of a table which shows what proportion 
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of cases fall into each of several or many specified categories. The 
histogram differs from a bar chart in that it is the area of the bar that 
denotes the value, not the height, a crucial distinction when the categories 
are not of uniform width (Lancaster, 1974). The categories are usually 
specified as non-overlapping intervals of some variable. The categories 
(bars) must be adjacent. 

The word histogram is derived from histos and gramma in Greek, the first 
meaning web or mast and the second meaning drawing, record or writing. A 
histogram of something is thus, etymologically speaking, a drawing of the 
web of this something. 
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View Measures Over Time 

 Using the View Measures Over Time on a Network allows an analyst 
to see how a network measures change over multiple time periods. If you 
use non-dated data, ORA will automatically represent your multiple Meta-
Matrices with simple integers (i.e., 1, 2, 3, 4...) 

Below is the Meta-Network Pane showing five time periods for the Tanzania 
dataset. 

 

From the main menu select Visualizations > View Measures Over 
Time... A dialog box will appear stating it will run on the currently loaded 
Networks. 

NOTE : If you have any Networks you do not want to use in your calculation 
hit [Cancel] and remove them from The Meta-Network Pane before 
proceeding. 

NOTE : It is of the utmost importance that the Networks in all Meta-
Networks are named the same. If not, the Over Time function will not work 
correctly. 

Computation Parameters 

First, the Computation Parameters dialog window appears. Here you can 
select the measures to use and whether to combine or transform the 
datasets. When done, click the [Compute] button to continue to the 
analysis. 

Measures Over Time window 
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This window is divided into three panes. 

The Measure Selector Pane contains tabs for all NodeClasses in addition 
to a Network Level tab. If the Network Level tab is selected you can 
choose which measure(s) to apply to the entire Meta-Network. If a 
NodeClass tab is chosen you can choose which Node(s) to view and in the 
Select a measure: text box select the measure to apply to them. All 
actions are instantly updated in the Charts Pane. 

The Restrictor Pane allows you to set the beginning and ending time 
periods and additionally you can skip any number of intermediary steps. 
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The Charts Pane contains three tabs and a legend at the bottom showing 
the colors associated to which nodes. 

Measures values :  

NOTE : Hovering over any measure will bring up a description of that 
measure. 

Fast Fourier Transform :  

Change Detection :  

 
View Measures Over Time 

 View Network Over Time : Uses all selected Meta-Networks for 
analysis in various time frames. Select all the Meta-Networks to use in the 
analysis. 

NOTE : It is of the utmost importance that the Networks in all Meta-
Networks are named the same. If not, the Over Time function will not work 
correctly. 

 

Now select from the menu Visualizations > View Network Over Time 
This will bring up the Visualizer along with the Networks Over Time 
window. 
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The Animation Tab controls the workings of the animation. It also contains 
the Play/Stop buttons. 

The Timeslices Tab contains checkboxes for all active Meta-Networks. 
Placing a check mark in the boxes will use that particular Meta-Network. 

The Clustering Tab allows you to set the time frame for clustering by day, 
week, month, or year. 

Animating the Display 

Pressing the Play button will start the animation. Below are the five agent x 
agent Networks. In different time slices new nodes appear and the 
connections between the agents changes. 
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Drill Down 

 DrillDown allows for any path to be followed. 

From the drop down textbox select the node you wish to start with. Here 
we'll begin with daniel_jackson. 
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The dialog box below will appear confirming you want to discontinue your 
last drill-down session. 

 

Click on the node and a contextual menu will appear with all the links it has 
to other nodes. I select <event> (5 nodes). 
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This shows the five events the daniel_jackson was at. 

 

Next I select summit_meeting and from the contextual menu select 
<resource> (4 nodes). 
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It drills down showing the five links to resource nodes connected to the 
summit_meeting. 

 

This can be continued for as long as you need. 

The [+] and the [-] buttons increase and decrease the font size. 
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Node Cloud 

 In ORA you can opt to visualize your data as a word cloud. A word cloud 
can loosely be described as a visual representation of words that appear 
within your data by displaying words that appear with the most common 
frequency as the largest. Below is a screen image of the SG1 data set as 
visualized in ORA's word cloud feature. 

 

Word Cloud Tools and Settings 

File : By accessing the File Menu you can open a previously saved Meta-
Network, Save an Image to the clip board, and close your Meta-Network 
word cloud. 

Options : In options, you can choose the measure you wish to apply to your 
word cloud visualization. 
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Horizontal Words : You can use this slider to set the ratio of the horizontal 
words visualized to the vertical word display (e.g. changing this setting to 
100% would result in all horizontal word visualizations and no vertical 
words. Conversely, changing this setting to zero has the opposite effect.  

Select a layout : Choose either word cloud layout (default) or a square 
layout. The square layout will attempt to visual your word cloud in 
approximate equal ratio of width and height.  

Min. Font Size : Sets the parameter for the smallest font size to display. 
Note: if you change this setting, click "run" to have the new setting applied.  

Max. Font Size : Sets the parameters for the largest font size to display. 
Note: if you change this setting, click "run" to have the new setting applied.  

Max Words : Sets a limit on the maximum amount of words to visualize 
(e.g., if you set this at 10, the word cloud will only visualize the words that 
appear in the top ten in terms of frequency.  

Run : Click [Run] to apply any changes to the settings. 

 
Help Menu 

The Help Menu contains information which is beneficial in running ORA. 

 Help Contents : Calls up this Help File System 

 System Monitor :  
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About ORA : Contains information regarding this software, the 
institute of origin, permissions and warranties, version and build 
dates, and Java usage. 

 

 
The ORA Visualizer 

The ORA Visualizer produces a graphical model of a Meta-Network 
comprised of Links and Nodes. Moreover, you can interact with your Meta-
Network model by removing key actors, isolating certain links, 
focusing on any particular relationship between two nodes using 
tools such as the Path Finder.  

You can apply a host of grouping algorithms, look at node's Sphere of 
Influence, Locate Nodes, which may be hidden in complex clusters of nodes 
and links. 

The Visualizer Interface 

Below is a visualized Meta-Network displayed with the current tools available 
in the Visualizer. In this view all nodes and links are visualized. Note the 
different palette areas and options available from the Visualizer.  
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Synchronization 

Synchronization allows you to work in the Editor and instantly see those 
effects in the Visualizer (or visa versa). Adding or removing a link in the 
Editor will place that link on the screen in the Visualizer. 

The ORA Layout Algorithm uses a standard spring embedder algorithm. 
For large data sets, this has been enhanced using the Barnes-Hut Simulation 
for calculating the force of repulsion between any two nodes. 
Reference :Nature 324, 446 - 449 (04 December 1986); 
doi:10.1038/324446a0, A hierarchical O(N log N) force-calculation 
algorithm, Josh Barnes & Piet Hut 
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The Visualizer Toolbar 

This section explains the function of each of the toolbar's default buttons. 
The user can add or remove buttons from the toolbars. These are explained 
in other sections of this help. 

When you first load a Meta-Network you will see the pause button 
depressed in the Visualizer tool bar. You can layout the Meta-Network by 
clicking the play button. The visualization will space apart across the screen. 
This is called laying out a Network. The Visualizer is separating nodes and 
links that, at first, appear on top of each other. You can pause this process 
again when you think the Meta-Network is satisfactorily spaced apart or you 
can let ORA lay out the entire Meta-Network. Your computer speed, as well 
as the complexity of Meta-Network, will determine how long this takes.  

 
Copy / Paste : This feature allows you quickly capture a 
visualization and save it to be pasted into another document later. 

  

Play / Pause : The Play Pause function works very similar to 
the play pause feature on any device. The pause button (two 
vertical bars) is depressed, the Visualizer stops laying out a 
Meta-Network. When the play button is depressed (right pointed 
triangle) ORA Visualizer begins laying out the Meta-Network as 
described above. The red ellipse highlights on the tool bar where 
this feature is located and accessible. 

 

Magnifying / Maximizing : The Magnifying Glass icon with the 
plus sign inside it, allows you to instantly fill the Visualizer window 
pane with the currently rendered Meta-Network. The red circle in 
the screen shot above highlights where to access this feature on 
the Visualizer tool bar. 

If there are any nodes off screen, clicking the button once will bring all the 
nodes into view on the screen. 
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NOTE : This function works well when selecting a small part of your overall 
Meta-Network and magnifying it to fill the Visualizer screen. 

 

Rotating The Visualization : To Rotate your visualization 
look for the word next to the Noon-pointing sundial icon in 
the tool bar. This feature is another way to manipulate your 
visualization to fill the entire Visualizer window pane. 

NOTE : Use this feature in conjunction with the magnifying glass function to 
work your visualization into largest size possible. 

 
Show Labels : The Show Labels button allows you to toggle the 
labels on & off in the Visualizer. Default is ON. 

 
Show links : The Show Links button allows you to toggle the 
links on & off in the Visualizer. Default is ON. 

 

Show Arrows : The Show Arrows button allows you to toggle 
the arrows on & off in the Visualizer and show directional data. 
Default is OFF. 

 

Font Size : The Font Size allows for setting the size of 
the font in the Visualizer. This allows you to change the 
size of the font to suit you needs for each individual 
Visualizer set. It ranges from 4, which is almost 
unreadable, to extremely large numbers, which can also 
be unreadable by virtual of overcrowding. So pick the size 
of font that best suits your screen. 
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Node Size : The Node Size allows for changing the node 
size, larger or smaller by increments of one. Four is the 
smallest size possible and creates a very small, almost 
indistinguishable dot. As the number increases is 
becomes easier to see the individual nodes until the 
number gets to a point where is can simply overpower 
the screen. But this gives you the ability to customize 
the entity size to suit your needs. 

 

NOTE : This also affects the size of the nodes in the Legend. 

  
Link Width : Allows for changing the general width of the line, 
larger or smaller. And as the options before you can pick the exact 
size which best suits your needs for the display. 

 

 
Meta-Node Size : Use the Meta Node Manager to handle 
creating and removing Meta-Nodes. 

 
Node Sizes : The Toggle Node Size button rotates through three 
sizes for the nodes (as seen below). 
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Hide Links by Weight : Use the Hide Links with Weight to select which 
links to display. As long as there are links with different values you can hide 
links of smaller values leaving only the more important links visible. This can 
assist in seeing links that might normally be too cluttered to view. Below left 
is a Meta-Network with all links in view. Below right is the same Meta-
Network with links less than 2.0 hidden. 

 

 

Drag : Used to move the view around the Meta-Network to see 
different parts. Press and hold the left mouse button and move the 
pointer around to view various parts of the Meta-Network. 
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 Marquee : Click and drag the marquee over nodes to select them. 

After releasing the mouse button the set of selected nodes will remain 
enlarged enclosed in a dashed line. 

 

After selecting a group of nodes they can be moved all together. Press the 
[Pause] button on the toolbar, switch to the [Move] tool, then grab and 
move the group. This is useful in creating displays of small portions of the 
Visualizer. 
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NOTE : Only one set of nodes can be selected at a time. Creating a second 
selection negates the first nodes selected. 

 

The Paint Tool : The Visualization Paint tool allows you to 
draw on the visualization.  You can select a brush size and a 
brush color via a small pop-up menu that appears whenever paint 
mode is selected.  Nodes are also selected whenever you stop 
drawing, using the shape drawn (plus a line from the endpoints of 
the drawing) as a giant polygon, which selects nodes based on 
whether or not they’re inside the polygon.  There’s also a “clear” 
button that removes all paint. “painting” works similar to using a 
marker on your computer screen – no matter how much you 
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zoom/pan/do whatever to the visualization, the marks will remain 
in the same place. 

 
Node Creator : You can create new nodes within pre-existing 
NodeClasses or create them in a new NodeClass. 

 
Link Creator : Click on one node then drag the pointer to a 
second node. A link between the two will be created. 

 
Node / Link Eraser : While the Eraser tool is active any node or 
link clicked will be removed from the Meta-Network.  

 

 
Show/Hide Labels 

 Node labels, which often prove helpful in describing Networks, can 
sometimes clutter a visualization. Thus, it may be necessary to eliminate 
labels from your visualization. To remove labels go to Visualizer tool bar and 
find the Show Labels button. 

This initial screen shot shows the Visualizer with all the labels. 

 

When you click the Label button on the Visualizer tool bar ORA toggles the 
labels on and off. Note that now a much more clearer conceptual picture of 
the network is produced. You can flip between the two views. 

 
Hide Links By Weight 



 

 
187 

 

ORA can visualize your network with only the more weighted links 
displayed. Below are procedures to accomplish this task.  

You can select to hide links either Less Than or Greater Than a certain 
value. Below is an agent x location network. And there are three tooltips 
displayed for jacob_carter for the values of 1.0, 2.0, and 3.0. We'll keep the 
hiding style as Less Than. 

 

First we'll increase the value to 1.1 hiding all lower values. The link to the 
hasaraSystem_spaceStation is removed from view. The others, however 
are still on the screen. 
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Now let's increase the value to 2.1. This removes the link from jacob_carter 
to Ravenna. 

 

If we increases to value to 3.1 then all of the links would be removed. 
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In this way you can remove links which are of lesser important to 
concentrate on a smaller set of data. 

 
Hyperbolic View 

The Hyperbolic function creates a bulge within your visualization adding a 
sense of depth. By moving the slider from right to left, you can increase or 
decrease this bulge effect and create different depth-added views. By 
moving the network around the window you can create the view you need. 
The Hyperbolic radio button and slider can be found at the bottom of the 
window. 

This tool is useful when nodes may be very tight on screen such as the ones 
in the following images. Using the Hyperbolic tool you can help space them 
out for easier viewing. Here is how to do so: 
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NOTE : The Hyperbolic function, when selected, converts the slider to this 
feature. This is also true of using the zoom and rotate functions. Use all 
three in conjunction to get your visualization just the way you want it. Scroll 
down below this screen shot for another when viewed with the Hyperbolic 
feature. 

 

Select the Hyperbolic tool and move the slider to the right. Then click-and-
hold on some part of the white background and move the entire network to 
the left. You will notice the space between the nodes begins to increase the 
closer them come to the center of the screen. 
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Now the nodes are able to be read much easier. 

NOTE : It is useful to use this tool in conjunction with the Rotate and 
Magnify tools to obtain just the view you desire. 

 
Rotating A Visualization 

You can rotate a visualization with the slider bar at the bottom of the 
interface or from the tool bar at the top. To do this from the slide bar, click 
the rotate option toward the bottom of the interface. This activates the 
rotate feature.  

As you move the slider from the left to right, your visualization will rotate 
correspondingly. From the tool bar, you can click inside the rotate icon, 
which will turn the visualization depending on exactly where you clicked.  

In the screen shot below, the yellow ellipses highlight where to access ORA's 
rotate tool both at the bottom and top of the Visualizer interface. 
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NOTE : Use the rotate feature in tandem with the magnifying glass to find a 
visualization's maximum screen size. 

 

 
Zooming 

At the bottom of the Visualizer interface is a sliding zoom bar (image below).  

You can drag the scrollbar left (to zoom out) or right (to zoom in).  

 

In the screenshot below the zoombar has been set to the far left, the 
absolute zoom out possible. At this point very little is distinguishable. 
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In the next shot the zoombar has been placed almost to the far right, 
absolute zoom in. It allows for extreme close-ups of various parts of the 
Meta-Network. 



 

 
194 

 

 

NOTE : Clicking on the Magnifying glass in the Visualizer tool bar will set 
the view to include all visible nodes. 

 
Visualizer Paint Tool 

 The Visualization Paint tool allows you to draw colored lines on a 
visualization. You can select a brush size and a brush color via a small pop-
up menu that appears whenever paint mode is selected.  
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Nodes are also selected whenever you stop drawing, using the shape drawn 
(plus a line from the endpoints of the drawing) as a giant polygon, which 
selects nodes based on whether or not they're inside the polygon. There's 
also a clear button that removes all paint. Painting works similar to using a 
marker on your computer screen - no matter how much you zoom/pan/do 
whatever to the visualization, the marks will remain in the same place. 

From the Paint Palette you can select a brush size by adjusting the slider. 
Then choose a color by clicking a pre-set colour or clicking the [Custom 
Color] button and select any color. Clicking the [Clear] button sets 
everything back to default. Once brush size and color are selected, you can 
draw on the Visualization. 

To undo your drawing click the [Clear] button. 

NOTE : If you pan the visualization, the paint drawing will remain stationery 
on the screen. It does not move with the visualization.  

 
File Menu 

 

Open Meta-Network : This opens an Open File dialog box so 
you can navigate to a directory and open a Meta-Network into the 
Visualizer. 
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 Open ORA-Image : 

 

Save Image to File : This opens a Save As… dialog box and 
allows you to save an image of the current Visualizer in one of the 
following formats: PNG, JPEG, SVG (scalable vector), or PDF. 

 

Save Meta-Network to File : After you've made changes to the 
information you can save the current status of the Meta-Network 
into a new file in a DyNetML* format. 

Save Special :  

 Save Meta-Network (Only Selected Nodes) :  

 Save Grouping to New Meta-Network :  

 Save Meta-Network (No Dotted Links) :  

 Save Meta-Network (Only Dotted Links) :  

 

 

Copy Image to Clipboard : 
Similar to the Save Image to 
File… only saves it to the 
clipboard where you can paste 
it into an image-editing 
program. 

 

Add Meta-Network to ORA : 
Save the currentlyvisible 
network into a new Meta-
Network titled, New Meta-
Network. This new Meta-
Network can be renamed 
accordingly. 
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Add Grouping to Current 
Meta-Network :  

 
Add MetaNodes to Current 
Meta-Network :  

 Visualize in 3-D :  

 GeoSpatial Networks :  

 Node Cloud :  

 

Close : Close the Visualizer 
and returns to the Main 
Interface. 

 
Save Image to File 

An image can be captured from the Visualizer and saved in one of four 
formats: 

• PDF : This format us usable with Adobe's Acrobat and Reader 
programs. 

• JPEG : A standard compressed format for image editing. 

• PNG (Portable Network Graphics). PNG is a bitmapped image format 
that employs lossless data compression. PNG was created to improve 
upon and replace the GIF format.  

 “ORA Images” are functional in regards to PNGs.  Whenever you save a 
PNG, relevant information about the visualization gets stored inside the 
image.  This makes saving a little longer, but not so long that you’d notice if 
you were not looking for it.  These images Node Colors, Node Location, 
Screen Center, and Zoom Value.   
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Loading images into a Visualizer will re-create the image inside the 
Visualizer.  Loading an image is as simple as dragging-dropping it onto the 
Visualizer.  

• SVG : Stands for Scalable Vector Graphics. SVG is an XML specification 
and file format for describing two-dimensional vector graphics, both 
static and animated. SVG can be purely declarative or may include 
scripting. Images can contain. 

Selecting Image Resolution on Save 

After choosing a format form the drop-down menu and specifying a filename 
press [Save]. A dialog box will appear asking for the quality of the image. 
The 1.0 saves the image in the same resolution. A higher number will result 
in a higher resolution image. 

 

Below are examples of an image saved with a scale of 1.0 (on the left) and 
then saved with a scale of 5.0 (on the right). Use a number higher than 1.0 
if there is a need for a higher resolution image. 
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NOTE : Values less than 1.0 are ignored when scaling images. 
 

 
Actions 

This section of the help contains a description of the functions of the Action 
Menu: 

 Undo : Undoes a variety of actions performed in the Visualizer. 

 

Add Node(s) : Function for adding Nodes directly into the 
Visualizer. These can be added to existing NodeClasses or within 
newly created NodeClasses. You also have the option of the 
number of nodes to create. 

 

Add Node (with links or attributes) : Allows you to add a Node 
directly into the Visualizer. In addition you can create links and 
assign weights to these new links. You can also select attributes 
and assign values to these attributes. 

 

Add Link : Allows you to create new links in a Meta-Network in 
the Visualizer. Then select the source and target nodes and then 
select the network. You have the option of creating a new network 
for this link. Lastly you can select the weight of the new link. 

Notes on Display of Multiple Edges : If your Meta-Network contains 
graphs with “multiple edges between two nodes” ORA will display the 
edges as curved lines so as to allow visualization of overlapping Edges. 
This is to say that if there is represented two nodes with four edges coming 
from four different graphs. 
 
Please note that Tool tips are currently handled by math looking at the 
edge as if it were a straight line. Since our line is not straight anymore, it 
will only be highlighted if the cursor’s in the middle – nowhere near the 
edge. But otherwise, you should still see tool tips. 

 Pin All Nodes : Set all nodes as unmovable 



 

 
200 

 

 
Unpin All Nodes : Release all nodes and allow them to be moved 
independently. 

Isolates 

 
Hide Isolated Nodes : Remove any node which has zero links 
connecting it to other nodes. 

 Periphery : Moves Isolates back to their original position. 

 
Combine into MetaNode : Collects all the Isolate nodes into a 
Meta-Node. 

 

Move into Column : Moves all isolates to the right side of the 
screen in a column. The isolated nodes can be moved back using 
the Periphery option. 

 

 
Hide Pendant Nodes : Remove any node which has only one 
edge connecting it to another node. 

 
Recursively Hide Pendants : This function will run the both the 
Hide Pendant routine until there are no more Pendants. 

 

Recursively Hide Pendants and Isolates : This function will run 
both the Hide Pendant and Hide Isolate routines until there are 
no more Pendants or Isolates. 

 
Show All Nodes: Any nodes that were previously hidden will be 
revealed. 

 

Show All Nodes Except Isolates : Reveal any nodes that were 
previously hidden with the exception of nodes that have no links 
connecting them to another node. 
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Compute Standard Measures for Visible Network : Compute 
Standard measures computes the following collection of measures 
on the visible network: Total Degree Centrality, Betweenness 
Centrality, Eigenvector Centrality, Cognitive Demand, Resource 
Exclusivity, Task Exclusivity, Knowledge Exclusivity. The measure 
values can then be viewed within the Entity Status Window. 

 

 
Hide Pendants 

Pendants share links with only one other node. Their linkage is tangential 
and therefore isolated from the core linkages you may be interested in 
examining. Pendant Nodes, like Isolated Nodes, can be hidden. 

From the drop down menu in the Visualizer select Tools > Hide Pendant 
Nodes.  

Below is a Before/After screen shot of the visualization before showing the 
removal of the pendant nodes. 

 

 
Add Node 



 

 
202 

 

IMPORANT NOTE : Changes done using Add Node(s) and Add Link(s) are 
transient. Be sure to use either the File > Save Meta-Network As… (to 
save the entire Meta-Network with additions) or File > Add Meta-Network 
to ORA (to create a new Meta-Network using only the currently visible 
nodes). Changes can not be saved back to the currently open Meta-Network. 

The Add Node(s) function allows addition of nodes to the current Visualizer. 
These added Nodes are not added to the currently open Meta-Network. If 
there is a need to save the Meta-Network with the added nodes then use the 
menu item File ⇒ Save Meta-Network to File… and create a new Meta-
Network. 

Below is the NodeSet for Stargate with the original 16 node NodeSet. 

 

From the main menu select, Actions ⇒ Add Node(s) which brings up the 
Add Node(s) dialog box. 
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1. Use an Existing nodeset :  

allows for a NodeSet selectable in option 2 or Use a new nodeset 
creates a new empty NodeSet. 

2. This dropdown gives the option for selecting a pre-existing NodeSet to 
place the new node. 

3. The Node ID: textbox is used for giving the new node an ID. 

4. The Number to Create: specifies the number of new nodes. 

NOTE : If the Number to Create is larger than 1 then the text placed in 
section 3 for Node ID will be used as a prefix for all new nodes crated. 

After inputting the information to add node A17, the Visualizer will now 
display the new node as A17 with no connections. In order to display this 
node with a title will require saving the Meta-Network and changing the 
information within the ORA Editor. 
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Adding Multiple Nodes 

The procedure for adding multiple nodes is similar to adding a single node. 
The exception is the text in the Node ID: textbox. When adding multiple 
nodes only use a prefix. ORA will attach numbers, starting at 1, for each 
node. 

Here's the addition of three new nodes and the prefix A will be used. Three 
nodes, A_1, A_2, and A_3 are created on screen. 

NOTE : You can only use a prefix ONCE. ORA will not accept any previously 
used prefixes a second time. 

 

To add additional nodes use a different prefix. 
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NOTE : Now either save the altered Meta-Network using the File > Save 
Meta-Network As… to a new filename or continue with Add Link(s). 
 

 
Add Link 

Allows you to create links between nodes in the Visualizer and place them in 
an existing NodeClass or create a new NodeClass. You can also set the 
weight for the new link. 
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NOTE : Changes done using Add Node(s) and Add Link(s) are transient. Be 
sure to use either the File > Save Meta-Network As… (to save the entire 
Meta-Network with additions) or File > Add Meta-Network to ORA (to 
create a new Meta-Network using only the currently visible nodes). Changes 
can not be saved back to the currently open Meta-Network. 

1. Start node : The start of a directed edge. 

2. End node : The end of a directed edge. 

3. Insert Nodes as they're clicked : Fills in the textboxes for Node. 
The first click adds the node in the Start node section. The second 
click adds the node to the End node section. Any further clicks will 
make the previous End node the start node and the newly clicked node 
becomes the new End node. 
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4. Use an Existing network : will place the links within the chosen 
network form the dropdown menu and Use a new network creates a 
new network from the name in option 5. 

5. New Network ID : is the name for the new network from option 4. 

6. Network : allows you to choice the Network to create the link in. 

7. Link Weight : The weight to assign the edge between the nodes. 

NOTE : Since this function creates directed links a second link would need 
created for reciprocal action. 

Example : If a connection was made starting with A to B, a second 
connection would need to be made starting with B to A. 

Adding a Missed Link 

If after the Meta-Network was constructed and it's noticed an link is missing 
(e.g. janet_frazier should have been connected to gen_hammond), the 
missing link can be added immediately without returning to the editor. 

 

From the Visualizer menu select Actions > Add Edge(s). 
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Be sure that the Insert Nodes as they're clicked has been check marked 
and that Use an existing network is selected with the correct network is 
visible in the dropdown. Then select the [Create Edge] button. 

 

The two nodes are now connected with a directed link. 
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NOTE : this created a directional link from janet_frazier to 
gen_hammond but not the other way. To make it go both ways, a second 
link from gen_hammond to janet_frazier would need to be created. 

 
Add Network From Scratch 

This function also allows the creation of Networks from Scratch. First, 
remove the checkmarks from all the NodeSets in the Legend to remove 
them from the screen. 

 

The DataSet 

Next prepare your data for inclusion. Here is a small, five node, NodeSet. 

A01 col_jack_o'neill 

A02 maj-samantha_carter 

A03 daniel_jackson 

A04 teal'c 

A05 gen_hammond 

From the main menu select Actions > Add Node(s). 

In the dialog box activate the Use a new nodeset radio button. 
Underneath, in the Type: dropdown menu, select the type of NodeSet. Then 
in the New NodeSet ID: textbox give it a name. Then select the [Create 
Node(s)] button. 
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The five nodes will appear in the Visualizer with the prefix and attached 
numbers. Now it's time to connect the nodes. 

 

From the Visualizer menu select Actions > Add Link(s). 



 

 
211 

 

 

After selecting [Create Link] a new link will be drawn in the Visualizer. 
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Now switch the NodeSet to use to Use an existing network, select the 
newly created NodeSet in the dropdown, and create the rest of the links. 

 

All of the links are now complete. 

 

Save the Meta-Network with either Save Meta-Network As… or Add 
Meta-Network to ORA and use the ORA editor to add in titles and 
attributes. 

 
Isolates 

Periphery 

Places isolates that were moved into column back to their original positions. 

Hide Isolate Nodes 

To further simply a visualization, it may prove useful to remove isolated 
nodes from the visualization.  

Isolated nodes are not directly linked or connected to other nodes, which 
share direct links with each other. In the screen shot below, the red ellipses 
highlights an isolated nodes which need removed. 
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Select from the Main Menu: Actions ⇒ Hide Isolated Nodes. 

In the screen shot below, after removing isolated nodes, the visualization is 
further simplified.  

 

Combine into MetaNode 

This option will combine all the Isolates into one MetaNode. This can be 
expanded right-clicking to bring up the contextual menu. 

Move into Column 

This function is used to move isolate nodes from the main viewing area to 
move easily view the connected nodes. These will be lined up on the left side 
of the screen. 

NOTE : The original dataset was changed in order to create the isolates. 

NOTE : If the names are unviewable and off the screen, change the position 
of the labels 

The isolates can be returned to the original position using the Periphery 
options. 
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:  

 
Color Nodes By Attribute 

When the agent-by-agent network is opened all the nodes default to the 
color red. ORA has default colors for all the various NodeSets. But ORA can 
also color the nodes based on their individual attributes. Here's the default 
agent-by-agent NodeSet in red. 
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From the Visualizer main menu select Actions … Color Nodes by 
Attribute or Measure. This brings up the Node Color Selector dialog box. 

 

Selecting the down arrow for Select an Attribute:. Highlight an attribute 
from the list. ORA gives default colors to the nodes. 

 

In some instances the color distinction isn't highly visible. And for 
presentation purposes a good contrast is necessary. 

To bring up the Color Selector click on the color you want to change. 
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Note: By hovering over the measure or attribute, you can bring up detailed 
tool tips. 

Select a new color from the swatches. Then select [OK] 

 

Your new color choice is now reflected in the dialog box. 

 

And the nodes with the attribute you selected are now a new, and brighter, 
color. 
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Resize Nodes By Attribute 

Resize by Attribute uses the numerical value of an attribute to size the 
nodes. Sizes will be scaled accordingly. Below is an attribute created for this 
example.  

The numbers range from 0 to 10 and denote approximate rank. 10 denoting 
general/leader down through the ranks to 5 for civilians and finally 0 for 
persons not involved. 



 

 
218 

 

 

From the main menu select Actions ⇒ Size Nodes by Attribute or 
Measure. Then select the attribute to use for the sizing. When finished, 
select [Close]. 
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NOTE : Sizing nodes by attributes only works with attributes of numerical content. 
Alpha content will have no affect on the size of the nodes. 

 

Each node will now be displayed according to the value in the chosen 
attribute. 
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NOTE : The numerals are not displayed in ORA and are shown only for display 
purposes. 

 

 
Resize Nodes By Measure 

ORA has the capability to visualize nodes by scaling them relative to each 
other in relation to common SNA Measures or Attributes as selected within 
the ORA Visualizer.  

The key benefit to sizing nodes by Measure or Attribute is the ability to 
conceptually capture which nodes in your network figure more prominently 
in terms of measures by simply gauging their size visually and intuitively. 

First, visualize one of your networks. Below is the Stargate agent x event 
network to find the agent with expertise regarding events in the scenario. 
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From the main menu select Actions ⇒ Size Nodes by Attribute or 
Measure. 

From the bottom textbox I selected Cognitive Expertise. Each of the nodes 
in turn grows to reflect it's value from that measure. 
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The display now changes to reflect each node's value by size. 

 

We'll compare two nodes: daniel_jackson and teal'c.  

daniel_jackson's cognitive expertise value is 0.2400 and is displayed with a 
large red circle while the value of teal'c is 0.1556 is displayed by a much 
smaller red circle. The values can be read in the Node Status dialog box. 

Cognitive Measure for daniel_jackson 

 

Cognitive Measure for teal'c 
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Compute Standard Measures 

This functions runs four standard measures: 

Cognitive Demand: Cognitive Demand measures the total amount of effort 
expended by each agent to do its tasks. Individuals who are high in 
cognitive demand value are emergent leaders. Removal of these individuals 
tends to be quite disruptive to networks. 

Centrality, Betweenness: Betweenness tells us which node is the most 
connected to other parts of a network. For example, Betweenness can tell us 
which person in a network is the most central to the network as a whole. 
Betweenness measures the number of times that connections must pass 
through a single individual to be connected. 

Centrality, Eigenvector : Eigenvector Centrality reflects one's connections to 
other well-connected people. A person connected to many isolated people in 
an organization will have a much lower score in this measure then those that 
are connected to people that have many connections themselves. This would 
be true even if such a WHO might have a high amount of actual connections 
(i.e. high degree centrality). 

Centrality, Total Degree: Degree Centrality tells us the relative number of direct 
connections a WHO might have in a network; the higher the score the more 
likely a WHO might be likely to receive and potentially pass on critical 
information that flows through the organization. 

These values can be viewed either by hovering over a node and revealing 
the tooltip or double clicking a node and bringing up the Node status dialog 
and selecting the Measures tab. 

 

 
Visualizer Tools 
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The ORA Visualizer provides a suite of tools to visually analyze your Meta-
Network. The Visualizer Tools can be located accessed from within 
Visualization mode on the main menu bar (image below):  

 

Drill Down : With the ORA Drill-Down Wizard you can quickly 
visualize ego networks by overall node class knowledge, tasks, 
resources, agents) or by choosing individual nodes from a 
checklist. The ORA Drill-Down Wizard is only accessible through 
the Visualizer: 

 

Node Status: The Node Status Window is selected by default. It 
first pops-up when you select any node in the Visualizer. This 
window provides you with a snapshot of the currently selected 
node by displaying that nodes unique Attributes, Measures, and 
Neighbors. 

 
Group Viewer : Allows viewing of current display to be viewed in 
various grouping: CONCOR, Newman, Johnson, FOG, and K-
FOG 

 Propagation Dialog :  

 
Key Set Selector : Helps put a set of arbitrary items on the 
screen. 

 
Legend : Allows for toggling visibility of nodes and links on the 
fly. 

 

MetaNodes : A Meta-Node contains multiple nodes collapsed into 
one. You can create Meta-Nodes based on the NodeClasses in your 
organization, or you can create Meta-Nodes based on the 
attributes of the nodes. To create Meta-Nodes, you must access 
the Meta-Node Manager. 

 
Path Finder : The Path Finder allows you to focus or drill down 
on a particular node, or multiple nodes, that you may be 
interested in analyzing in greater detail. 
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Sphere of Influence : Each node within a network has a unique 
Sphere of Influence or Ego Network, essentially it's direct 
relationship with it's neighbors as a function of specified path 
length. 

 

Block Maps : Block Maps display varying intensities of data by 
displaying "blocks" correlating to the value of data. For instance, a 
block map displaying node centrality values would reserve the 
largest block for the node highest in that value. Color is used to as 
well to visualize different values with the darkest color reserved 
for the highest value. Block Maps can also be referred to as heat 
maps.  

 

Node Locator : Brings up a window with the Meta-Network in a 
collapsible tree structure. Selecting any node within this tree will 
highlight the node, enlarge it, and bring it to the center of the 
display. 

 Micro Simulation :  

 
Networks Over Time : Allows you to view a version of your 
network across multiple time periods.  

 Vector Maps :  

 

 
Drill Down Wizard 

With the ORA Drill-Down Wizard you can quickly visualize ego networks by 
overall node class (knowledge, tasks, resources, agents) or by choosing 
individual nodes from a checklist. The ORA Drill-Down Wizard is only 
accessible through the Visualizer: 

From the ORA Visualizer Main Menu select Tools ⇒ Drill Down. 

The following window box will appear. 
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The top sections allows you to chose the nodes for use. The bottom tabs 
allow for choosing specific nodes within a set. 

Drill Down Wizard Example 

Using the Embassy Meta-Network, we will render the various node classes 
using the Drill-Down Wizard Tool. The screen shot below displays the 
Embassy Meta-Network as it should first appear in the Visualizer. 
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From the Main Menu select Tools ⇒ Drill Down. 

This will bring up the Drill Down dialog box as shown below). 
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Here, select the node class Knowledge by selecting the Knowledge check 
mark box. The screen shot below, displays the end result that you should 
now see in the Visualizer. 
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Next, with the Knowledge node box checked, add the node class Task. The 
screen shot below displays the end result. 
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Next use the search bar feature of the Drill-Down Wizard to narrow the 
search. 

Enter the word Bombing in the Visualizer search field below. Then select the 
check box on the bombing row. The screen should now reflect your new 
search parameters. Everything not associated with bombing has been 
turned off. 
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Drill Down Wizard Explained 

The ORA Drill Down Wizard can be broken down into three primary sections 
of input: 

1. Section 1: enables you choose individual node sets or combination of 
node sets to display in the Visualizer. 

2. Section 2: of the Drill Down Wizard enables you to search for a 
particular node within your Meta-Network. This can be handy when 
you dealing with large nodesets and the one you are interested in 
finding is not easily located. 

3. Section 3: enables you check mark an individual node within your 
Meta-Network by node class if so desired. 
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Node Status 

The Node Status Window is used to reveal pertinent information about 
one selected node. The window can be brought up by either selecting it from 
the main menu, Tools > Node status or by double-clicking the node in the 
Visualizer. The dialog box below will appear.  
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The top of the box will contain general information about the selected node. 
Underneath there are five tabs available which will display the node's 
information. You can switch nodes by selecting any other node in the 
Visualizer. ORA will automatically change the display. 

Neighbors : displays the nodes which are linked to the selected node. It 
also displays the weight of each link. 

Sources :  

URIs : If there are any URIs attached to the node they are display under 
this tab. 

Attributes : Types and Values of all attributes are displayed under this tab. 

Measures : If Measures were run on the Meta-Network their values are 
displayed under this tab. 
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Link Status 

The Link Status Window is used to reveal pertinent information about one 
selected link. Active the window my right-clicking the link and selecting Link 
Status or by double-clicking the link in the Visualizer. There are several tabs 
available which will display the node's information. 

 

The top section display information about the link. The weight and to which 
Network it belongs. It also shows the Source and Target Node and Nodeset. 

Attributes : The Link contains any attributes they will be listed under 
this tab. 

URIs : Any URIs this link refers to will be listed under this tab. 

Sources :  
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Group Viewer 

The Group Viewer helps separate nodes into distinct groups.  

We'll use one of the networks for each of the groups to further examine the 
breakdown. 

There are six groupings which can be called up: 

Clique :  

CONCOR :  

Johnson :  

Newman : Used to find clusters in a network. 

FOG :  

Alpha-FOG :  

ORA implements the Newman algorithm presented in the following paper: 

Finding community structure in very large networks, Aaron Clauset, M. E. J. 

Newman, and Cristopher Moore, Phys. Rev. E 70, 066111 (2004). The 
algorithm uses link weights.  It is not the Newman-Girvan algorithm based 
on betweenness  centrality. 

Please note, Newman developed this algorithm as it scales better than the 
Newman-Girvan for large networks. 

 
Group Viewer-Cliques 

Below is an image of the Group Viewer box and procedures for using this 
tool.  
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Parameters 

Minimum clique size :  

 
Group Viewer-CONCOR 

Below is an image of the Group Viewer window and procedures for using this 
tool.  

 



 

 
237 

 

Parameters 

Use out-links (matrix rows)? The links leading out of the chosen node 
into another node. 

Use in-links (matrix columns)? The links leading into the chosen node 
from another node. 

Example 

The example uses the network agent x task. Foe each of the three 
possibilities in, out, both the display is shown with the number of groups 
set to 4. The resulting displays show how the in and out links affect the 
groupings. 

Use both in-links and out-links 

 

Use in-links 
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Use out-links 
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Group Viewer-Johnson 

Below is an image of the Group Viewer Johnson window and procedures for 
applying the Johnson algorithm.  
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Parameters 

Relationship type:  

• Similarity 

• Dissimilarity 

Link method:  

• SingleLink 

• CompleteLink 

• AverageLink 

 
Group Viewer-Newman 

• Below is an image of the Group Viewer window and procedures for 
applying the Newman grouping algorithm: 
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•  
• The Newman grouping is used to find clusters in a network. I began 

increasing the number of groups to view until the larger cluster began 
to break up. 

•  
• In this case the nodes remained clustered (with only one or two nodes 

breaking off) until I reached 4 as the number of groups. Then the 
network broke up into two large and two small clusters. The nodes in 
each of the two large clusters have a commonality as to the 
organizations they belong to and the tasks they were assigned. 

 
Group Viewer - K-FOG 

• FOG (or Fuzzy Overlapping Groups) works in either square-mode 
(NodeSet-1 x NodeSet-1) of multi-mode (NodeSet-1 x NodeSet-2). 
The multi-mode is the more natural procedure. it's prime function is to 
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form nodes into groups (clusters or communities) and show which 
nodes share the secondary functions. 

• REMEMBER : Groups produce tasks - people participate in tasks. 
• Below are images of the Group Viewer K-Fog window for both 

SingleMode and MultiMode. 

•  
• Parameters 

• SingleMode and MultiMode 
• Select a Network: The same in both. The dropdown menu lists all the 

available networks in the selected Meta-Network. 
• Select a number of groups to see : Number of groups to divide the 

nodes into. Generally the analyst would have an idea of the number of 
groups that are necessary. 

• SingleMode 
• Select the number of trees per node : The number of sample 

events to generate. 
• Select the tree size : The number of people involved in each group 

• MultiMode 
• Select Node Class to Cluster : Selects, via the radio buttons, the 

node class to display using the other node class as it's base. 
• Links 
• The thickest link is usually the leader of the group. The question to ask 

is WHY is that particular person the strongest link. It is important to 
look at the composition of the group(s) involved. 
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• If the weights are Lopsided (many strong and/or weak links) the 
analyst needs to look at the association of the interstitial* actors whose 
information will assist in analyzing the groups. 

• If a node is connected to only one group and that group has few actors 
then it is considered somewhat insular. 

• SingleMode Example 
• Run on the agent x agent network with a number of threes per node 

set to "2", the tree size set to "2", and the number of groups to see 
set to "2". The header designation is "S=the set (1-5)" and "G=first or 
second group". 
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• MultiMode Example 
• The agent x task network is used and the Task Node Class is 

selected to Cluster. The number of groups to see was set to "4". The 
results of hitting [Compute] five times are shown below. Each of the 
results is different but there is an overall pattern. In four of them there 
is a distinctive single large cluster of nodes. 

•  

 
Group Viewer-ALPHA FOG 

Alpha-FOG is similar to K-FOG in it clusters nodes into groups. The 
difference between the two is Alpha-FOG is used when the analyst is not 
quite sure of the number of groups. 

The trade-off between K-FOG and Alpha-FOG is accuracy vs. insight. 

The ALPHA-FOG dialog box 
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Parameters 

The dropdown menu contains all the networks in the Meta-Network. After 
selecting a network OA will display the two NodeSets in the network below in 
a set of radio buttons. Select one to display. The other will be used as the 
tasks set. 

Alpha Value (0-1): 

The slider bar controls the APLHA-value. It defaults to 0.5. You can manually 
move the slider right or left then press [Compute]. 

Below the slider are three buttons, [Left], [Zoom Out], and [Right]. 

• Pressing the Left button will reset the three values. The left value will 
remain the same, the right values will be reduced by half, and the 
middle value will be the value unequally between the two. Each press 
of the Left button will repeat the sequence. Pressing the Right button 
will do the same, but in the opposite direction. 
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• The Zoom Out button reverse the above procedure in the exact order 
(i.e. if you pressed Left, Right Right, Left, and Left the Zoom 
Out button would undo then as Left, Left, Right, Right, Left). 

The buttons at the bottom control the display. The [Compute] button uses 
the current Alpha value and re-display the network. The [Reset button 
removes all groups and resets all the nodes to default. The [Close] button 
closes the dialog box. 

Below is the initial display using the default of 0.5. It doesn't really tell us 
much about the grouping of the network. There are some groupings but 
there are also four groups with one node only and many small "almost" 
groupings. Also all the links are the same weight which does not indicate the 
leader of any group. 

 

Setting the slider bar to 0.0 groups all the nodes into a single group. This 
contains the opposite problem as there is only one group. 



 

 
247 

 

 

Setting the slider bar to 1.0 divides the tasks into 18 groups, none of which 
are distinctive. There is definitely no groupings here. 

 

It's necessary to find the optimum setting. 

Starting from the default setting I clicked Left. The range was from 0.0 - 
0.5. got three groups which looked fairly good. But I decided to check out 
the other options. I clicked Left again and the range changed to 0.0 - 0.25. 
But it combined all the nodes into one group. Definitely was he correct 
grouping. I clicked Right and the range changed to 0.125 - 0.25. It split 
them into two groups. 
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KeySet Selector in Visualizer Tool 

Note : A slightly different version of this tool is available in the ORA Main 
Menu interface (i.e., non-Visualizer tool). 

You can use the Key Set Selector to simply complex visualizations. The Key 
Set Selector tool is accessible from the Visualization tool bar at the following 
path: 
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Key Set Selector Tabs 

Visibility : Contains options for manipulating the display of nodes 
depending on whether or not nodes are selected. You can also add or 
remove selected items 

Node Locations : All selected nodes can be moved to a column to the right 
or left side of the screen. 

Node Appearance : Selected nodes can have their labels shown/hidden and 
the node color changed. 
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Other : Create Meta-Node combines all selected nodes into a Meta-Node. 
Highlight Checked Items 

Create Meta-Node - All selected items are combined into a Meta-Node on 
the screen. 

Keyset Selector Examples 

Following is a short example of the KeySet Selector. It covers the main 
aspects of the tool only. 

 

In the Filter Commands textbox the word poison is typed which causes all 
nodes with poison in any attribute to be revealed. Pressing the [Select All] 
button places a check mark in all the nodes. Lastly in the Visualizer 
Commands pressing the [Show Only Checked Items] button hides all 
but the checked items. 
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The [Clear All] button is pressed to clear all the check marks. poison is 
replaced in the Filter Commands with the word sg-1. Be aware that even 
though only nodes with sg-1 are to be added the two nodes with sg-17 also 
appear as sg-1 is a sub-string of sg-17. SO instead of using the [Select All] 
button check marks are manually placed in the check boxes desired. 

 

The [Add Checked Items] button is pressed and the four new nodes are 
added to the Visualizer. 
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With the four nodes of sg-1 still check marked press the [Highlight 
Checked Items]. The four nodes are now displayed in a larger format. 

 

The last button, [Create Meta-Node] will cull nodes into a Meta-Node. 

Move Left/Right 

If a set of nodes needs "pulled out" of the display the Move Left/Move 
Right buttons can help. Below is a normal display. The nodes for SG-1 are 
quite difficult to see. 
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From the Keyset Selector dialog select the nodes to be highlighted and place 
a check mark in the box. 

 

Press the [Move to the Right] button. This brings the selected items 
toward that side of the display. 
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Pressing the button again will move the selected nodes farther in that 
direction. 

 

 
Legend 

The Legend dialog box allows you to quickly hide and reveal nodes and links 
in the Visualizer.  

Use the checkboxes to change a NodeSets visibility. When you first call up 
the Visualizer all the boxes will contain checkboxes... 
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...and in the Visualizer all nodes and links are revealed. A little hard to make 
heads or tails of something like that. 

 

By using the Legend checkboxes you can selectively show/hide nodes and 
links. Deselect the checkbox to the left of Agent. Instantly all of the Agent 
nodes are hidden along with any connections they had with the rest of the 
nodes. The node structure is a little easier to see now. 
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Next think about a particular set of connections you'd like to see, say a task 
x task network and how the agents relate to the tasks. 

 

From the Legend box menu select Control => Hide All nodes Then again 
from the menu Control => Refresh Legend. Now place checkmarks in the 
checkboxes for agent, task, and task x task. All the tasks will be linked 
together as per your network and all the agents will have connections to the 
tasks they are associated with. 
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Another example is how knowledge relates to specific tasks. From the 
Legend menu select Control => Hide All Nodes. Now place checkmarks 
next to knowledge, task, and the Knowledge x task network. 
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Now the Visualizer reveals which knowledge is required for which specific 
tasks. 

 

The legend also reflects the size, shape, and color of the nodes in the 
Visualizer. 
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Legend Edit Menu 

Below is an image of the Legend Edit Menu and a description of this tool: 

 

Copy Legend Image to Clipboard : Copys an image of the entire legend 
that can be pasted into an image-editing program. 

 
Legend Control Menu 

Below is an image of the Legend Control window: 

 

Show All Nodes : Will bring into view all entities in the MetaMatrix. Good to 
use if you need to make a fresh start. 

Hide All Nodes: Hides every entity. Good starting point when you only wish 
to display a small subset of entities. 

Refresh Legend : After using the menu items above and/or using the 
checkboxes this item will bring the Visualizer up to date. 

 
Node Color 

The color of a NodeClass can be changed in the Visualizer. In the Legend 
window click on the colored node of a NodeClass. This will bring up a color 
selector box. Select a new color and click [OK]. All the nodes of that 
NodeClass will change colors. 
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NOTE : This color change is in effect for as long as the Visualizer is open. If 
you close and re-open the Visualizer the colors will revert to their default 
colors. 

Here is a section with the default colors of red for agents and cyan for 
tasks. 

 

Open the Legend window (if it's not open already) and click once on the 
NodeSet you want to change. This will bring up the Color Change dialog 
window. 
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Select [OK] and the new color will be displayed for the chosen NodeSet. 

 

The newly selected color appears in both the Visualizer and Legend windows. 
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Creating a Meta-Node 

 A Meta-Node contains multiple nodes collapsed into one. You can create 
Meta-nodes based on the nodesets in your organization, or you can create 
MetaNodes based on the attributes of the nodes. From the drop down menu 
select Tools > Meta-Nodes or select the Meta-Node Manager button on 
the toolbar. This brings up the Meta-Node dialog box. 

 

1. Expand all meta-nodes expands all meta-nodes to their respective 
single nodes. 

2. Select how to create links between Meta-Nodes: 
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o Absolute count of the links : Counts each link from any node 
in the Meta-Node to any other node as 1.0. 

o Proportion of the maximum possible links :  

o Block model links and weights :  

3. Meta-Node Creation is controlled by three buttons: 

o By Node Class : Creates Meta-Nodes based on current 
NodeSets. 

o By Most Recent Grouping : Creates Meta-Nodes based on the 
most recent use of the Group Viewer. 

o By Attribute… : Creates Meta-Nodes on one individual 
attribute. 

 

 
Meta-Node Node Class 

Node creation is done via three buttons in the Meta-Node Creation section. 
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This button will create Meta-Nodes for each NodeSet. 

 

 

 
Meta-Node Attribute 

This button creates Meta-Nodes using a single attribute. It's used in 
conjunction with the Funnel Nodes checkbox. Below is an image of the 
Select an attribute box:  

 

Choosing group without the Funnel Nodes checked creates a confusing 
display. 
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Next place a checkmark in the Funnel nodes box and select groups for a 
cleaner display. 

 

 

Leaving the Funnel nodes option unchecked works best with fewer 
NodeSets. Below only the agent and tasks NodeSets were used. Without 
funneling the individual tasks can be viewed as to which agent Meta-Node 
they connect to. It also reveals that groups in area 1 are not connected to 
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any tasks and that groups in area 2 are all the agent nodes that had no 
groups affiliation. 

 

 
Path Finder 

The Path Finder is used to find, not only, the shortest path between two 
nodes but also paths to other nodes when particular situations occur. Below 
is an image of the Path Finder tool and a description of its various elements.  
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The interface contains four sections: 

Start node : Select the NodeSet/Node to begin the path. 

End node : Select the NodeSet/Node to end the path. 

Options : Options regarding link parameters and which NodeSets to use. 

Advanced Options : Options regarding whether, and how, to use one 
particular node within the set. 

Using only Agent nodes (tolerance = 0) 

Using only the Agent NodeSet the pathway requires three intervening nodes. 
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NOTE : For this example the values in the Network have been altered from the 
regular values. 

Tolerance of "1", nothing else checked. 

Shortest path: 1 

 

There is the direct link from gen_hammond to col_jack_o'neill and the 
secondary pathway with teal'c in the middle. 

Use link direction 

Shortest path: 2 

The path direction must lead from the source to the target. 

 

The link from gen_hammond to col-jack-o'neill is removed as it's a 
directional link in the wrong direction. The shortest link is "2". 

Use link weight (Remove links with negative values) 
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Shortest path: 6 

Use link weights finds the shortest path from A to B using minimal weights as 
opposed to minimal number of links. Also the shortest path is the total of the link 
weights — not the number of links total. 

 

The shortest path is from col_jack_o'neill to teal'c (5) then from teal'c to 
gen_hammond (1) for a total of "6". 

Use link weight (Convert negative links to positive values) 

Shortest path: 3 

Uses the absolute values of numbers. A negative number becomes a 
positive number. 

 

Use link direction and link weight with absolute values 

Shortest path: 3 
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Sphere of Influence 

Each node within a network has a unique Sphere of Influence or Ego 
Network. Essentially it's a direct relationship with it's neighbors as a 
function of specified path length. The ORA Visualizer allows you to focus on 
this relationship by creating an Ego Map centered on any particular node 
you choose. 

From the Visualizer's Main Menu select Tools ⇒ Sphere of Influence. 

The following dialog box will then appear. From here you can select the Size 
of your sphere's influence, the NodeSets, and Key Sets to use. 
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Select a sphere of influence radius 

The drop down box allows you to choose the path length for a particular 
node(s). The value starts out at 0. Below is an example of a radius of 0, 1, 
2, and 3. In many other cases the links will branch out as you increase the 
radius. 
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Auto-Zoom : Maximizes your ego network within the Visualizer. 

Auto-Center : Keeps the visualized Ego Network centered within the 
Visualizer display. 

Hide connections between levels : Removes any connections between 
nodes that do not have a connection to any node in the filter. 

 

Expand only these nodes : Allows you to select the components you wish 
to have displayed in a node's Sphere of Influence. 

Filter Commands : Used for selecting the filters to use on the current 
visualization. 

Node selection table : Allows the selection of individual nodes for 
visualization. First selected is symbiote_poison in the bottom table. Then 
the NodeSets events and locations were added. Only the nodes that are 
linked to the original symbiote_poison are displayed in the Visualizer. 

A Sphere of Influence Example 

This example will show how to take one node and expand upon it to show 
how it is related to nodes in other nodesets. First, from the table at the 
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bottom, select a node. Here we select the symbiote_poison. From the 
Expands only these nodes: place a checkmark in location. It reveals that 
symbiote_poison is connected to two locations, Ravenna and 
hasaraSystem_spaceStation. 

 

Next we'll place a checkmark next to tasks:. This reveals that there are two 
tasks that relate directly to symbiote_poison, poison_jaffa_at_gate and 
poison_summit. 

 

Now that we've got a couple of nodes on the screen let's increase the radius 
of the sphere to 2. The tree will now display all nodes within 2 links of 
symbiote_poison. 
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Lastly you can eliminate any nodesets by removing them from the list. 
Remove the checkmark from tasks: to reveal only the locations up to two 
links away. 

 

The Sphere of Influence allows you to hone your search and show only the 
nodes you need to see. 
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View Networks Over Time 

The Networks Over Time loads multiple Meta-Networks into the Visualizer 
and displays them as Time Slices. What follows are the procedures to do 
this: 

Step 1) 

First, highlight the Meta-Networks to load into the Visualizer. For this 
example I divided the whole Stargate Summit network into four distinct 
phases. 1) The meetings; 2) What was supposed to happen; 3) What did 
happen; 4) The attack on the Tok'ra homeworld. These are Summit 1-4. 

 

Step 2) 

Once you select "Load Into Visualizer", go the ORA Visualizer.  

From the ORA Visualizer Main Men Bar select the Networks Over Time 
Option. 
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The dialog box appears for you to verify you've chosen the correct Meta-
Networks. Place a checkbox in the ones you want or Check All. Then select 
[View]. 

 

To control the Over Time function from the main menu, select Tools ⇒ 
Networks Over Time. 
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The Phase Duration has two controls. Transition Phase duration sets 
the amount of time in milliseconds for the fading out of the previous set and 
the fading in of the new set. The Display Phase duration sets the amount 
of time in milliseconds that a set will be displayed before moving to the next 
set. 

Constant maintains a node's position throughout all Timeslices. 
Determined by Timeslice allows you to move a node independently in 
each Timeslice. 

Record Node Locations upon Exiting a Meta-Network maintains a 
node's position when changing Timeslices. NOTE: It does not maintain the 
node's positions after you exit the Visualizer. Upon returning to the 
Visualizer all nodes will be in default positions. 

The Slider bar controls which Timeslice is displayed. The buttons at the 
bottom, [Play] and [Stop] control the motion display. 

Summit-1 

The initial meetings between the SGC and the Tok'ra 
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Note: You can select multiple nodes by simply clicking on them. You do not 
need to depress any other keys (i.e., ctrl+shift, etc.).  

Summit-2 

The plan as it was supposed to go 
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Summit-3 

What really happened when Osiris showed up unexpectedly. Instead of 
poisoning the Summit daniel_jackson decides to forgo that action after 
hearing the information from Osiris. He's almost found out but still escapes. 

 

Summit-3 
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What was happening back on Revanna while daniel_jackson was at the 
Summit. 

 

NOTE : Measures and reports run on these multi-Meta-Networks are for all 
connections, not the individual Meta-Networks. 

Time Clustering 

Time clustering is available via the Over Time dialog in the Visualizer. It’s a 
fairly simple panel – there’s a ComboBox to select which period you want to 
cluster by (by Day, by Week, by Month, by Year), and two radio buttons to 
select what a week begins with (only used when clustering by week). Finally, 
there’s a simple button to cluster. 
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Clusters are fairly straightforward. It looks at the start date (earliest date 
available in a set of timeslices) and the end, and grabs snapshots at the 
given interval, looking at the beginning of that interval. So, if you cluster by 
month, it’ll move through each month, grabbing a snapshot of the 1st day. If 
no Timeslices exist for that day, it just uses the Timeslice with a date closest 
to that day without going over. 

 
Node Shaper 

The Node Shaper allows you to change the size of individual node(s) or 
assigning pictures. Below is an image of the Node Shaper widow and a 
description of how to change the shape of the nodes in your model.  
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1. Select a Style : Select from three Node Style Sizes or use an image in 
it place of the node. 

2. Select a Shape : An optional shape can be used instead of the 
NodeSet's default shape. The node will retain it's default NodeSet 
color. 
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3. Select Node to Re-Shape : The bottom section contains the controls 
for selecting which nodes to work with. Typing anything in the Find 
textbox will automatically filter out non-matching nodes. 

4. NodeSet tabs : Select which NodeSets to view. ALL shows every 
node or the tabs will show only their individual NodeSets. 

5. Checkboxes : Place a checkmark in the box next to the nodes you 
want to change. 

6. Filters : Use for filtering based on individual attributes. You can filter 
on more than one attribute at time. An example can be found in Create 
a new Meta-Network 

7. Select/Clear All buttons : Will either Select or Clear all 
VISIBILE nodes. If a check marked node has been filtered out and is 
currently NOT visible when the Clear All button is pressed, then that 
node will retain it's checkmark and be affected by future changes. 

8. Apply/Load Changes : After any changes have been made to the top 
portions selecting the [Apply Changes] buttons will cause them to be 
displayed in the Visualizer. 

9. Close :  

 

 
How The Node Shaper Changes The NodeSet 

What follows are examples of how the Node Shaper changes the NodeSet. 

Whenever the Node Shaper is called and a node is assigned something 
other than it's default shape new attributes will be added to Every NodeSet, 
not just the NodeSet you're working with. 

• Drawing Type : This will define what type of node is to be drawn, 
shape of image. There are three options for size (small, medium, and 
large) and one option for image. 

• Nodes Shape : There are four large shapes (circle, rectangle, ellipse, 
and hexagon), eight medium shapes (circle, hexagon, downtriangle, 
pentagon, diamond, square, uptriangle, and octagon), and one small 
shape. 
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• Image : Contains the name of the file associated with that node. 

Changing one node will create these three attributes and place the 
default value in every node in every NodeSet. Any of these attributes can be 
manually changed from within the Main Interface Editor. 

This is useful if you have changed many nodes and want to restore them all 
to their defaults quickly and easily. The quickest way is using the Copy and 
Paste method. 

 

Column "1" contains the modified values. In column "2" three values of 
medium are highlighted and copied using Ctrl-C. In column "3" the cursor is 
moved to the top cell and Ctrl-V is used to paste those three values in. In 
column "4" this is repeated until all values are back to their defaults. 

If the Image attribute contained a filename then changing Drawing Type 
to image will relink that file to the picture. Any of the four Drawing Type 
values can be placed in this column. 

 
Node Shaper Examples 
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Original agent x agent Network 

Below is the agent x agent network in the normal medium sized nodes.  

We will proceed to change the shape of the nodes to varying sizes as well as 
add image and picture icons to the nodes.  

 

Multiple Sized Nodes 

By using the Find textbox and the Filters I placed checkmarks in all 
members of the SGC. Then the Large Node Style was selected the [Apply 
Changes] button was pressed. 
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Picture Replacement 

Here three different symbols were used to denote 1) the SG-1 team (the 
blue circles), 2) the SG-17 team (the green circles), and 3) the SGC who are 
not members of either team. This was accomplished by filtering which group 
was to be displayed. Then checkmarks were placed and Image Node Style 
was selected. Then for each group an individual picture was applied to all the 
selected nodes together. 
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Lastly is the ability to assign a picture of the actual person the node 
represents (or location, object, etc.). 
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NOTE : It's suggested that any picture to be used should be reduced to a maximum of 
40 x 40 pixels before importing as this is the size ORA will reduce it automatically. 

 

 
Visualizer Layout Menu 

 
Run Active Layout : Turns on the motion and allows ORA to 
attempt to sort out the positioning of the nodes. 

 
Stop Active Layout : Turns off the motion and stops all nodes 
from moving. This allows you to move individual nodes around 
without disturbing the rest of the Meta-Network. 

 

Spring Embedded Layout : This layout operates fine in datasets 
of approximately under 500 nodes. Much higher than that and the 
layout gets sluggish. A single layout iteration could take two 
minutes or longer. Not really practical. 
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Spring Embedded (with enhancements for large data) : The 
enhanced layout with large datasets. It uses the same basic 
algorithm but has some optimizations built in. With 10k nodes or 
so, a single layout iteration takes 10 seconds or so. 

NOTE : Now you're probably asking "if this new algorithm is so good, 
why not keep it on all the time?" Reason: If you pick up and drag a 
node, and as such drag an entire meta-network, the display will look jittery 
and confusing. So, whenever you load in under 500-nodes, the normal 
version is enabled. More than that, it uses the enhanced version. 

 Run MDS Layout :  

 Run Tree Layout :  

 

Run Circle Layout (Pendants to Outside): Takes all pendants 
and puts them in a circle. All Nodes connected to a pendant are 
on a circle inside the pendant circle. Repeat until all nodes are in 
some circle, with the inner most nodes being the farthest from 
any pendant. 

 

Run Circle Layout (Center is High Betweenness) : Calculate 
the Centrality-Betweenness for the graph. Take the node(s) with 
the highest value. Place them in the center. All nodes connected 
to those nodes get put on a circle surrounding the center. Repeat 
as necessary. 

 

Run Hierarchical Layout : Tries to layout the network in a 
pyramid formation so that all arrows either point up or point 
down. 

 

Run Box Layout : More of a Polygon Layout, really. You select 1-
4 groups of nodes (either by node type or by node class). Each 
group is then laid out as one edge of a polygon. 1 Group = circle, 
2 Groups = 2 parallel lines. 3 Groups = Triangle, 4 Groups = 
square 
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Attribute/Measure Layout : Uses the input attribute and/or 
measure as the x,y coordinates of the nodes. 

 
Hierarchical Layout 

 

 Run Hierarchical Layout :  

When selecting the Hierarchical 
lay out option, you will be 
prompted for a square network 
(including the Visible meta-
network, since technically its 
square), and then for a node to 
use as the peak node. Finally, 
you must choose the desired 
build direction. This refers to 
Link direction, since a link could 
mean reports to just as easily 
as it could mean commands. 

Arrows always try to maintain 
their direction meaning, in the 
event of cycles, for example, we 
try to minimize the number of 
arrows that go "against the 
current", so to speak. It will 
also will warn you should you 
try to input a symmetrical 
network, as those don't really 
have bosses or subordinates. 

Hierarchy Layout has two 
buttons, for automatic layout, 
without having to enter in any 
data on top nodes. The buttons 
are to be used depending on 
what the link between two 
nodes really constitutes. If it's 
more of a Link points to boss 
node, building from bottom to 
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top works best. It links signify 
who gives commands, top to 
bottom. 

 

 

 
Display 

Link Appearance 

 
Link Labels > Show Link Labels : Toggles on/off the display of 
the labels of the links. 

 
Link Labels > Show Weight Value Labels : Toggles on/off the 
display of the weight of the links 

 
Link Labels > Show Weight Sign Labels : Sets the label and 
shows whether their weight is positive or negative. 

 
Link Color > Default : Removes all custom link coloring and 
resets all links to default. 

 

Link Color > By Link Weight : You can set a range of colors to 
represent the weight of links. A dialog box allows you to chose the 
colors for the minimum and maximum weights. 

 
Link Color > Match Source Node : Colors the link the same as 
the source. 

 
Link Color > Match Target Node : Colors the link to match the 
target. 
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Show Multiple Links Between Nodes : For any two (or more) 
links that link the same two nodes (usually because two 
nodeclasses have two or more graphs linking them), this causes to 
not be rendered as a straight line, but rather allow for each link to 
be curved, making every single link visible. 

 
Retain Bidirectional Links : When two nodes have links to each 
other only one link will be displayed. 

 

Split Bidirectional Links : When two nodes have links to each 
other only both links will be displayed. These links will be rendered 
as curved links between the nodes. 

 Show Links : Toggles on/off the display of links between nodes. 

 
Scale Link Width to Number of Links Between Nodes : 
Adjusts the width of the link to represent the weight of the link. 

 
Show Arrows : Toggles on/off the display of the arrows of the 
links. 

 

Show Self Links (Loops) : Shows whether there is a connection 
between a node and itself. It is designated with a circle pointing 
back to itself. 

 

Node Appearance 

 
Label Style > Default : Sets the label to appear to the right of 
the node. This is the default position for labels. 
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Label Style > On Right of Node : Sets the label to appear to the 
right of the node. 

 
Label Style > On Left of Node : Sets the label to appear to the 
left of the node. 

 
Label Style > On Top of Node : Sets the label to appear on top 
of the node. 

 
Label Style > On Bottom of Node : Sets the label to appear 
beneath the node. 

 
Label Style > Centered on Node : Sets the label to appear 
directly centered on the node. 

 
Node Style > Toggle Node Size : Rotates between the three 
sizes and styles for the display of the nodes. 

 
Node Style > Spot : Sets the size of all nodes to a small colored 
circle. 

 
Node Style > Small Shapes : Sets all nodes to a colored shape 
(circle, square, triangle, pentagon, diamond, hexagon). 

 
Node Style > Large Shapes : Sets shape of nodes to a colored 
shape only large enough to contain the label. 

Comments 

 Show Comments : Toggles on/off the display of comments 

 Set Comments Font : Sets the font used in Visualizer comments. 
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Set Comments Color : Sets the color used in Visualizer 
comments. 

Title 

 
Title Location > Top : Sets the Title to the top of the Visualizer 
window. 

 
Title Location > Bottom : Sets the Title to the Bottom of the 
Visualizer window. 

 
Title Location > Left : Sets the Title to the left of the Visualizer 
window. 

 
Title Location > Right : Sets the Title to the right of the 
Visualizer window. 

 
Title Location > Center : Sets the Title to the center of the 
Visualizer window. 

 

Set Title : Create a title for a screen shot. The title will remain a 
static size and retain its position regardless of the zoom of 
movement of the display. 

 Set Title Font : Set the font used in the title of the screen shot 

 Show Title : Toggle visibility of the title. 

 Log Scale Nodes :  

 

Show MouseOvers : Toggles the information boxes on and off 
whenever you hover the mouse over a node or link in the 
Visualizer. 
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Autozoom : Zooms the display either In or Out to bring all nodes 
into view. 

 
Background Color > Black : Sets the Visualizer background to 
black. 

 
Background Color > White : Sets the Visualizer background to 
white. 

 
Background Color > Custom : Brings up the color picker which 
allows you to chose any color for the background. 

NOTE : Some of the possible background colors can make it difficult to view 
the Visualizer. Your best choice is black (although white is used in the 
examples for easier printing). 

 
Background Image > Load : Allows you to chose a .jpg, .gif, or 
.png to use as a background. 

NOTE : Some pictures may make viewing the network somewhat difficult. 

 
Background Image > Clear Image : Removes the image and 
returns the background to the last background color used. 

 Black and White Only : Removes all colors form the Visualizer. 

 

Grayscale : Removes the hue from all nodes and links displaying 
them as shades of gray. If any of the nodes are difficult to read try 
changing the background color to a darker or lighter color. A black 
background works very well for grayscale images. 

 
Reset Node/Link Options : Resets all node and link colors back 
to default. 
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Link Color 

In ORA you can color links according to several preferences. Below are the 
procedures for doing so.  
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NOTE : For this example all the nodes are colored black so as to decrease the color 
confusion. 

NOTE : For this example the link weights have been drastically altered from the 
original values to assist in display purposes. 

NOTE : Below is a warning for the placement of the Min and Max sliders. When the 
sliders are set to the absolute left and right positions this causes all the colors to be 
set to red. Move the sliders in to prevent this. 

 

Even Distribution - The Full spectrum 
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The colors used are evenly distributed across the chosen spectrum. Using a 
NodeSet with weights of 2, 4, 6, 8, & 10 would have three colors chosen at 
evenly spaced intervals across the spectrum. 

Even Distribution - The Limited spectrum 
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Limiting the spectrum to smaller set will cause some of the numbers to 
contain very similar colors. This might make it difficult to tell the various 
shades of blue apart. Use this only when there are a very limited number of 
values. 

Scale to Weight 
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When scaling to weight the 100 values cause a spread to occur that makes 
all other values in the same general color area. 

Link Values 

 



 

 
301 

 

When a link is bi-directional and the weights of the links are not the same 
the Visualizer will color the link that was drawn last. 

Change link Color 

After setting the type Even Distribution/Scale by Weight the color of the 
links can be set manually through the color changer. Click on the color box 
of any of the links to bring up the color change dialog box. Select a new 
color and select [OK]. 

 
Comments 

While in the Visualizer Comments can be added to the display. Right-click a 
node and from the contextual menu select Add Comment. The comment is 
placed in a colored box with a dashed arrow connecting them to the original 
node. 

NOTE : These comments are not saved when exiting the Visualizer. 

NOTE : The main use of these comments would be in creating screenshots for display 
in order to add commentary for a report. 

Below is a section of the Stargate scenario with the unexpected appearance 
of Osiris. 

 

Adding a Comment 

A comment is added stating Osiris's arrival changes the plan. 
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From the main menu, under the Tools item, the font size and color, as well 
as the color for the box, can be changed. 

 

Adding Multiple Comments 

It is also possible to add multiple comments to the same node. 
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REMEMBER: These comments are not saved when exiting the Visualizer. 

Deleting a Comment 

A comment can be deleted by first selecting that comment. A right-click 
brings up the contextual menu. From this menu select Delete Selected 
Node(s). 

 
MouseOvers 

NOTE : To access the contextual menu the option must be checked. 

Go to Display >  Show Mouse Overs and make sure the option is check 
marked. 

When the pointer is passed over any Node in the Visualizer a yellow tooltip 
box will appear showing information on links to other nodes as well as 
values for measures than have been run. Below is a screen shot comparing 
two MouseOvers. 
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If an Attribute is empty ORA will leave a blank line for that attribute. Only if 
the attribute has a value will it be displayed. Neighbors are all the links to 
other nodes. 

 
Node Images 

Nodes can be replaced with various symbols or pictures to make it easy to 
identify individual nodes. There are a few items to note. 

All images should be reduced to approximately 50 x 50 pixels before 
using in ORA. Bigger images will be reduced in size on the display and 
the image quality may possibly be degraded. 

If a picture is placed on a background with the color R=255, B=0, G-
192 the background will be changed to the color of the node. 

Setting a Image Folder 

The Set Picture option is designed with modularity in mind, with adding new 
images as easy as putting a folder with images in the 
include\OraFiles\images\Visualizer\node folder. The dialog will 
automatically read that folder for subfolders, use the subfolder names as 
categories, and the images inside the subfolders as the images for each 
category. 
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Set Picture 

Right-click any node and select from the contextual menu Appearance 
Submenu > Set Picture. The Node Selector dialog box will appear. The 
drop down menu contains various types of node images. With a node 
selected a custom image can be applied. Nodes with Images will scale.  

 

Custom 

The Custom option allows for the inclusion of a user's own icons. 

The custom category is used for images that have been previously loaded in 
the current meta-network. Clicking OK applies the currently selected node's 
image to all nodes selected in the Visualizer.  

Additional information can be found in the Node Shaper section. 

The [New Image] button brings up a navigation box from which to 
navigate any directory and select an image file. The picture types can be 
jpg/jpeg, gif, or png. These will all be collected into the Custom section. 

NOTE : Remember to reduce the picture size BEFORE importing it into ORA. 

To set a new image right-click the node and select Set Picture. This brings 
up the picture dialog box. Locate the appropriate picture and select it. A 
black border will appear around the image. Select [OK] will set the picture 
to the node. 
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Visualizer Contextual Menus 

The Contextual Menu is displayed by right-clicking an a Node or Link. It 
contains many standard uses in manipulating nodes and links. 

Node Menu 

Pin SubMenu : 

Pin All Nodes : Globally pins all nodes. Nodes are unaffected by the [Play] 
button or the movement of other nodes. 

Unpin all Nodes : Frees all nodes from being pinned. 

Pin Selected Node(s) : All selected nodes will become pinned 

Unpin Selected Node(s) : All selected nodes will become unpinned. 

URL SubMenu :  

Attach URI : You can attach a URI to the selected node. 

Go To URI : Activates your browser and goes to the URI associated with 
this node. 
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Appearance Submenu :  

Picture : You can replace the node shape with a picture. 

Node Size : You can numerically set the Node Size of an individual node. 

Font Size : You can numerically set the Font Size for an individual node. 

Enlarge : Increases the size of the selected node in the Visualizer 

Shrink : Decreases the size of the selected node in the Visualizer 

Brighten : Lightens the shade of the color of the selected node 

Darken : Darkens the shade of the color of the selected node. 

Hide Labels : Hides the label of the selected node 

Show Labels : Reveals the label of the selected node 

Visibility Submenu :  

Hide Node(s) : Removes the selected node (along with all links) from view 
in the Visualizer. 

NOTE : This does not delete the node from the Meta-Network. 

Hide Adjacent Node(s) : Hides all nodes that are linked to the selected 
node. The selected node remains visible. 

Other :  

Color Adjacent Edges : Allows you to chose the color for all links 
associated with the selected node. Only works on one node at a time. 

Select Node : Registers the node as selected when ORA affects multiple 
nodes. 

Center Node : Brings the selected node to the center of the Visualizer. 

Pin Node : Pins node to background so it is unaffected by the movement of 
other nodes. 

Expand Node : Shows all nodes and links connected to the selected node. 
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Combine into MetaNode : Multiple nodes can be selected and combined 
into a Meta-Node which will contain links to all the nodes that the individual 
nodes had. The four large circles of SG-1 are selected. The and green circles 
show which tasks are associated with these agents. Press, and hold, the 
Control key while selecting each node for the Meta-Node. Then without 
releasing the Control key, right-click one of the nodes to bring up the 
contextual menu. Select Combine into Meta-Node. 

 

After combining the task nodes that were linked to the individual nodes are 
now linked to the sg-1 Meta-Node. 

 

NOTE : If additions or deletions of NodeSets needs done expand the Meta-
Node before proceeding. 

Add Comment : Attaches a comment to the currently selected node. 
Good for making notes for display purposes. Comments can be toggled to be 
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shown or hidden form the Display menu. The color and font of the comments 
are also controlled from the Display menu. 

Delete Selected Node(s) : Allows for the deletion of nodes form a Meta-
Network from within the Visualizer. 

NOTE : This deletion is permanent once the Meta-Network is saved. If there 
is any question regarding the deletion then remove the Meta-Network from 
ORA before saving and reload the Meta-Network. 

Link Menu 

Link Status : Brings up the Link Status box with information on its weight, 
the network, source and target nodes, source and target nodeset. 

Hide Link : Hides the link. This does not delete the link. 

Set Value : Set a new value for a link. 

Reverse Direction : Reverses the Source and Target aspects of the link. 

Delete Link : Removed the link from the Network. 

 
Removing Nodes In The Visualizer 

You can remove nodes directly from the ORA Visualizer by right clicking on a 
node and selecting Hide Node. Below is an example of removing an node 
using the Hide Node tool.  

Find the node you want to hide. Here we will hide ren'al.  
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Place the cursor over the node and right-click on the node to bring up the 
contextual menu. Highlight Hide node. gen_hammond and the four task 
nodes are now separated from the rest of the network. 

 

 
Comments 

Add Comment : Attaches a comment to the currently selected node. 
Good for making notes for display purposes. 
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Mouse Menus 

Right clicking any node in the Visualizer brings up a menu of the most 
useful tasks concerning nodes.  

The Pin Node Submenu : Allows you access various function involving 
pinning and unpinning nodes in the Visualizer 

The URI Submenu : Allows you to attach a URI to a node or go to a URI 
already attached to a node. 

The Appearance submenu : allows you to control the size of the individual 
node and font, brighten or darken it's color, or show or hide an individual 
label. You can even assign an individual picture to a node which is helpful 
when you are familiar with the agents, locations, or items. 

MetaNodes : After selecting two or more nodes you can combine them into 
a single MetaNode and give that MetaNode a name. If necessary you can 
also Expand that MetaNode into its individual nodes. 

Comments : You can add or delete comments for any node in the Meta-
Network. 
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Visualizer Patterns 

This is a list of common patterns that can make it easier to find various 
clusters as the underlying structure of your network.  

No Links 

 

2-Group 
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Bowtie 

 

Chain 

 

Circle 

 

Star 

 

Cognitive 
Demand 

 

Degree 
Centrality 

 

Eigenvect
or 

Centrality 

 

High 
Betweenne
ss and No 

Degree 
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Exclusivity 

 

  

 

 
GeoSpatial Network 

ORA provides tools to visualize Geospatial Information Systems: GIS 
Visualizer and GIS Visualizer 3D. When working with the GIS Visualizer your 
Meta-Network must include location information. 

 GeoSpatial is concerned with plotting who or what was where on a 
global basis. It plots nodes on a map and then connects those nodes. 
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 Loom also deals with nodes I n locations but is keyed on the 
timeframes in which nodes appear. There are locations in which two agents 
appear in but which were there at different times and never met. 

 

 
GIS 

The GeoSpatial Visualizer differs from the 2D Visualizer as it places nodes on 
a representative map whereas the regular Visualizer allows the nodes to 
float freely in a non-space. 

Many Geospatial information system (GIS) products apply the term 
geospatial analysis in a very narrow context. In the case of vector-based GIS 
this typically means operations such as map overlay (combining two or more 
maps or layers according to predefined rules), simple buffering (identifying 
regions of a map within a specified distance of one or more features, such as 
towns, roads or rivers) and similar basic operations. The Geospatial Network 
tool in ORA allows for the plotting of a Meta-Network on a map of the globe 
using longitude and latitude for placing the nodes. 
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This longitude and latitude is associated with a location nodeclass. Then 
other nodeclasses are associated with the location nodeclass. This 
information is used to place people and items on the map. 

Below is the default map included with ORA's GIS tool. 

 

NOTE : Other maps, or layers, can be added and loaded into the GIS 
Visualizer. The GIS Visualizer generally can load geospatial maps based on 
the Shapefile format. 

The ORA Geospatial Visualizer can be accessed from either the main menu 
bar: Main Menu Bar > Visualization > Geospatial Networks or by 
clicking the triangle on the Visualizer button in the Editor. 

Geospatial Networks attributes 

The Meta-Network MUST contain a location Node Class and that Node Set 
MUST contain longitude and latitude data. Below is an example of a 
Location node class information that contains Longitude and Latitude as 
attributes. 

 

Location COUNTRY POP CAP LONGITUDE LATITUDE 
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Murmansk Russia 468000 N 33.0860405 68.96355 

Arkhangelsk Russia 416000 N 40.6461601 64.52067 

Saint Petersburg Russia 5825000 N 30.4533272 59.95189 

Magadan Russia 152000 N 150.780014 59.571 

Perm' Russia 1160000 N 56.2324638 58.00024 

Yekaterinburg Russia 1620000 N 60.6101303 56.84654 

Nizhniy 
Novgorod 

Russia 2025000 N 43.94067 56.28968 

Glasgow UK 1800000 N 
-
4.26994753 

55.86281 

Kazan' Russia 1140000 N 49.1454659 55.73301 

NOTE : The columns which are necessary to build a Location Node Class 
are highlighted in Blue. In this example below, COUNTRY, POP, and CAP are 
not necessary, though they can be added, as additional attributes. Further 
below this chart, we will display how a location node set will appear in ORA's 
editor. 

Longitude and Latitude Format : The longitude and latitude use the 
degree.minute format. Longitude begins at the prime meridian which runs 
through Greenwich Village and run eastward 360 degrees. You can also 
denote the longitude values with positive or negative (-) numbers between 0 
and 180. Latitude uses a 0-point which begins at the equator and runs to 
90 to the north and -90 to the south. 
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GeoSpatial Network Toolbar 

 The GUI contains tools to work with the GIS maps. You can also 
customize the toolbar with functions from the menu. 

Standard Toolbar 

 
Copy Image to Clipboard : Places a copy of the current map in 
the clipboard which can be pasted into another program. 

 
Pan Map : Place the cursor on the map and click the button. The 
map will re-center on those co-ordinates. 

 
Select Place : Click and drag to capture nodes for information to 
display in an information window. This information will be 
displayed in an expanding tree format. Click and drag the cursor 
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to include the nodes to display. 

 

A pop-up window will display information for all the nodes captured by the 
cursor. 
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Zoom In : Zoom In works in two ways. 1) Click and drag to select 
the area you want to zoom in on. The selected area will fill the GIS 
window. 2) Click the map once and the view will zoom in centering 
on the clicked area. This can be repeated until you zoom in as 
close as needed. 

 
Zoom Out : Place the cursor on the map and click the button. the 
map will zoom out and re-center on those co-ordinates. 

 Show Labels : Toggle the labels on & off. 

 Show Links : Toggle the links on & off. 

 Show Arrows : Toggle the arrows on & off. 
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Font Size : Increase or decrease font size using the up & down 
arrows. 

 

Node Size : Increase or decrease node size using the up & down 
arrows. The size of the node is proportional to the number of 
entities in a location. 

 
Link Width : Increase or decrease link width using the up & down 
arrows. 

 

 
GeoSpatial File Menu 

 The GeoSpatial file menu allows you to open, add, and save map data. 

 

Open Meta-Network… : Opens a NEW Meta-Network file into 
the Geospatial map. REMEMBER: The new file needs to have both 
longitude and latitude data. 

 Open Trailset… :  

Add GIS Data… :  

 
Add CSV : You can load a .csv file and specify which columns 
contains the longitude/latitude data. 
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Add KML (Google Earth) : KML is a file format used to display 
geographic data in an earth browser (e.g. Google Earth). A KML 
file is processed in much the same way that HTML (and XML) files 
are processed by web browsers. Like HTML, KML has a tag-based 
structure with names and attributes used for specific display 
purposes. 

 

Add e00 : Contains Geographic Information Systems (GIS) 
mapping data exported by ArcGIS software. ORA can import this 
style of vector data and convert it for use in the GeoSpatial tool. 

 

Add ERSI Shapefile : An ERSI shapefile is a digital vector 
storage format for storing geometric location and associated 
attribute information. Shapefiles spatially describe geometries: 
points, polylines, and polygons. 

  NOTE : This format lacks the capacity to store topological 
information. 

 Add Shapefile (using Openmap) :  

 Add Shapefile (using Geotools) :  

Save Map… :  

 Save Map To PNG : Saves the currently map to the .PNG format. 

 Save Map To SHP : Saves the currently map to the .SHP format. 

 Save Map To KML : Saves the currently map to the .KML format. 

 
Save Map To DyNetML : Saves the current map to the DyNetML 
format with the added NodeClass ClusterLocation--
ClusterLocation. This records changes affected by the Network 
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Aggregator in grouping locations into regions. 

 

 
Save Map To Loom Trailset : Saves the currently map to the 
Loom format. 

Current GIS Layers 

  
Open From Defaults : Opens what is currently saved as the 
default Dynamic Network and GIS layers. 

  
Open from a File : Uses the information saved in the choose file 
to set the Dynamic Network and GIS layers. 

  
Save As Default : Saves the currently selected Dynamic 
Network and GIS layers as the default. 
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Save to a File : Saves the currently selected Dynamic Network 
and GIS layers to a file. 

Current Meta-Network Locations Configurations 

  Open From a File :  

  Save to a File :  

  Create Meta-Network From Visible Network... 

  
Copy Image To Clipboard : Saves a picture of the current map 
to the clipboard which can be pasted into another program for 
use in demonstration purposes. 

  Close 

 

 
GeoSpatial Modify Menu 

 GeoSpatial Actions Menu. 

 Replace Current Meta-Network :  

 Create New Spatial Relation :  

 Create New Spatial Nodeset :  
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GeoSpatial Analyze Menu 

 GeoSpatial Actions Menu controls color and size of location nodes. 

 
Reset Map Zoom : Reset the display of the map to it's default 
size. 

 
Reset Nodes Colors and Size : Returns on nodes to their default 
colors and sizes. 

  NOTE : If the colors do not reset, click on the map with Pan tool 
to force the reset. 

 
Size Nodes by Attribute or Measure : Sizes nodes using 
numerical data. 

  NOTE : You can not size by an attribute using non-numerical data. 

 
Size Links by Value : Adjusts the weights of links in proportion 
to all links. 

 Color Nodes by Attribute or Measure : Colors the nodes using 

 Color Nodes by Component :  

 
Color Nodes by Concor Grouping : Colors nodes using Concor 
Grouping*. 

 
Color Nodes by Newman Grouping : Colors nodes using 
Newman Grouping* 
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GeoSpatial Tools Menu 

 Tools is a set of controls for adjusting how nodes and links are displayed. 

 

Layer Manager : Controls the visibility of the NodeClass(es), 
Network(s), and Shape layers on the map by checking or 
unchecking the boxes. 

 
Network Aggregator : Controls the groupings of nodes which are 
displayed together as separate regions. 

 Get/Set View :  

 
Configure Meta-Network Locations :  
 

 

 
Layer Manager 

The GIS Layer Manager controls what is displayed in the GeoSpatial 
Visualizer. This includes all NodeClasses and Shape layers. It is similar to the 
Legend in the regular Visualizer. 
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Selecting or Deselecting a NodeClass or GIS Layer will remove it from the 
display. It does not remove it from the dataset. 

The Move Up and Move Down buttons adjust the display position of the 
SHAPE files. These buttons have no affect on the Network Layers. 

Layer Manager Menus 

Layers 

Add New Layer : You can add additional map files to the display. 

Remove Selected Layer : You can remove selected map layers from 
the display. 

Show All Network Layers : Displays all node information on the map 

Hide All Network Layers : Removes all Network information form the 
map. The Information is still available through the Layer Manager. 

Change Layer Position > Move Layer Forward :  

Change Layer Position > Move Layer Backward :  

Change Layer Position > Move Layer To Front :  
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Change Layer Position > Move Layer To Back :  

Add Layer As Nodeset :  

Options 

Set Current Map Data As Default :  

Reset Map With Default Data :  

 

 
Network Aggregator 

The Network Aggregator looks at regions instead of individual locations. 
Using the slider you can control how dense each region will be. Increasing 
the density groups more locations into a region. 

 



 

 
329 

 

Using a sliding scale, which in turn represents network information retention 
(or loss) depending on the level of the adjusted slider. A value can also be 
entered manually in the numeric field box. 

When the network bar is fully red it indicates full network resolution and 
therefore network information is preserved and displayed in the GIS 
Visualizer. Conversely, when lower network resolution figures are entered 
network detail can be sacrificed. This bar graph is intended to show the level 
of such loss. 

It is best to experiment with the slider at varying values and observing GIS 
visualization for optimum balance of data resolution and visual relevancy.  

This is a useful tool when you have many noisy or cluttered locations. The 
grouping assists you in seeing the connections easier. 

GeoSpatial with no aggregation 

 

GeoSpatial using Network Aggregation 
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GeoSpatial Options Menu 

 These options control various display options of the Visualizer. 

 Show Links : Toggles the visibility of the Links. 

 Show Labels : Toggles the visibility of the Node Labels. 

 Show Arrows : Toggles the visibility of the link Arrows. 

 Use 2D Visualization (Openmap) 

 Use 3D Visualization (NASA Worldwind) 

 

 
Loom/View Trails 
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Before starting you need a dataset that can be used within the Loom. One 
such dataset is the TAVI dataset. 

Use File > Open Meta Network to open TAVI.xml 

The clock icon in the Meta-Network Panel means that it is a dynamic meta 
network and that there are continuous-time updates (deltas, which are 
listed below the top-level network) indicating how the network changes 
over time. 

 

To analyze the data you must have a relation that A) changes over time and 
B) stays many:one (e.g., a person must have only one location at any given 
time). Usually this is Agent x Location, but in theory you can select other 
relations. 
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In the main ORA screen, open the Visualizer > View Trails. Select the 
Person x Location input network. 

At the top left is a list of Agents; the bottom left is a list of locations. 
Activating the check-box next to an agent will cause its trail to appear in the 
right hand panel. The large vertical strips correspond to locations, and the 
path moving between them is the trail indicating the agent's location at each 
point in time. 

 

Open Loom : Highlight the TAVI dataset in the Meta-Network pane. From 
the drop down menu select Visualizations > View Trailsets. In the dialog 
box select Persons x Locations. The Loom window will appear with the 
chosen Network. 

 

Selecting one person you can easily see where they've been (Left 
window). But when you select multiple people, it can quickly get impossible 
to view the trails right window). 
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Making the Display more Readable : can be done in several ways. 
Clicking the color circle representing the individual node brings up the color 
changer. You can then select a color which stands out better for viewing. 
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Loom File 

 Loom File Menu 

 
Open … : Opens up DyNetML file which contains location and time 
data. 

 
Save as… : Saves currently open DyNetML file under a new 
filename. 

 Export > DyNetML : Saves the Loom data as a DyNetML file. 

 
Save Image as… : Saves an image of the current Loom state. 
Can be saved as a png, jpeg, pdf, svg, or tiff file. 

 

 
Loom Options 

 Loom Options Menu 

 Anti-Aliasing : Used to smooth out rough edged lines. 

 
Grayscale : Removes all colors from image and is good when 
printing black and white images. 
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Show Timeline : Displays the timeline markers on the left of the 
Loom. 

 

Stretch Vertical : You can select a percentage to enlarge the 
height of the Loom. Good when many nodes are situated in a 
small area. 
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Bar Width : Widens the individual locations. Good when many 
nodes are situated in a small area. 

 

 

Allow Multiple Waypoints per Period : If unchecked a node will 
appear only in the most weighted position. If checked then the 
node will be placed in all locations. 
Example : A main location also contains three separate rooms. An 
agent can be listed to be in the main location but can also be listed 
as moving between the individual rooms. If this option is checked, 
the agent will be shown to be in all locations which can lead to it 
appearing an agent is in two places at once. 
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NOTE : The dotted line denotes a node which disappeared from all locations 
then reappeared later on. 

 

 
ORA Measures 

ORA contains over 100 measures.  

What is a Measure 

A measure is a function that takes as input a Meta-Network and outputs a 
single value or a vector of values. Consider the measure Density. The 
output for this measure is a single number used to analyze an organization. 
By default, all measures are run on a Meta-Network. To view which 
measures are available, go to the Tools menu and select the Measures 
Manager. 

ORA Measures Manager 

The Measures Manager categorizes measures in the following ways: 
Entity Level, Graph Level, and Risk Category. 

Entity Level Measure is one that is defined for, and gives a value for, 
each entity in a network. If there are x nodes in a network, then the 
metric is calculated x once each for each node. 

Examples are Degree Centrality, Betweenness, and Cognitive Demand. 

Graph Level Measure is one that is defined for, and gives a value for, 
the network as a whole. The metric is calculated once for the 
network. 

Examples are Centralization, Graph Hierarchy, and the maximum or 
average Betweenness 
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Some reports use a predefined set of measures, and these are not 
affected by the Measure Manager selections (for example, the Intel, 
Context, Located SubGroups, Sphere of Influence, and Immediate 
Impact reports). The Risk Report, however, uses only the measures 
selected in the Measure Manager. 

The following sets of entities (with their abbreviated symbol) are used 
throughout the document: Agent (A), Knowledge (K), Resource (R), and 
Task (T). The following networks defined on these entity sets are used 
throughout the documentation. 

 

Symbol Entity Sets Name 

 U V   

AA Agent Agent Communication Network 

AK Agent Knowledge Knowledge Network 

AR Agent Resource Capabilities Network 

AT Agent Task Assignment Network 

KK Knowledge Knowledge Information Network 

KR Knowledge Resource Training Network 

KT Knowledge Task 
Knowledge Requirement 
Network 

RR Resource Resource 
Resource Substitute 
Network 

RT Resource Task 
Resource Requirement 
Network 

TT Task Task Precedence Network 

Input: 

This lists each of the Networks that are required as input to the 
measure. If a measure takes as input a specific network from the Meta-
Network, such as the Agent x Knowledge (AK) matrix, then it is 
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listed. If the measure runs on any square (unimodal) network then 
N is given. A measure can require more than one input matrix. 

1. Each input matrix can have one or more of the following 
requirements:  

a. square: the matrix must have the same number of 
rows as columns 

b. binary: it must be binary data (i.e. any links in the 
network are assumed to have a weight of one) 

c. symmetric: the network must be undirected 

2. ORA does the following when a network does not meet one 
or more of the above requirements: 

a. square: measure is not computed 

b. binary: measure is computed, and edge weights are 
ignored (all edges are given value one) 

c. symmetric: measure is computed, and the matrix is 
first symmetrized using the union method 

A complete list of all measures available in ORA, along with references, 
input and output specifications, can be found in the following ORA 
Measures sections. 

 
Access Redundancy 

Informal Name 

None 

Citation 

Carley, Kathleen M. 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: CMU 
2002 

Minimum and Maximum Values 
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Minimum : 0 

Maximum : ℜ∈[0,(|A|-1*|R|]. 

Computational Time 

Fast 

Description 

Average number of redundant agents per resource. An agent is redundant if 
there is already an agent that has access to the resource. 

Input : Agent by Resource matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Actual Workload 

Informal Name 

None 

Citation 

Carley, Kathleen M. 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: CMU 
2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 
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The knowledge and resources an agent uses to perform the tasks to which it 
is assigned. Individuals or organizations that are high in workload are those 
that are doing more complex tasks and have the resources and knowledge 
or expertise to do those tasks. Tasks are more complex if they require more 
expertise and/or more resources. This measures is only calculated if all of 
the following matrices are available: agent x knowledge, agent x resource, 
agent x task, knowledge x task, resource x task. 

Example : In a given organization, employees have access to certain 
knowledge (e.g., fix computers) and resources (e.g., computer parts). 
This measure would compute a value to reflect the overall level of 
organizational access within the network.  

Actual Workload 

Input :  

Agent by Knowledge matrix with DataType=binary 

Agent by Resource matrix with DataType=binary 

Agent by Task matrix with DataType=binary 

Knowledge by Task matrix with DataType=binary 

Resource by Task matrix with DataType=binary 

Output : Node Level with Type=agent and DataType=real. 

 
Agent Knowledge Needs Congruence 

Informal Name 

None 

Citation 

Lee, 2004 

Minimum and Maximum Values 
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Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The number of knowledge that an agent lacks to complete its assigned tasks 
expressed as a percentage of the total knowledge required for the assigned 
tasks. 

Input :  

Agent by Knowledge matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 

Knowledge by Task matrix with DataType=binary. 

Output : Node Level with Type=agent and DataType=real. 

 
Agent Knowledge Waste Congruence 

Informal Name 

None 

Citation 

Lee, 2004 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 
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Medium 

Description 

The number of knowledge that an agent has that are not needed by any of 
its tasks expressed as a percentage of the total knowledge of the agent. 

Input :  

Agent by Knowledge matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 

Knowledge by Task matrix with DataType=binary. 

Output : Node Level with Type=agent and DataType=real. 

 
Agent Resource Needs Congruence 

Informal Name 

None 

Citation 

Lee, 2004 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 
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The number of resources that an agent lacks to complete its assigned tasks 
expressed as a percentage of the total resources required for the assigned 
tasks. 

Input :  

Agent by Resource matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 

Resource by Task matrix with DataType=binary. 

Output : Node Level with Type=agent and DataType=real. 

 
Agent Resource Waste Congruence 

Informal Name 

None 

Citation 

Lee, 2004 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The number of resources that an agent has that are not needed by any of its 
tasks expressed as a percentage of the total resources of the agent. 

Input :  



 

 
345 

 

Agent by Resource matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 

Resource by Task matrix with DataType=binary. 

Output : Node Level with Type=agent and DataType=real. 

 
Agent Socio Economic Power 

Informal Name 

None 

Citation 

Kathleen M. Carley, 2004 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

A measure of actor power based on access to knowledge, resources, and 
tasks in the organization. 

Example : An individual within an organization that has the most 
connections, hence access, to knowledge (special skills), resources 
(unlimited funding) and tasks (has the most important tasks). Such an 
agent would rank high in the SocioEconomic Power measure. 

Input :  

Agent by Knowledge matrix with DataType=binary. 
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Agent by Resource matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 

Output : Node Level with Type=agent and DataType=real. 

 
Assignment Redundancy 

Informal Name 

None 

Citation 

Carley, Kathleen M. 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : ℜ∈[0,(|A|-1*|T|] 

Computational Time 

Fast 

Description 

Average number of redundant agents assigned to tasks. An agent is 
redundant if there is already an agent assigned to the task. 

Input : Agent by Task matrix with dataType=binary 

Output : Graph Level with DataType=real 

 
Authority Centrality 
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Informal Name 

None 

Citation 

Kleinberg J.M, 1998 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

A node is authority-central to the extent that its in-links are from nodes that 
have many out-links. Individuals or organizations that act as authorities are 
receiving information from a wide range of others each of whom sends 
information to a large number of others. Technically, an agent is authority-
central if its in-links are from agents that have are sending links to many 
others. The scientific name of this measure is authority centrality and it is 
calculated on agent by agent matrices. 

Input : Square matrix with DataType=real. 

Output : Node Level with DataType=real. 

 
Average Distance 

Informal Name 

None 

Citation 
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NetStat 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The average shortest path length between nodes, excluding infinite 
distances. 

Example : In a given organization, this measure computes the average 
amount of connections between any two members in the organization. 

Input : Square matrices. 

Agent by Knowledge matrix with DataType=binary 

Agent by Task matrix with DataType=binary 

Knowledge by Task with DataType=binary 

Output : Graph Level with DataType=real. 

 
Average Speed 

Informal Name 

None 

Citation 

Carley, Kathleen M. 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002 
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Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The average speed with which any two nodes can interact. This is based on 
the inverse of the shortest path lengths between node pairs. 

Example : In an organization that any two individuals have an average 
of 3.4 connections between them would approximate the average speed 
at which an a communication might spread throughout the organization. 
Naturally, the lower the average links, the higher the organizational 
speed. 

Input : Square matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

  

 
Betweenness Centrality 

Informal Name 

None 

Citation 

Freeman, 1979 

Minimum and Maximum Values 

Minimum : 0 
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Maximum : 1 

Computational Time 

Slow 

Description 

Network centralization based on the betweenness score for each node in a 
square network. This measure is defined for directed and undirected 
networks. 

The Betweenness Centrality of node v in a network is defined as: across all 
node pairs that have a shortest path containing v, the percentage that pass 
through v. Individuals or organizations that are potentially influential are 
positioned to broker connections between groups and to bring to bear the 
influence of one group on another or serve as a gatekeeper between 
groups. This agent occurs on many of the shortest paths between other 
agents. The scientific name of this measure is betweenness centrality and it 
is calculated on agent by agent matrices. 

Example : This measure indicates the extent that an individual is a 
broker of indirect connections among all others in a network. Someone 
with high Betweenness could be thought of as a gatekeeper of 
information flow. People that occur on many shortest paths among other 
People have highest Betweenness value. Betweenness is one of the key 
measures used by those interested in networks. 

Input : Square Node Level Matrix with DataType=binary 

Output : Node Level and dataType="real" 

 
Bonacich Power Centrality 

Informal Name 

None 

Citation 
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Bonacich P., 1987 "Factoring and weighing approaches to clique 
identification" Journal of Mathematical Sociology, 2 (January, 1972), 113-
120. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The Bonacich Power Centrality computes the centrality of each entity based 
on the centrality of its neighbors. Beta should be chosen such that its 
absolute value is less than the reciprocal of the largest eigenvalue of N. 

Example : In a given organization, this measure can tell us who is 
connected to the most powerful (e.g., other highly connected agents) 
people. 

Input : Square Node Level matrix with DataType=real.  

Output : Node Level and DataType=real. 

 
Boundary Spanner 

Informal Name 

None 

Citation 

Cormen, Leiserson, Rivest, Stein 2001. "Introduction to Algorithms" Second 
Edition. Cambridge, MA: MIT Press, 2001. 

Minimum and Maximum Values 
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Minimum : 0 

Maximum : 1 

Description 

An node which, if removed from a network, creates a new component. 

This is often called a Gate Keeper node. It consists of High Betweenness 
and Low Centrality. A Boundary Spanner is an articulation point of N, 
as defined in the referenced book. 

Example : An employee with few direct connections, but if removed 
from the network will result in an unconnected sub-group. 

Input : Square Node Level Agent by Agent matrix with 
DataType=binary, Direction=No. 

OutputNode Level with DataType=Binary. 

 
Burt Constraint 

Informal Name 

None 

Citation 

Burt, Ronald. Structural Holes: The Social Structures of Competition. 
Cambridge, MA: Harvard University Press, 1992. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 
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Description 

The degree to which each node in a square network is constrained from 
acting because of its existing links to other nodes. 

Example : Bob is given a certain task, but that task requires certain 
links, which Bob does not have. Bob is constrained in the sense he does 
not have the links to complete the task. This measure computes a value 
for such relationships as they distributed across the whole network. 

Input : Square matrix with dataType=real. 

Output : Node Level with DataType=real. 

 
Capability 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2007 

Minimum and Maximum Values 

Minimum :  

Maximum :  

Computational Time 

Fast 

Description 

Detects entities with high or low degree relative to other entities. The 
formula discounts for the fact that most agents have some connections and 
assumes that there is a general discount to having large numbers of 
connections. 



 

 
354 

 

Input : Square matrix with dataType=real. 

Output : Node Level with DataType=real and type=row. 

 
Clique Count 

Informal Name 

None 

Citation 

Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods 
and Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

The number of distinct cliques to which each node belongs. Individuals or 
organizations who are high in number of cliques are those that belong to a 
large number of distinct cliques. A clique is defined as a group of three or 
more actors that have many connections to each other and relatively fewer 
connections to those in other groups. The scientific name of this measure is 
clique count and it is calculated on the agent by agent matrices. 

Input : Square matrix with dataType=binary. 

Output : Node Level with DataType=integer. 
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Classic SNA Density 

Informal Name 

None 

Citation 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

The ratio of the number of links versus the maximum possible links for a 
square network. Self-loops are ignored. 

Input : Square matrix with dataType=binary. 

Output : Graph Level with DataType=real. 

 
Closeness Centrality 

Informal Name 

None 

Citation 

Freeman, L.C. (1979). "Centrality in Social Networks I: Conceptual 
Clarification." Social Networks, 1, 215-239. 
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Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

The average closeness of a node to the other nodes in a network. Closeness 
is the inverse of the average distance in the network between the node and 
all other nodes. 

Closeness reveals how long it takes information to spread from one 
individual to others in the network. High scoring individuals in Closeness 
have the shortest paths to all others in the network. It would follow such 
individuals could monitor the information flow in an organization better than 
most others that have a lesser Closeness value. The ones with the highest 
value in this measure will often times have the best picture of what is 
happening in the network as a whole. 

In short, Closeness is the inverse of the average distance in the network 
between any given node and all other nodes. 

Example : Closeness reveals so-called people in the know. Closeness 
measures the path length from one person to another in a network. It 
tells us which person is central to an organization. 

Input : Square matrix with DataType=binary. 

Output : Node Level with DataType=real. 

 
Closeness Network Centralization 

Informal Name 

None 
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Citation 

Freeman, L.C. (1979). Centrality in Social Networks I: Conceptual 
Clarification. Social Networks, 1, 215-239. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

Network centralization based on the closeness centrality of each node in a 
square network. This is defined only for connected, undirected networks. 

Example : An organization has employees, computers, benchmarks, and 
products. How central these entities exist within the connections of the 
network, which is defined by the connections they have throughout the 
network, is loosely what is network centralization. This measure 
computes a value for the centrality of these entities. 

Input : Square matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Cognitive Demand 

Informal Name 

Emergent Leader 

Citation 

Carley, Kathleen M. & Yuqing Ren, 2001, "Tradeoffs Between Performance 
and Adaptability for C3I Architectures." In Proceedings of the 2001 
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Command and Control Research and Technology Symposium, Annapolis, 
Maryland, June, 2001. 

Carley, 2002. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

Measures the total amount of cognitive effort expended by each agent to do 
its tasks, need to move, connecting others, and so on. Such individuals may 
never become the formal leader of a group. Emergent leaders are identified 
in terms of the amount of cognitive effort that is inferred to be expended 
based on the individual's position in the meta-network. Individuals who are 
strong emergent leaders are likely to be not just connected to many people, 
organizations, tasks, events, areas of expertise, and resources; but also, are 
engaged in complex tasks where they may not have all the needed 
resources or knowledge and so have to coordinate with others, or have other 
reasons why they need to coordinate or share data or resources. 

Input : Agent by Agent matrix with dataType=binary. 

Output : Node Level Agent with DataType=real. 

 
Cognitive Distinctiveness 

Informal Name 

None 

Citation 
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Carley, Kathleen 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

Measures the degree to which each pair of agents has complementary 
knowledge, expressed as the percent of total knowledge. 

Input : Matrix with Type=Agent (Source) and Type=Knowledge (Target) 
and DataType=binary. 

Output :  

Node Level : Node Level with Type=agent and DataType=real. 

Dyad Level : Dyad Level with SourceType=agent, 
TargetType=agent, and DataType=real. 

 
Cognitive Expertise 

Informal Name 

None 

Citation 

Carley, Kathleen M. 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: CMU 
2002 
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Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

Measures the degree to which each pair of agents has complementary 
knowledge, expressed as a percentage of the knowledge of the first agent. 

Example : If one person in an organization knows how do perform X but 
can't do Y. Whereas another individual can do Y but not X, such 
individuals would rank highly in this measure. 

Input : Agent (source) by Knowledge (knowledge) matrix with 
DataType=binary." 

Output :  

Node Level with Type=agent and DataType=real. 

Dyad Level with Type=agent, Target=agent, and DataType=real. 

 
Cognitive Resemblance 

Informal Name 

None 

Citation 

Carley, Kathleen M. 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 
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Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

Measures the degree to which each pair of agents has the exact same 
knowledge. Each value is normalized by the row sum. 

Example : In an given organizational network, let us say that Bob has 
the knowledge to perform X, Y, and Z. Whereas Sally also has the 
knowledge to perform X, Y and Z. This measure would rank this pair 
(i.e., dyad) high in Cognitive Resemblance. 

Input : Agent by Knowledge matrix with DataType=binary. 

Output : Dyad Level with an Agent by Knowledge matrix with 
DataType=real. 

 
Cognitive Similarity 

Informal Name 

None 

Citation 

Carley, Kathleen M. 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 
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Computational Time 

Slow 

Description 

Measures the degree to which each pair of agents have overlapping 
knowledge. 

Example : With an organization where Bob has the knowledge of X, Y 
and Z and Sally has the knowledge of Q, R and Z. The Cognitive 
Similarity measure would compute a value for Bob and Sally's 
overlapping knowledge of Z. 

Input : Agent (source) by Knowledge (target) matrix with 
dataType=binary. 

Output :  

Node Level with Type=agent and DataType=real. 

Dyad Level with Agent by Agent matrix with DataType=real. 

 
Column Breadth 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 
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Fast 

Description 

The fraction of entities with column nodes with degree greater than one. 

Example : In a given organization, we have the following entities: 
employees (agents), computers (resources), benchmarks (tasks). This 
measure tells us on how many links greater than one exist within these 
entity types. 

Input : Matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Column Count 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : Number of Columns 

Computational Time 

Fast 

Description 

The number of column nodes in a network. 

Input : Matrix with DataType=binary. 
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Output : Graph Level with DataType=integer. 

 
Column Degree Centrality 

Informal Name 

None 

Citation 

Wasserman and Faust, 1994 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

A centralization based on the degree of the column nodes of a network. 

Input : Matrix with DataType=real 

Output : Node Level with dataType=real and Type=column. 

 
Column Degree Network Centralization 

Informal Name 

None 

Citation 
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NetStat 

Minimum and Maximum Values 

Minimum :  

Maximum :  

Computational Time 

Fast 

Description 

A centralization based on the degree of the column nodes of a network. 

Input : Matrix with DataType=real 

Output : Node Level with dataType=real and Type=column. 

 
Column Redundancy 

Informal Name 

None 

Citation 

Carley, Kathleen M. 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : ℜ∈[0,(m-1)*n] 

Computational Time 
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Fast 

Description 

The mean number of column node links in excess of one. 

Input : Matrix with dataType=binary. 

Output : Graph Level with DataType=real. 

 
Communication 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2003 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

Measures the communication need of agents to complete their assigned 
tasks. 

Example : In a given organization Bob is assigned a task which is 
dependant upon his social links to other individuals in the network. The 
measure would compute a value for how dependent Bob is on the links 
to the other individuals to complete the task. A higher value would 
indicate Bob must possess a greater number of connections to complete 
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any given task he is assigned. Conversely, a low value would indicate 
relatively few linkages are necessary to complete certain tasks. 

Input :  

Agent by Agent matrix with dataType=binary. 

Agent by Task matrix with dataType=binary. 

Agent by Resource matrix with dataType=binary. 

Resource by Task matrix with dataType=binary. 

Task by Task matrix with dataType=binary. 

Output : Node Level with Type=agent and DataType=real. 

 
Communication Congruence 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: CMU 
2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 
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Measures to what extent the agents communicate when and only when it is 
needful to complete tasks. Perfect congruence requires a symmetric Agent x 
Agent network. 

One of the following pairs of matrices must exist: AK/KT, AR/RT. If both 
exist, then the measure first concatenates them into [AK AR], [KT RT] and 
uses them. 

Communication Congruence = 1 iif agents communicate when and only 
when it is needful to complete their tasks. There are three task related 
reasons when agents i and j need to communicate: 

(a) Handoff: if i is assigned to a task s and j is assigned to a task t and s 
directly precedes task t. 

(b) Co-Assignment: if i is assigned to a task s and j is also assigned to s. 

(c) Negotiation: if i is assigned to a task s and j is not, and there is a 
resource r to which agents assigned to s have no access but j does. 

The three cases are computed as follows: 

(a) let H = AT*TT*AT' 

(b) let C = AT*AT' 

(c) let N = AT*Z*AR', where Z(t,r) = [AT'*AR - RT'](t,r)<0 

Note that C is always symmetric, but not necessarily H and N. 

let Q(i,j) = [ (H+H') + C + (N+N')](i,j) > 0. 

Communication Congruence requires reciprocal communication, explaining 
the transposes of H and N to make them symmetric. 

let d = hamming distance between Q and AA, which measures the degree to 
which communication differs from that which is needed to do tasks. 

The maximum value for d is d_max = |A|*(|A|-1) 

Then Communication Congruence = 1 - (d /d_max), which is in [0,1]. 

Input :  
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Agent by Agent matrix with dataType=binary. 

Agent by Task matrix with dataType=binary. 

Agent by Resource matrix with dataType=binary. 

Resource by Task matrix with dataType=binary. 

Task by Task matrix with dataType=binary. 

Output :  

Graph Level with DataType=real. 

 
Communicative Need 

Informal Name 

None 

Citation 

Carley Kathleen M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

Measures the percentage of reciprocal links in a network. This is also called 
Reciprocity. 

Input : Square matrix with DataType=binary 
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Output : Graph Level with DataType=real. 

 
Complete Exclusivity 

Informal Name 

None 

Citation 

Ashworth, M. and Kathleen M. Carley, 2003 "Critical Human Capital" Working 
Paper, CASOS, Carnegie Mellon, Pittsburgh PA. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

Detects entities that have ties that no other entity has. Individuals or 
organizations that are high in complete exclusivity for events are those that 
attend or are supposed to attend an event that no one else does. The 
scientific name of this measure is complete exclusivity and it is calculated on 
agent by event matrices. 

Example : Individuals or organizations that are high in complete 
exclusivity for events are those that attend or are supposed to attend an 
event that no one else does.  

Input : Matrix with DataType=binary. 

Output : Node Level with DataType=real and Type=row. 
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Complexity 

Informal Name 

None 

Citation 

Wasserman and Faust, 1994 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

The density of the meta-network as a whole. 

Input : MetaMatrix with DataType=binary. 

Output : Graph Level with dataType=real. 

 
Connectedness 

Informal Name 

None 

Citation 

Krackhardt, D. 1994. Graph Theoretical Dimensions of Informal 
Organizations. In Computational Organization Theory, edited by Carley, 
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Kathleen M. and M.J. Prietula. Hillsdale, NJ: Lawrence Erlbaum Associates, 
1994. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

Measures the degree to which a square network's underlying (symmetrized) 
network is connected. Individuals or organizations that connect groups are 
those that are connecting disconnected groups. The individual or 
organization may be connected to only one or a few members of each 
groups. This is a composite measure that is high when the agent is 
potentially influential but is not in the know. This is calculated as the ration 
of betweenness centrality to total degree centrality and is calculated on 
agent by agent matrices. 

Input : Square matrix with dataType=binary. 

Output : Graph Level with DataType=real. 

 
Distinctiveness Correlation 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum : 0 
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Maximum : 1 

Description 

Measures the degree to which each pair of rows has complementary data, 
expressed as the percent of total data. 

Input : Matrix with dataType=binary. 

Output :  

Node Level with Type=row and DataType=real. 

Dyad Level with SourceType=row, TargetType=row, and 
DataType=real. 

 
Correlation Expertise 

Informal Name 

None 

Citation 

Carley, Kathleen, M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

Measures the degree to which each pair of rows has complementary data, 
expressed as a percentage of the data of the first row. 
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Input : Matrix with dataType=binary. 

Output :  

Node Level with Type=row and DataType=real. 

Dyad Level with SourceType=row, TargetType=row, and 
DataType=real. 

 
Resemblance Correlation 

Informal Name 

None 

Citation 

Carley, Kathleen, M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

Measures the degree to which each pair of rows has the exact same data. 

Input : Matrix with dataType=binary. 

Output :  

Node Level with Type=row and DataType=real. 

Dyad Level with SourceType=row, TargetType=row, and 
DataType=real. 
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Similarity Correlation 

Informal Name 

None 

Citation 

Carley, Kathleen, M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

Measures the degree to which each pair of rows have overlapping data. 

Input : Matrix with dataType=binary. 

Output :  

Node Level with Type=row and DataType=real. 

Dyad Level with SourceType=row, TargetType=row, and 
DataType=real. 

 
Density 

Informal Name 

None 
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Citation 

Wasserman, Stanley and Katherine Faust. Social Network Analysis: Methods 
and Applications. Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

The ratio of the number of links versus the maximum possible links for a 
network. 

Density compares existing links to all possible links in the employee 
communication network. It reflects the social level of organizational 
cohesion. This measure must be interpreted in relation to the size of the 
group and the type of work performed. 

Input : Unimodel matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Diameter 

Informal Name 

None 

Citation 

Wasserman, Stanley and Katherine Faust. Social Network Analysis: Methods 
and Applications. Cambridge: Cambridge University Press, 1994. 
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Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The maximum shortest path length between any two nodes in a unimodal 
network G=(V,E). If there exist i,j in V such that j is not reachable from i, 
then |V| is returned. 

Input : Square matrix with dataType=binary. 

Output : Graph Level with DataType=integer. 

 
Diffusion 

Informal Name 

None 

Citation 

Carley, Kathleen M. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 
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Description 

Computes the degree to which something could be easily diffused (spread) 
throughout the network. This is based on the distance between nodes. A 
large diffusion value means that nodes are close to each other, and a 
smaller diffusion value means that nodes are farther apart. 

Input : Square matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Effective Network Size 

Informal Name 

None 

Citation 

Burt, Ronald. Structural Holes: The Social Structures of Competition. 
Cambridge, MA: Harvard University Press, 1992. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

The effective size of a node's ego network based on redundancy of links. 

Example : In a given organization, let us say Bob has ties to many 
others in the organization, who in turn have redundant ties to other 
people. The point at which this no longer applies tends to define effective 
network size. 
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Input : Square matrix with DataType=real. 

Output : Node Level with DataType=real. 

 
Efficiency 

Informal Name 

None 

Citation 

Krackhardt, D. 1994. Graph Theoretical Dimensions of Informal 
Organizations. In Computational Organization Theory, edited by Carley, 
Kathleen M. and M.J. Prietula. Hillsdale, NJ: Lawrence Erlbaum Associates, 
1994. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

The degree to which each component in a network contains the minimum 
links possible to keep it connected. 

Example : In an organization, let us say Bob has a connection to the 
computer, Sales, Event, and Goal. This measure computes a value for 
the minimum number of links entities such as Bob must have for the 
network to maintain its network status. Therefore, this is a network level 
measure. In other words, if Bob had one less link, then the entities 
would cease to constitute the original network. 

Input : Square matrix with DataType=binary and Directed=No. 
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Output : Graph Level with DataType=real. 

 
Eigenvector Centrality 

Informal Name 

None 

Citation 

Bonacich P, 1972 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

Calculates the principal eigenvector of the network. A node is central to the 
extent that its neighbors are central. Leaders of strong cliques are 
individuals or organizations who are connected to others that are themselves 
highly connected to each other. In other words, if you have a clique then the 
individual most connected to others in the clique and other cliques, is the 
leader of the clique. Individuals or organizations who are connected to many 
otherwise isolated individuals or organizations will have a much lower score 
in this measure then those that are connected to groups that have many 
connections themselves. This would be true even if such a WHO might have 
a high amount of actual connections (i.e. high degree centrality). 

It calculates the eigenvector of the largest positive eigenvalue of the 
adjacency matrix representation of a square network. A Jacobi method is 
used to compute the eigenvalues and vectors. 

Hub-Centrality and Authority-Centrality measures are generalizations of the 
Eigenvector Centrality measure and take into account directed links. 
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Example : It follows that a person well-connected to well-connected 
people can spread information much more quickly than one who only has 
connections to lesser important people in a network. People with higher 
scores of Eigenvector Centrality could be critical when rapid 
communication is needed. 

Furthermore, individuals or organizations that are connected to man 
other otherwise isolated groups will have a much lower score in this 
measure than those that are connected to groups that have many 
connections themselves.  

Input : Square Agent by Agent Node Level matrix with DataType=real 
and directed=No. 

Output : Node Level and DataType=real. 

 
Exclusivity 

Informal Name 

None 

Citation 

Ashworth, 2002 

Minimum and Maximum Values 

Minimum :  

Maximum :  

Computational Time 

Fast 

Description 

Detects entities that have ties that comparatively few other entities have. 
Individuals or organizations that are high in complete exclusivity for 
knowledge are those that have expertise or are connected to types of 
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knowledge that no one else has. The scientific name of this measure is 
complete exclusivity and it is calculated on agent by knowledge matrices. 

• Individuals or organizations that are high in complete exclusivity for 
location are those that have frequented locations that no one else has. 

• Individuals or organizations that are high in complete exclusivity for 
resources are those that have resources or are connected to types of 
resources that few others have. 

• Individuals or organizations that are high in complete exclusivity for 
tasks are those that are engaged in or assigned to tasks or activities 
for which no one else is engaged in or assigned to. 

Input : Matrix with DataType=binary. 

Output : Node Level with DataType=real and Type=row. 

 
Fragmentation 

Informal Name 

None 

Citation 

Borgatti, S.P. 2003. The Key Player Problem. Dynamic Social Network 
Modeling and Analysis: Workshop Summary and Papers, R. 

Breiger, K. Carley, & P. Pattison (Eds.) Committee on Human Factors, 
National Research Council, 241-252. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 



 

 
383 

 

Description 

The proportion of nodes in a network that are disconnected. 

Example : In a given organization 25 out of 400 sales agents are 
disconnected from the resources and knowledge that exists at the 
company headquarters because they travel more frequently and are thus 
disconnected from the rest of the network. The attribute of this 
disconnection expressed as a property of the entire organization is its 
computed disconnected measure.  

Input : Square matrix with DataType=binary and Directed=No. 

Output : Graph Level with dataType=real. 

 
Geodesic Distance 

Informal Name 

None 

Citation 

Wasserman and Faust, 1994 

Minimum and Maximum Values 

Minimum : 0 

Maximum : Number of columns - 1 

Computational Time 

Medium 

Description 

Computes the length of the shortest path between all node pairs, where 
length is the number of links, ignoring link weights. If no path exists 
between two nodes, then a distance of zero is given. The distance from a 
node to itself is also zero. 
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Input : Square matrix with DataType=binary. 

Output : Dyad Level with DataType=integer. 

 
Global Efficiency 

Informal Name 

None 

Citation 

Latria and Marchiori, 2001 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

Global Efficiency is the normalized sum of the inverse geodesic distances 
between all entity pairs. 

Example : In an organization certain resources are closer to each other 
in terms of links. If both resources are located closer to each other than 
it would follow an organization where such resources tend to be more 
closely distributed across a network would be a more efficient network. 

Input : Square matrix with DataType=binary. 

Output : Graph Level with DataType=real. 
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Hierarchy 

Informal Name 

None 

Citation 

Krackhardt, D. 1994. Graph Theoretical Dimensions of Informal 
Organizations. In Computational Organization Theory, edited by Carley, 
Kathleen M. and M.J. Prietula. Hillsdale, NJ: Lawrence Erlbaum Associates, 
1994. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

The degree to which a unimodal network exhibits a pure hierarchical 
structure. 

Example : Let us say in an organization Sue is the president. Under 
Sue, we have 4 vice presidents, whom all in turn have 5 or 10 direct 
reports, who all have 2 or 3 managers working for them. To such a 
degree that this architecture is present in the organization is its 
computed Krackhardt Hierarchy value. 

Input : Square matrix with DataType=binary. 

Output : Graph Level with dataType=real. 
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Hub Centrality 

Informal Name 

None 

Citation 

Kleinberg J.M, 1998 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

A node is hub-central to the extent that its out-links are to nodes that have 
many in-links. Individuals or organizations that act as hubs are sending 
information to a wide range of others each of whom has many others 
reporting to them. Technically, an agent is hub-central if its out-links are to 
agents that have many other agents sending links to them. The scientific 
name of this measure is hub centrality and it is calculated on agent by agent 
matrices. 

Input : Square matrix with DataType=real. 

Output : Node Level with DataType=real. 

 
In Degree Centrality 

Informal Name 
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None 

Citation 

Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods 
and Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

For any node, e.g. an individual or a resource, the in-links are the 
connections that the node of interest receives from other nodes. 

Example : An agent by knowledge matrix with a number of in-links. A 
piece of knowledge has is the number of agents that are connected to. 

Input : Square Agent by Agent matrix with DataType=real. 

Output : Node Level with DataType=real and Type=Column. 

 
In Degree Network Centralization 

Informal Name 

None 

Citation 

NetStat 

Minimum and Maximum Values 
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Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

A centralization of a square network based on the In-Degree Centrality of 
each node. 

Example : In a given organization, all employees have many incoming 
links to other employees. This is their In degree connections. This 
measure computes a value for the entire organization as a whole as to 
how central these connections are within the organization.  

Input : Square matrix with DataType=real. 

Output : Graph Level with DataType=real. 

 
Information Centrality 

Informal Name 

None 

Citation 

Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods 
and Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 
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Slow, with High Space requirements 

Description 

Information centrality is a network metric that accounts for indirect as well 
as shortest (geodesic) paths among entities. Information centrality is similar 
to betweenness, except that betweenness considers only shortest paths 
geodesics, whereas information centrality also considers more circuitous 
paths weighted by the inverse of the path length (the number of links 
along the path). 

Calculates the Stephenson and Zelen information centrality measure for 
each entity. 

Example : Entities high in information centrality are more likely to get 
more information and to get information faster. 

Input : Square matrix with DataType=real and Directed=No. 

Output : Node Level with DataType=real. 

 
Interdependence 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 
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Fast 

Description 

The percentage of links in a unimodal network that are Pooled or Reciprocal. 

Example : A reciprocal link is one that is bidirectional. Let us say Bob 
has a link to Sue and Sue has a link back to Bob This is a reciprocal link. 
However, if Bob had a lot of links to Sue and others, which were not 
reciprocated, that is bidirectional, than Bob would be said to rank higher 
in radial links, which linked in one direction. The extent that a network 
exhibits these relationships is computed as the Interdependence and 
Radial value for the network.  

Let G=(V,E) be the graph representation of a square network. 

Let a = Pooled Edge Count and b = Reciprocal Edge Count of the 
network. 

Then Interdependence = (a+b)/|E| 

Input : Square matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Interlockers 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 
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Computational Time 

Fast 

Description 

Interlocker nodes have a triad count greater than one standard deviation 
above the mean node triad count. 

Example : A typical corporate board of directors is a good example of 
an interlocking architecture. Whereas a predominant amount of board 
members—perhaps close to 70-percent—might serve on one board only, 
it is often common that the remaining 30-percent may serve on 3 or 
more other boards. These directors that serve on the other boards 
constitute the interlocking agents that connect all these typical boards 
together. The Interlockers and radial measures compute a value for such 
relationships as they exist in the network at the entity, that is agent 
(e.g., "board member"), level. 

Input : Square matrix with DataType=binary. 

Output : Node Level with DataType=binary. 

 
Inverse Closeness Centrality 

Informal Name 

None 

Citation 

Wasserman, Stanley and Katherine Faust. Social Network Analysis: Methods 
and Applications. Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 
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Computational Time 

Slow 

Description 

The average closeness of a node to the other nodes in a network. Inverse 
Closeness is the sum of the inverse distances between a node and all other 
nodes. Nodes high in closeness centrality are more likely to communicate 
faster and operate more efficiently. 

Input : Square matrix with DataType=binary. 

Output : Node Level with DataType=real. 

 
Isolate Count 

Informal Name 

None 

Citation 

Carley, Kathleen, M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : Number of nodes in the network 

Computational Time 

Fast 

Description 

The number of isolate nodes in a unimodal network. 

Input : Square matrix with DataType=binary. 
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Output : Graph Level with DataType=integer. 

 
Knowledge Access Index 

Informal Name 

None 

Citation 

Ashworth, M. and Carley, Kathleen M., 2003, "Critical Human Capital", 
Working Paper, CASOS, Carnegie Mellon, Pittsburgh PA. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

Boolean value which is true if an agent is the only agent who knows a piece 
of knowledge and who is known by exactly one other agent. The one agent 
known also has its KAI set to one. 

An node level measure that computes the average shortest path length 
between entities, excluding infinite distances. This is known as the 
Knowledge Access Index (KAI) value. 

Example : Let us imagine a social network where 50 employees have 
many connections to each other. The average number of connections per 
employee is the Access Index.  

Input : Agent by Agent matrix with DataType=binary 

Output : Output is nodeLevel with Type=agent and DataType=binary. 
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Knowledge Actual Workload 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: CMU 
2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The knowledge an agent uses to perform the tasks to which it is assigned. 

Input :  

Agent by Knowledge matrix withDataType=binary 

Knowledge by Task matrix with DataType=binary 

Agent by Task matrix with DataType=binary 

Output : Node Level with Type=agent and DataType=real. 

 
Knowledge Congruence 
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Informal Name 

None 

Citation 

Carley, Kathleen M. 2002 

Minimum and Maximum Values 

Minimum :  

Maximum :  

Computational Time 

Medium 

Description 

Measures the similarity between what knowledge are assigned to tasks via 
agents, and what knowledge are required to do tasks. Perfect congruence 
occurs when agents have access to knowledge when and only when it is 
needful to complete tasks. 

Input : Agent by Knowledge, Agent by Task, and Knowledge by Task 
matrices with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Knowledge Diversity 

Informal Name 

None 

Citation 

Borgatti, S.P. 2003. The Key Player Problem. Dynamic Social Network 
Modeling and Analysis: Workshop Summary and Papers, R. 
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Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

The distribution of difference in idea sharing. This is the Herfindahl-Hirshman 
index applied to column sums of AK. 

Example : Characterizes the network in terms of how the items in a 
knowledge network (who knows what) are non-uniformly distributed 
across employees 

Input : Agent by Knowledge matrix with DataType=binary. 

Output : Graph Level with dataType=real 

 
Knowledge Exclusivity 

Informal Name 

None 

Citation 

Ashworth, 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 
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Fast 

Description 

Detects agents who have singular knowledge. 

Example : A key piece of knowledge that supports an entire 
organization is only accessible through one person. 

Input : Agent by Knowledge matrix with DataType=binary. 

Output : Node Level with DataType=real and Type=agent. 

 
Knowledge Load 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

Average number of knowledge per agent. 

Input : Agent by Knowledge matrix with DataType=binary 
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Output : Graph Level with DataType=real. 

 
Knowledge Negotiation 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: CMU 
2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The extent to which agents need to negotiate with each other because they 
lack the knowledge to complete their assigned tasks. 

Example : In a given organization, Bob does not have knowledge 
needed to complete a certain task but Sue does have it. Bob must 
negotiate with Sue to gain that knowledge to complete the task. The 
extent to which others in the organization must negotiate for knowledge 
that others have is the organization's knowledge negotiation value. 

Input :  

Agent by Tasks matrix with DataType=binary. 

Agent by Knowledge matrix with DataType=binary. 
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Knowledge by Tasks matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Knowledge Omega 

Informal Name 

None 

Citation 

Carley, K, Dekker, D., Krackhardt, D (2000). How Do Social Networks Affect 
Organizational Knowledge Utilization.  

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The degree to which agents reuse knowledge while doing their tasks. 

Example : Sue has X amount of tasks within her company. How many 
of those tasks that require a knowledge that can be used for one or 
more of her other tasks is omega knowledge. This measure computes a 
value for such relations to knowledge sets at the network level.  

Input :  

Agent by Task matrix with DataType=binary. 

Knowledge by Task matrix with DataType=binary. 

Task by Task matrix with DataType=binary. 



 

 
400 

 

Output : Graph Level with DataType=real. 

 
Knowledge Potential Workload 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 

Minimum :  

Maximum :  

Computational Time 

Medium 

Description 

Maximum knowledge an agent could use to do tasks if it were assigned to all 
tasks. 

Example : In a given organization, let us say Bob is assigned all task 
that exist in the organization. This measure would compute a value 
expressing Bob's potential to carry out all the tasks based on his 
connections to the resources and knowledge needed for the tasks.  

Input :  

Agent by Knowledge matrix with DataType=binary. 

Knowledge by Task matrix with DataType=binary. 

Output : Node Level with Type=agent and DataType=real. 
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Knowledge Redundancy 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : ℜ∈ [0,(|A|-1)*|K|] 

Computational Time 

Fast 

Description 

Average number of redundant agents per knowledge. An agent is redundant 
if there is already an agent that has the knowledge. 

Input : Agent by Knowledge with dataType=binary. 

Output : Graph Level with dataType=real. 

 
Knowledge Task Completion 

Informal Name 

None 
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Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The percentage of tasks that can be completed by the agents assigned to 
them, based solely on whether the agents have the requisite knowledge to 
do the tasks. 

Example : Bob is assigned 10 Tasks to complete which require a certain 
amount of knowledge to finish. However, on average only 10-percent of 
this knowledge will be available to Bob for him to complete the tasks 
given. This measure would compute a value for the likelihood that Bob 
would be able to complete any given task. 

NOTE : Task Completion Overall is a combination of the Task Completion 
Knowledge and the Task Completion Resource. 

Input :  

Agent by Knowledge matrix with dataType=binary. 

Agent by Task matrix with dataType=binary. 

Knowledge by Task matrix with dataType=binary. 

Output : Graph Level with DataType=real 
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Knowledge Under Supply 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The extent to which the knowledge needed to do tasks are unavailable in the 
entire organization. 

Input :  

Agent by Task matrix with dataType=binary. 

Agent by Knowledge matrix with dataType=binary. 

Knowledge by Task matrix with dataType=binary. 

Output : Graph Level with DataType=real 

 
Lateral Link Count 
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Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

The percentage of lateral links in a unimodal network. Fixing a root node x, a 
lateral link (i,j) is one in which the distance from x to i is the same as the 
distance from x to j. 

Let G=(V,E) be the graph representation of a network. And fix an entity 
x∈V to be the root entity. 

Example : Fixing a root entity x, a lateral edge (i,j) is one in which the 
distance from x to i is the same as the distance from x to j. 

Input : Square matrix with DataType=binary. 

Output : Graph Level with DataType=real 

 
Link Count 

Informal Name 

None 
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Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : Number of links in the network 

Computational Time 

Fast 

Description 

The number of links in the network. 

Input : Matrix with DataType=binary. 

Output : Graph Level with DataType=integer. 

 
Local Efficiency 

Informal Name 

None 

Citation 

Latora and Marchiori, 2001 (Full reference forthcoming) 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 
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Slow 

Description 

Normalized sum of the Global Efficiency of each node's ego network (here, 
the ego network for entity i does not include entity i). 

Example : In an organization, Bob has a connection to the computers, 
Sales Data, Events, Goals. This measure computes a value for the 
minimum number of links to entities such as Bob must have for the 
network to maintain its network status. Therefore, this is a network level 
measure. If Bob had one less link, then the entities would cease to 
constitute the original network. 

Input : Square matrix with dataType=binary. 

Output : Graph Type with DataType=real. 

 
Location Relevance 

Informal Name 

None 

Citation 

Olson, Malloy 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

The extent to which location influences a particular persons connections. 
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Input :  

Agent by Agent matrix with DataType=real. 

Agent by Location matrix with DataType=real. 

Output : Node Level with Type=location with dataType=real. 

 
Minimum Speed 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

NOTE : Minimum Speed = 1 / (Levels for the Network) 

Computational Time 

Medium 

Description 

The maximum shortest path length between node pairs (i,j) where there is a 
path in the network from i to j. If there are no such pairs, then Minimum 
Speed is zero. 

Example : In an organization, we have Bob and Sue with numerous 
paths between them. The shortest path between this entity pair would 
be Bob and Sues (Bob/Sue) minimum speed. One might also say that if 
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there were numerous links between Bob and Sue and that the average 
linkage was in the neighborhood of 5 paths (e.g., links) when every 
person in the organization is taken as a whole, the shortest linkage 
between them would be the minimum speed at which Bob and Sue 
might communicative. If Bob and Sue had direct links, minimum speed 
would be 0.  

Input : Square matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Network Levels 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : Z∈[0,|V|-1] 

Computational Time 

Medium 

Description 

The Network Level of a square network is the maximum Node Level of its 
nodes. 

Input : Square matrix with DataType=binary. 

Output : Graph Level with DataType=integer. 
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Node Count 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : Number of nodes in the network 

Computational Time 

Fast 

Description 

The number of nodes in a unimodal network. 

Input : Square matrix with DataType=binary. 

Output : Graph Level with DataType=integer. 

 
Node Levels 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 
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Minimum and Maximum Values 

Minimum : 0 

Maximum : Number of nodes in the network - 1 

Computational Time 

Medium 

Description 

The Node Level for a node v in a square network is the longest shortest path 
from v to every node v can reach. If v cannot reach any node, then its level 
is 0. 

The Network Level of a square network is the maximum Node Level of its 
nodes. 

Input : Square matrix with DataType=binary. 

Output : Graph Level with DataType=integer. 

 
Organization Agent Knowledge Needs Congruence 

Informal Name 

None 

Citation 

Lee, 2004 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 



 

 
411 

 

Medium 

Description 

Across all agents, the knowledge that agents lack to do their assigned tasks 
expressed as a percentage of the total knowledge needed by all agents. 

Input :  

Agent by Knowledge matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 

Knowledge by Task matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Organization Agent Knowledge Waste Congruence 

Informal Name 

None 

Citation 

Lee, 2004 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium  

Description 

Across all agents, the knowledge that agents have that are not required to 
do their assigned tasks. 
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Input :  

Agent by Knowledge matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 

Knowledge by Task matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Organization Agent Resource Needs Congruence 

Informal Name 

None 

Citation 

Lee, 2004 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

Across all agents, the resource that agents lack to do their assigned tasks 
expressed as a percentage of the total resources needed by all agents. 

Input :  

Agent by Resource matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 
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Resource by Task matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Organization Agent Resource Waste Congruence 

Informal Name 

None 

Citation 

Lee, 2004 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

Across all agents, the resources that agents have that are not required to do 
their assigned tasks. 

Input :  

Agent by Resource matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 

Resource by Task matrix with DataType=binary. 

Output : Graph Level with DataType=real. 
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Organization Task Knowledge Needs Congruence 

Informal Name 

None 

Citation 

Lee, 2004 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

Across all tasks, the knowledge that tasks lack expressed as a percentage of 
the total knowledge needed by all tasks. 

Example : An organization needs many skills to meet it's organizational 
objectives. However, not all of the skills are present within the 
organizational network. This measure computes a value for this lack of 
skills as it is distributed across the organization as a whole.  

Input :  

Agent by Knowledge matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 

Knowledge by Task matrix with DataType=binary. 

Output : Graph Level with dataType=real 
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Organization Task Knowledge Waste Congruence 

Informal Name 

None 

Citation 

Lee, 2004 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

Across all agents, the knowledge that agents have that are not required to 
do their assigned tasks. 

Input :  

Agent by Knowledge matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 

Knowledge by Task matrix with DataType=binary. 

Output : Graph Level with dataType=real 

 
Organization Task Resource Needs Congruence 

Informal Name 
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None 

Citation 

Lee, 2004 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

MediumFast 

Description 

Across all tasks, the resources that tasks lack expressed as a percentage of 
the total resource needed by all tasks. 

Example : An organization needs many resources to meet it's 
organizational objectives. However, not all of the resources are present 
within the organizational network. This measure computes a value for 
this lack of resources as it is distributed across the organization as a 
whole.  

Input :  

Agent by Resource matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 

Resource by Task matrix with DataType=binary. 

Output : Graph Level with dataType=real 

 
Organization Task Resource Waste Congruence 

Informal Name 
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None 

Citation 

Lee, 2004 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

Across all agents, the resources that agents have that are not required to do 
their assigned tasks. 

Input :  

Agent by Resource matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 

Resource by Task matrix with DataType=binary. 

Output : Graph Level with dataType=real 

 
Out Degree Centrality 

Informal Name 

None 

Citation 

Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods 
and Applications." Cambridge: Cambridge University Press, 1994. 
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Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

For any node, (e.g. an individual or a resource), the out-links are the 
connections that the node of interest sends to other nodes. For example, 
imagine an agent by knowledge matrix then the number of out-links an 
agent would have is the number of pieces of knowledge it is connected to. 

The scientific name of this measure is out-degree and it is calculated on the 
agent by agent matrices. Individuals or organizations who are high in most 
knowledge have more expertise or are associated with more types of 
knowledge than are others. If no sub-network connecting agents to 
knowledge exists, then this measure will not be calculated. The scientific 
name of this measure is out degree centrality and it is calculated on agent 
by knowledge matrices. Individuals or organizations who are high in "most 
resources" have more resources or are associated with more types of 
resources than are others. If no sub-network connecting agents to resources 
exists, then this measure will not be calculated. The scientific name of this 
measure is out degree centrality and it is calculated on agent by resource 
matrices. 

Input : Square Agent by Agent matrix with dataType=real. 

Output : Node Level with DataType=real and Type=row. 

 
Out Degree Network Centralization 

Informal Name 

None 

Citation 
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NetStat 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

A centralization of a square network based on the Out-Degree Centrality of 
each node. 

Example : In a given organization, all employees have so many links to 
other employees. This is their out degree connections. This measure 
computes a value for the entire organization as a whole as to how 
central these connections are within the organization.  

Input : Square matrix with DataType=real. 

Output : Graph Level with DataType=real. 

 
Overall Task Completion 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002 

Minimum and Maximum Values 

Minimum : 0 



 

 
420 

 

Maximum : 1 

Computational Time 

Medium 

Description 

The percentage of tasks that can be completed by the agents assigned to 
them, based solely on whether the agents have the requisite knowledge and 
resources to do the tasks. 

NOTE : Task Completion Overall is a combination of the Task Completion 
Knowledge and the Task Completion Resource. 

Input :  

Agent by Knowledge matrix with dataType=binary. 

Agent by Resource matrix with dataType=binary. 

Agent by Task matrix with dataType=binary. 

Knowledge by Task matrix with dataType=binary. 

Resource by Task matrix with dataType=binary. 

Output : Graph Level with DataType=real 

 
Performance as Accuracy 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002 
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Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

Measures how accurately agents can perform their assigned tasks based on 
their access to knowledge and resources. 

Input :  

Agent by Knowledge matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 

Agent by Resource matrix with DataType=binary. 

Knowledge by Task matrix with DataType=binary. 

Resource by Task matrix with DataType=binary. 

Output : Graph Level with DataType=real 

 
Personnel Cost 

Informal Name 

None 

Citation 

Ashworth, M. and Carley, Kathleen, M., 2003, "Critical Human Capital, 
Working Paper, CASOS" Carnegie Mellon, Pittsburgh PA. 

Minimum and Maximum Values 
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Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

Total number of people reporting to an agent, plus its total knowledge, 
resources, and tasks. 

Personnel Cost is the sum of the in-degree centrality of all AA matrices in the 
graph (this computes the number of agents reporting to each agent), plus 
the out-degree centrality of any AK, AR, and AT graphs. 

Example : In a given organization, five employees report to Sue. All of 
the knowledge, resource and tasks connections attributed all the 
employees and Sue constitute Personnel Cost. This measure then 
computes a value for Sue based on all these connections of her 
employees. 

Input :  

Agent by Agent matrix with dataType=binary. 

Agent by Knowledge matrix with dataType=binary. 

Agent by Resource matrix with dataType=binary. 

Agent by Task matrix with dataType=binary. 

Output : Node Level with Type=agent and DataType=real. 

 
Pooled Link Count 

Informal Name 

None 
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Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

The percentage of pooled links in a unimodal network. A pooled is an link 
(i,j) such that there exists at least one other link (i,k) in the network, and k 
<> j. 

Let M be the adjacency matrix representation of a unimodal network. 

Let S = { (i,j) | M(i,j)=1 ∧ sum(M(:,j))>1 } 

In other words: edge (i,j) is a pooled edge iff the in-degree of entity j > 1. 

Then Pooled Edge Count = |S| / |E|. 

Example : A pooled edge in a network N=(V,E) is an edge (i,j)∈ E such 
that there exists at least one other edge (i,k) ∈ E, and k ≠ j. 

Input : Square matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Potential Boundary Spanner 

Informal Name 
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None 

Citation 

Cormen, Leiserson, Rivest, Stein 2001. "Introduction to Algorithms" Second 
Edition. Cambridge, MA: MIT Press, 2001. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

Individuals or organizations that connect groups are those that are 
connecting disconnected groups. The individual or organization may be 
connected to only one or a few members of each group. This is a composite 
measure that is high when the agent is potentially influential but is not in the 
know. This is calculated as the ration of betweenness centrality to total 
degree centrality and is calculated on agent by agent networks. 

Locates nodes that are high in betweenness centrality, but low in total 
degree centrality, and therefore potentially act as links between groups of 
entities. 

Example : This measures finds an individual who could likely have great 
potential to interact with other parts of an organization based on their 
existing connections. 

Input : Square matrix with DataType=binary and Directed=No. 

Output : Node Level and DataType=real 

 
Potential Workload 

Informal Name 
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None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 

Minimum :  

Maximum :  

Computational Time 

Medium 

Description 

Maximum knowledge and resources an agent could use to do tasks if it were 
assigned to all tasks. 

Input :  

Example : In a given organization, Bob is assigned all task that 
exist in the organization. This measure would compute a value 
expressing Bob's potential to carry out all the tasks based on his 
connections to the resources and knowledge needed for the tasks.  

Agent by Knowledge matrix with DataType=binary. 

Agent by Resource matrix with DataType=binary. 

Knowledge by Task matrix with DataType=binary. 

Resource by Task matrix with DataType=binary. 

Output : Node Level with DataType=real 

 
Radials 
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Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

Radial nodes have a triad count less than one standard deviation below the 
mean node triad count. 

Input : Square matrix with DataType=binary. 

Output : Node Level with DataType=binary. 

 
Reciprocal Link Count 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002 

Minimum and Maximum Values 
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Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

The percentage of links in a unimodal network that are reciprocated. A link 
(i,j) in the network is reciprocated if link (j,i) is also in the network. 

Let G=(V,E) be the graph representation of a network. 

Let S=card { (i,j) ∈ E | i <,(j,i) ∈ E } 

Then Reciprocal Edge Count = |S| / |E| 

Input : Square matrix with DataType=binary. 

Output : Graph Level with DataType=real 

 
Relative Cognitive Distinctiveness 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 
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Slow 

Description 

Measures the degree to which each pair of agents has complementary 
knowledge, expressed as the percent of total knowledge. Each value is 
normalized by the row sum. 

Input : Agent by Knowledge matrix with DataType=binary. 

Output : Dyad Level with Type=agent and DataType=real. 

 
Relative Cognitive Expertise 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

Measures the degree to which each pair of agents has complementary 
knowledge, expressed as a percentage of the knowledge of the first agent. 
Each value is normalized by the row sum. Individuals or organizations that 
are high in specialized knowledge are those that have expertise or are 
connected to types of knowledge that few others have. 

Input : Agent by Knowledge matrix with DataType=binary. 
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Output : Dyad Level with Type=agent and DataType=real. 

 
Relative Cognitive Resemblance 

Informal Name 

None 

Citation 

Carley, 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

Measures the degree to which each pair of agents has the exact same 
knowledge. Each value is normalized by the row sum. 

Input : Agent by Knowledge matrix with DataType=binary. 

Output : Dyad Level with Type=agent and DataType=real. 

 
Relative Cognitive Similarity 

Informal Name 

None 

Citation 
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Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

Measures the degree to which each pair of agents have overlapping 
knowledge. Each value is normalized by the row sum. 

Input : Agent by Knowledge matrix with DataType=binary. 

Output : Dyad Level with Type=agent and DataType=real. 

 
Relative Expertise 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 
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Description 

The degree of dissimilarity between agents based on shared knowledge. 
Each agent computes to what degree the other agents know what they do 
not know. Individuals or organizations that are high in specialized knowledge 
are those that have expertise or are connected to types of knowledge that 
few others have. The scientific name of this measure is relatively unique and 
it is calculated on agent by knowledge matrices. 

Input : Agent by Knowledge matrix with DataType=binary. 

Output : Node Level with Type=agent and DataType=real. 

 
Relative Similarity 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The degree of similarity between two agents based on shared knowledge. 
Each agent computes to what degree the other agents know what they 
know. 

Input : Agent by Knowledge matrix with DataType=binary. 
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Output : Node Level with Type=agent and DataType=real. 

 
Resource Access Index 

Informal Name 

None 

Citation 

Ashworth, M. and Carley, Kathleen M., 2003, "Critical Human Capital", 
Working Paper, CASOS, Carnegie Mellon, Pittsburgh PA. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

Boolean value which is true if an agent has exclusive access to a resource 
and who is known by exactly one other agent. The one agent known also has 
its KAI set to one. 

An node level measure that computes the average shortest path length 
between entities, excluding infinite distances. This is known as the Resource 
Access Index (RAI) value. 

Example : Let us imagine a social network where 50 employees have 
many connections to each other. The average number of connections per 
employee is the Access Index.  

Input :  

Agent by Agent matrix with DataType=binary 
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Agent by Resource with DataType=binary. 

Output : Node Level with Type=agent and DataType=binary. 

 
Resource Actual Workload 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: CMU 
2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The resources an agent uses to perform the tasks to which it is assigned. 

Input :  

Agent by Resource matrix withDataType=binary 

Resource by Task matrix with DataType=binary 

Agent by Task matrix with DataType=binary 

Output : Node Level with Type=agent and DataType=real. 
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Resource Congruence 

Informal Name 

None 

Citation 

Carley, Kathleen M. 2002 

Minimum and Maximum Values 

Minimum :  

Maximum :  

Computational Time 

Medium 

Description 

Measures the similarity between resources assigned to tasks via agents, and 
what resources are required to do tasks. Perfect congruence occurs when 
agents have resources when and only when it is needful to complete tasks. 

Input : Agent by Resource, Agent by Task, and Resource by Task 
matrices with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Resource Diversity 

Informal Name 

Who Has What 

Citation 
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Borgatti, S.P. 2003. The Key Player Problem. Dynamic Social Network 
Modeling and Analysis: Workshop Summary and Papers, R. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

The distribution of difference in resource sharing. This is the Herfindahl-
Hirshman index applied to column sums of AR. 

Example : Characterizes the network in terms of how the items in a 
resource network (who has what) are non-uniformly distributed across 
employees 

Input : Agent by Resource matrix with DataType=binary. 

Output : Graph Level with dataType=real 

 
Resource Exclusivity 

Informal Name 

None 

Citation 

Ashworth, 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 
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Computational Time 

Fast 

Description 

Detects agents who have singular resource access. 

Example : A key resource that supports an entire organization is only 
accessible through one person. 

Input : Agent by Resource matrix with DataType=binary. 

Output : Node Level with DataType=real and Type=agent. 

 
Resource Load 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

Average number of resources per agent. 



 

 
437 

 

Input : Agent by Resource matrix with DataType=binary 

Output : Graph Level with DataType=real. 

 
Resource Negotiation 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: CMU 
2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The extent to which agents need to negotiate with each other because they 
lack the resources to complete their assigned tasks. 

Example : In a given organization, Bob does not have access to the 
resources needed to complete a certain task but Sue does have it. Bob 
must negotiate with Sue to gain those resources. The extent to which 
others in the organization must negotiate for resources that others have 
is the organization's resource negotiation value. 

Input :  

Agent by Tasks matrix with DataType=binary. 
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Agent by Resource matrix with DataType=binary. 

Resource by Tasks matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Resource Omega 

Informal Name 

None 

Citation 

Carley, Kathleen M., Dekker, D., Krackhardt, D (2000). How Do Social 
Networks Affect Organizational Knowledge Utilization.  

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The degree to which agents reuse resources while doing their tasks. 

Example : Sue has X amount of tasks within her company. How many 
of those tasks that require a resource that can be used for one or more 
of her other tasks is omega knowledge. This measure computes a value 
for such relations to the resources at the network level.  

Input :  

Agent by Task matrix with DataType=binary. 

Resource by Task matrix with DataType=binary. 
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Task by Task matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Resource Potential Workload 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

Maximum resources an agent could use to do tasks if it were assigned to all 
tasks. 

Example : In a given organization, let us say Bob is assigned all task 
that exist in the organization. This measure would compute a value 
expressing Bob's potential to carry out all the tasks based on his 
connections to the resources and knowledge needed for the tasks.  

Input :  

Agent by Resource matrix with DataType=binary. 

Resource by Task matrix with DataType=binary. 
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Output : Node Level with Type=agent and DataType=real. 

 
Resource Redundancy 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : [(|R|-1)*|T|] 

Computational Time 

Fast 

Description 

Average number of redundant agents per resource. An agent is redundant if 
there is already an agent that has the resource. 

Input : Agent by Resource with dataType=binary. 

Output : Graph Level with dataType=real. 

 
Resource Task Completion 

Informal Name 

None 
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Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The percentage of tasks that can be completed by the agents assigned to 
them, based solely on whether the agents have the requisite resources to do 
the tasks. 

Example : Bob is assigned 10 Tasks to complete which require a certain 
amount of resources to finish. However, on average only 10-percent of 
those resources will be available to Bob for him to complete the tasks 
given. This measure would compute a value for the likelihood that Bob 
would be able to complete any given task. 

NOTE : Task Completion Overall is a combination of the Task Completion 
Knowledge and the Task Completion Resource. 

Input :  

Agent by Resource matrix with dataType=binary. 

Agent by Task matrix with dataType=binary. 

Resource by Task matrix with dataType=binary. 

Output : Graph Level with DataType=real 
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Resource Under Supply 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The extent to which the resources needed to do tasks are unavailable in the 
entire organization. 

Example : In an organization where Bob needs to complete Task A, he 
needs access to Resource B, which in this case might be a computer. 
However, what would happen if Resource B were simply unavailable? 
Say the computer was offline 50-percent of the time. This computer 
would likely under supply the task of completing Task A. This measure 
would compute a value to the effect that this under supply factor 
affected the ability to perform the task at hand.  

Input :  

Agent by Task matrix with dataType=binary. 

Agent by Resource matrix with dataType=binary. 
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Resource by Task matrix with dataType=binary. 

Output : Graph Level with DataType=real 

 
Row Breadth 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

The fraction of entities with row nodes with degree greater than one. 

Example : In a given organization, we have the following entities: 
employees (agents), computers (resources), benchmarks (tasks). This 
measure tells us on how many links greater than one exist within these 
entity types. 

Input : Matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Row Count 
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Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : Number of rows in the network 

Computational Time 

Fast 

Description 

The number of row nodes in a network. 

Input : Matrix with DataType=binary. 

Output : Graph Level with DataType=integer. 

 
Row Degree Centrality 

Informal Name 

None 

Citation 

Wasserman and Faust, 1994 

Minimum and Maximum Values 

Minimum : 0 
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Maximum : 1 

Computational Time 

Fast 

Description 

A centralization based on the degree of the row nodes of a network. 

Input : Matrix with DataType=real 

Output : Node Level with dataType=real and Type=row. 

 
Row Degree Network Centralization 

Informal Name 

None 

Citation 

NetStat 

Minimum and Maximum Values 

Minimum :  

Maximum :  

Computational Time 

Fast 

Description 

A centralization based on the degree of the row nodes of a network. 

Input : Matrix with DataType=real 
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Output : Graph Level with dataType=real and Type=row. 

 
Row Redundancy 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : [(N-1)*M] 

Computational Time 

Fast 

Description 

The mean number of row node links in excess of one. 

Example : Let us say in our organizational matrix, we have Bob 
who multiple links to Sue. Let us say this is multiple linkages has an 
average of 2.5 per employee to the same manager Sue or another. 
The measure computes a value for this average which is considering 
row redundancy.  

Input : Matrix with DataType=binary. 

Output : Graph Level with dataType=real. 
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Sequential Link Count 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

The percentage of links in a network that are neither Reciprocal Links nor 
Pooled Links. Note that an link can be both a Pooled and a Reciprocal link. 

Let G=(V,E) be the graph representation of a network, and let X = set of 
Pooled edges of G, and let Y = set of Reciprocal edges of G. 

Then Sequential Edge Count = | E-X-Y| / |E| 

Example : The percentage of edges in a network that are neither 
Reciprocal Edges nor Pooled Edges. Note that an edge can be both a 
Pooled and a Reciprocal edge. Self-loops are ignored. 

Input : Square matrix with DataType=binary. 

Output : Graph Level with DataType=real. 
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Shared Situation Awareness 

Informal Name 

None 

Citation 

Graham, 2004 

Minimum and Maximum Values 

Minimum : 0 

Maximum : Unscaled real number 

Computational Time 

Medium 

Description 

Individuals or organizations that are high in group awareness are those that 
by virtue of their connections to others, what resources they use, what 
knowledge there is, what tasks there are - have a better understanding of 
what others are doing. 

Example : If we take any given pair of actors in an organization, this 
measure computes a value for how similar they are to each other based 
on their relationships (i.e., links) to others in the same organization. 

Input : Agent by Agent matrix with dataType=binary. 

Agent by Agent matrix with dataType="binary" - label="Select an 
Interaction Matrix" 

Agent by Agent matrix with dataType="binary" - label="Select a 
Physical Proximity Matrix" 

Agent by Agent matrix with dataType="binary" - label="Select a 
Background Similarity Matrix" 
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Output :  

Node Level with Type=agent and DataType=real. 

Dyad Level with TargetType=agent and DataType=real. 

Formula :  

Let alpha, beta, delta, gamma, mu be Real numbers. 

Let A = Agent x Agent interaction/communication network. 

Let P = Agent x Agent physical proximity network. 

Let S = Agent x Agent social demographic similarity network. 

Let e = eigenvector centrality measure computed on A. 

Let G = geodesics between agents computed on A. 

Then the SSA measure between agents i and j is: 

SSA(i,j) = alpha*e[i]*e[j] + beta*P(i,j) + 
delta*S(i,j)/(gamma*G(i,j)) + mu*A(i,j)*A(j,i) 

 
Simmelian Ties 

Informal Name 

None 

Citation 

Krackhardt, David. 1998. "Simmelian Tie: Super Strong and Sticky." In 
Power and Influence in Organizations., edited by Roderick M. Kramer and 
Margaret Neale, pp. 21/38. Thousand Oaks, CA: Sage. 

Simmel, Georg. 1950. "The Sociology of Georg Simmel." New York: Free 
Press, 1st free press paperback edition. 

Minimum and Maximum Values 
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Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The normalized number of Simmelian ties of each node. 

Example : Described informally as ties embedded in cliques and are 
often associated with brokers inside such cliques such that if Bob and 
Susan only know of each other because of Chan and now all of them, 
Bob, Susan and Chan, now know each other. Chan, Bob, Susan now 
have simmelian ties to each other. 

Input : Square matrix with DataType=binary. 

Output : Node Level with dataType=real. 

 
Skip Link Count 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 
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Medium 

Description 

The fraction of links in a unimodal network that skip levels. An link (i,j) is a 
skip link if there is a path from node i to node j even after the link (i,j) is 
removed. 

A skip edge in a network G=(V,E) is an edge (i,j)∈E such that j is reachable 
from i in the graph G'=(V,E\(i,j)), that is, the graph G with edge (i,j) 
removed. Skip Count is simply the number of such edges in G normalized to 
be in [0,1] by dividing by |E|. 

Example : The fraction of edges in a unimodal network that skip levels. 
An edge (i,j) is a skip edge if there is a path from entity i to entity j even 
after the edge (i,j) is removed. 

Input : Square matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Social Technical Congruence 

Informal Name 

None 

Citation 

Cataldo et al, 2006 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 
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Description 

Social technical congruence represents the proportion of coordination 
requirements that were satisfied through some type of actual coordination 
activity carried out through some means of communication. 

A representation of the coordination requirements among the different 
workers is obtained by multiplying AT, TT and transpose of AT matrices. This 
product results in a people by people matrix where a cell ij indicates the 
extent to which person i works on tasks that share dependencies with the 
tasks worked on by person j. In other words, the resulting matrix represents 
the Coordination Requirements or the extent to which each pair of people 
needs to coordinate their work. 

Formally, the Coordination Requirements (CR) matrix is determined by the 
following product: 

Let, CR = AT * TT * transpose(AT) 

Given a particular CR matrix constructed from relating product dependencies 
to work dependencies, we can compare it to an Actual Coordination (CA) 
matrix that represents the interactions workers engaged in through different 
means of coordination. 

Diff (CR, CA) = card { diffij | crij> 0 & caij> 0 } 

|CR| = card { crij> 0 } 

We have, 

Congruence(CR, CA) = Diff (CR, CA) / |CR| 

Input :  

Agent by Agent matrix with DataType=binary 

Agent by Task matrix with DataType=binary 

Task by Task matrix with DataType=binary 

Output :  

Graph Level with dataType=real. 
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Dyad Level with Agent (source) by Agent (target) with 
DataType=real. 

 
Span of Control 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : ∈ℜ [0,|V|-1] 

Computational Time 

Fast 

Description 

The average number of out links per node with non-zero out degrees. 

Example : Bob has 5 out degree links to 5 other personnel in his 
company and of those 5 personnel, the average non-zero (i.e., people 
that make up that personnel that have out-degree links of there own) is 
4. Whereas Sue might have 5 personnel out degree links, but those 
personnel have 3 out-degree links themselves on average. It would 
figure that Sue might have a greater span of control, since the people 
she connects do, don't have as many connections as those that Bob 
connects to does. This measure would compute a value for such 
relationships called Span of Control. 

Input : Square matrix with DataType=binary. 
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Output : Graph Level with dataType=real. 

 
Spatial Betweenness Centrality 

Informal Name 

None 

Citation 

Olson, Mallory 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

The extent to which a node lies between other nodes that are far from each 
other. 

Input :  

Agent by Agent matrix with DataType=real. 

Agent by Location matrix with DataType=real. 

Output : Node Level with Type=agent and DataType=real 

 

 
Spatial Closeness Centrality 
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Informal Name 

None 

Citation 

Olson, Mallory 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

The extent to which a node is close to the other nodes both in the network 
and in space 

Input :  

Agent by Agent matrix with DataType=real. 

Agent by Location matrix with DataType=real. 

Output : Node Level with Type=agent and DataType=real 

 
Spatial Degree Centrality 

Informal Name 

None 

Citation 

Olson, Mallory 
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Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

The total distance from a node to its neighbors 

Input :  

Agent by Agent matrix with DataType=real. 

Agent by Location matrix with DataType=real. 

Output : Node Level with Type=agent and DataType=real 

 
Spatial Eigenvector Centrality 

Informal Name 

None 

Citation 

Olson, Mallory 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 
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Slow 

Description 

The sum of the eigenvector centralities of all nodes located at a place. 
Intuitively, the likelihood of arriving at a node at a particular location in a 
random walk. 

Input :  

Agent by Agent matrix with DataType=real. 

Agent by Location matrix with DataType=real. 

Output : Node Level with Type=location and DataType=real 

 
Strict Knowledge Congruence 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 
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Measures the similarity between what knowledge are assigned to tasks via 
agents, and what knowledge are required to do tasks. Perfect congruence 
occurs when agents have access to knowledge when and only when it is 
needful to complete tasks. 

Knowledge Congruence = 1 iff agents have knowledge when and only when 
it is needful to complete their tasks. Thus, we compute the knowledge 
assigned to tasks via agents, and compare it with the knowledge needed for 
tasks. 

Input :  

Agent by Knowledge matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 

Knowledge by Task matrix with DataType=binary. 

Output : Graph Level with dataType=real. 

 
Strict Resource Congruence 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 
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Description 

Measures the similarity between resources assigned to tasks via agents, and 
what resources are required to do tasks. Perfect congruence occurs when 
agents have resources when and only when it is needful to complete tasks. 

Knowledge Congruence = 1 iff agents have knowledge when and only when 
it is needful to complete their tasks. Thus, we compute the knowledge 
assigned to tasks via agents, and compare it with the knowledge needed for 
tasks. 

Input :  

Agent by Resource matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 

Resource by Task matrix with DataType=binary. 

Output : Graph Level with dataType=real. 

 
Strong Component Count 

Informal Name 

None 

Citation 

Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods 
and Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 
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Description 

The number of strongly connected components in a network. The network 
can be directed or undirected. 

Given a square network G=(V,E), the Strong Component Count is the 
number of strongly connected components in G. This is computed directly on 
G, whether or not G is directed.  

Input : Square matrix with DataType=binary. 

Output : Graph Level with dataType=integer. 

 
Task Exclusivity 

Informal Name 

None 

Citation 

Ashworth, 2002 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

Detects agents who exclusively perform tasks. Individuals or organizations 
that are high in complete exclusivity for tasks are those that are engaged in 
or assigned to tasks or activities for which no one else is engaged in or 
assigned to. The scientific name of this measure is complete exclusivity and 
it is calculated on agent by task matrices. 
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Input : Agent by Task matrix with DataType=binary. 

Output : Node Level with DataType=real and Type=agent. 

 
Task Knowledge Needs Congruence 

Informal Name 

None 

Citation 

Lee, 2004 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The number of knowledge not supplied to a task, but required to do the 
task, expressed as a percentage of the total knowledge required for the 
task. 

Task Knowledge Needs compares the knowledge requirements of each task 
with the knowledge available to the task via agents assigned to it. It is 
similar to Knowledge Congruence, but quantifies only the under supply of 
knowledge to tasks. 

Input :  

Agent by Knowledge matrix with dataType=binary. 

Agent by Task matrix with dataType=binary. 
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Knowledge by Task matrix with dataType=binary. 

Output : Node Level with Type=Task and dataType=real 

 
Task Knowledge Waste Congruence 

Informal Name 

None 

Citation 

Lee, 2004 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The number of knowledge supplied to a task via agents that are not required 
by it expressed as a percentage of the total knowledge required for the task. 

Task Knowledge Waste compares the knowledge requirements of each task 
with the knowledge available to the task via agents assigned to it. It is 
similar to Knowledge Congruence, but quantifies only the over supply of 
knowledge to tasks. 

Input :  

Agent by Knowledge matrix with dataType=binary. 

Agent by Task matrix with dataType=binary. 

Knowledge by Task matrix with dataType=binary. 
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Output : Node Level with Type=task and DataType=real. 

 
Task Resource Needs Congruence 

Informal Name 

None 

Citation 

Lee, 2004 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The number of resources not supplied to a task, but required to do the task, 
expressed as a percentage of the total resources required for the task. 

Task Knowledge Needs compares the knowledge requirements of each task 
with the knowledge available to the task via agents assigned to it. It is 
similar to Knowledge Congruence, but quantifies only the under supply of 
knowledge to tasks. 

Input :  

Agent by Resource matrix with dataType=binary. 

Agent by Task matrix with dataType=binary. 

Resource by Task matrix with dataType=binary. 

Output : Node Level with Type=task DataType=real. 
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Task Resource Waste Congruence 

Informal Name 

None 

Citation 

Lee, 2004 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The number of resources supplied to a task via agents that are not required 
by it expressed as a percentage of the total resources required for the task. 

Task Knowledge Waste compares the knowledge requirements of each task 
with the knowledge available to the task via agents assigned to it. It is 
similar to Knowledge Congruence, but quantifies only the over supply of 
knowledge to tasks. 

Input :  

Agent by Resource matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 

Resource by Task matrix with DataType=binary. 

Output : Node Level with Type=task and DataType=real. 
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Total Degree Centrality 

Informal Name 

In The Know 

Citation 

Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods 
and Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

The Total Degree Centrality of a node is the normalized sum of its row and 
column degrees. Individuals or organizations who are "in the know" are 
those who are linked to many others and so, by virtue of their position have 
access to the ideas, thoughts, beliefs of many others. Individuals who are "in 
the know" are identified by degree centrality in the relevant social network. 
Those who are ranked high on this metrics have more connections to others 
in the same network. The scientific name of this measure is total degree 
centrality and it is calculated on the agent by agent matrices. 

Individuals or organizations who are "in the know" are those who are linked 
to many others and so, by virtue of their position have access to the ideas, 
thoughts, beliefs of many others. Individuals who are "in the know" are 
identified by degree centrality in the relevant social network. 

Input : Square Agent by Agent Matrix with dataType=real. 

Output : Node Level with dataType=real. 
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Total Degree Centralization 

Informal Name 

None 

Citation 

Freeman, L.C. (1979). Centrality in Social Networks I: Conceptual 
Clarification. Social Networks, 1, 215-239.  

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Description 

A centralization of a square network based on the Total-Degree Centrality of 
each node. 

Example : An organization has a sales team, computers, sales data and 
a marketing team. How central all of these entities are within the 
organization is its total degree network centralization value. 

Input : Square matrix with DataType=real. 

Output : Graph Level with DataType=real. 

 
Transitivity 

Informal Name 
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None 

Citation 

NetStat 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

The percentage of link pairs {(i,j), (j,k)} in the network such that (i,k) is 
also an link in the network. 

Example : The percentage of pairs in the employee communication 
network where employee A is linked to B and B is linked to C and C is 
also linked to A 

Input : Square matrix with DataType=binary. 

Output : Graph Level with DataType=real 

 
Triad Count 

Informal Name 

None 

Citation 

NetStat 

Minimum and Maximum Values 
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Minimum : 0 

Maximum : Integer (N-1) (N-2) 

Computational Time 

Medium 

Description 

The number of triads centered at each node in a square network. A triad is a 
relationship amongst three nodes such that they constitute a distinct and 
important relationship which is deemed relevant to network architecture. 

Input : Square matrix with DataType=binary. 

Output : Node Level with DataType=integer. 

 
Upper Boundedness 

Informal Name 

None 

Citation 

Krackhardt, D. 1994. Graph Theoretical Dimensions of Informal 
Organizations. In Computational Organization Theory, edited by Carley, 
Kathleen M. and M.J. Prietula. Hillsdale, NJ: Lawrence Erlbaum Associates, 
1994. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 
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Description 

The degree to which pairs of agents have a common ancestor. 

Example : In a given organization, if Bob and Ahmed were both hired 
by Pedro this measure would compute a value correlating to this shared 
ancestry or linkage that both have to Pedro. 

Input : Square matrix with DataType=binary. 

Output : Graph Level with DataType=real. 

 
Watts-Strogatz Clustering Coefficient 

Informal Name 

None 

Citation 

Watts DJ, Strogatz SH "Collective dynamics of 'small-world' networks" 
NATURE 393 (6684): 440-442 JUN 4 1998.  

Minimum and Maximum Values 

Values for both Graph Level and Node Level 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Description 

Measures the degree of clustering in a network by averaging the clustering 
coefficient of each node, which is defined as the density of the node's ego 
network. 
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Example : The average of the proportion of links between each 
employee and his or her direct neighbors divided by the number of links 
that could possibly exist between them. 

The clustering coefficient gives a sense of the local characteristics of the 
network--how information spreads by means of employee groups. A higher 
clustering coefficient supports local information diffusion as well as a 
decentralized infrastructure because employees are likely to share 
information and know what is happening in their work group. 

Input : Square matrix with DataType=binary. 

Output : Both Graph Level and Node Level use produce DataType=real. 

 
Weak Boundary Spanner 

Informal Name 

None 

Citation 

Cormen, Leiserson, Riverest, Stein, 2001 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Description 

A node which if removed from a network creates a new component. 

Input : Square matrix with DataType=binary and Directed=No. 

Output : Node Level with dataType=binary. 
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Weak Component Count 

Informal Name 

None 

Citation 

Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods 
and Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : Integer Value 

Computational Time 

Medium 

Description 

The number of weakly connected components in an undirected (symmetric) 
network. 

Input : Square matrix with DataType=binary and Directed=No. 

Output : Graph Level with dataType=integer. 

 
Weak Component Members 

Informal Name 

None 

Citation 
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Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods 
and Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : Any Integer Value 

Computational Time 

Medium 

Description 

Computes the component to which each node belongs in the underlying, 
undirected network. 

Example : Given a square, symmetric network G=(V,E), the Weak 
Component Member for a entity is the weak component to which the 
entity belongs. The components are numbered from 1 to the number of 
weak components (Weak Component Count). 

Input : Square matrix with DataType=binary. 

Output : Node Level with DataType=integer. 

 
Report Overview 

Description 

Reports are one of ORA's core functions and comprise a very powerful 
feature in ORA. There are two ways to access the reports. 1) From the main 
menu Analysis > Generate Reports and 2) The Reports button in the 
main window. 

Categories 

ORA reports are divided into groups. 
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Knowledge Networks & Network Text Analysis : Communications 
Network Assessment, Communicative Power, Group Talk, Hot Topics, Large 
Scale, Parts of Speech, Semantic Network. 

Statistical Procedures and Diagnostics : Context, Missing Links, Potential 
Errors, QAP, Statistical Change Detection, Statistical Distribution. 

Geospatial : Geospatial Assessment, Key Entity, Trails, Unique Trails 
Report. 

Groups : Core Network, Local Patterns, Locate SubGroups. 

Dynamics : Belief Propagation, Change in Key Entities, Immediate Impact, 
QAP, Statistical Change Detection. 

Specialty : Capabilities, Drill Down, Influence Net, Merchant Marine, 
Optimizer, Public Health, Tactical Insight, Trails Analysis. 

Locate Key Entities : Change in Key Entities, Communicators, Critical Sets, 
Key Entity, Management, Simmelian Ties Analysis. 

Locate Key Relations : Shortest Path 

All Measures :  

 
Belief All Measures 

Description : 

Computes a collection of measures and generates output in categories. Each 
category analyzes a particular aspect of the meta-network structure. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 
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Belief Propagation 

Description : 

Estimates belief propagation through social networks. This report contains 
the most common beliefs shared by most people, the beliefs with the highest 
GINI coefficient, the most strongly held beliefs, the most likely to change 
beliefs, the most neutral individuals, and the most opinionated individuals. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

Single Meta-Network, multiple Meta-Network comparison. 

 
Capabilities 

Description : 

Analyzes the knowledge, resource, and task capabilities of agents and 
organizations in the network. 

Why Use This Report : 

To assess an individuals' or organizations' capability to perform tasks. 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 
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Output : 

Single Meta-Network, side-by-side comparison, multiple Meta-Network 
comparison. 

 
Change In Key Entities 

Description : 

Analyzes the changes over time of the agents that score highest in measure 
values. 

Why Use This Report : 

This report provides information on the overall structure of a complex 
network and identifies, for each type of node, which nodes stand out. A 
complex network typically is a meta-network with multiple types of entities 
such as people, expertise, resources and locations. Overall structure is 
defined using meta-network metrics such as Overall Complexity, Social 
Density, Social Fragmentation, Communication Congruence, Knowledge 
Congruence, Performance as Accuracy, and Average Communication Speed. 
Key entities within each of the component networks are identified in terms of 
metrics such as Degree Centrality, Cognitive Demand, Specialization, and 
Redundancy. Separate key-entity pages are produced for each type of 
entity. For example, if there are people and resources - then key people and 
key resources are both identified. If the user selects two or more networks, 
this report will compare the results. 

What networks are in the meta-network : 

When are needed to run report : 

At least two networks. 

Using the "don't run the time consuming measures" : 

Output : 

Single Meta-Network. 
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Communications Network Assessment 

Description : 

This report assesses a communications network. As information on speed of 
information transmittal becomes available it will be updated. This report 
takes a resource by resource network (preferably one where the nodes are 
communications devices and the links are the speed of reliability of the link). 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

  

 
Communicative Power 

Description : 

Analyzes one or more semantic networks to classify concepts by measure 
values. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 
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Single Meta-Network, side-by-side comparison, multiple Meta-Network 
comparison. 

 
Communicators 

Description : 

Analyzes the communication network (agent by agent) and gives high level 
statistics on its structure. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

Single Meta-Network, side-by-side comparison. 

 
Context 

Description : 

Compares measured values against various stylized forms of networks in an 
effort to characterize network topology. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 
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Output : 

Single Meta-Network. 

 
Core Network 

Description : 

Computes the core network and reports general statistics. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

Single Meta-Network, side-by-side comparison. 

 
Critical Sets 

Description : 

Finds critical sets of nodes in a network that best reach all other nodes, or 
whose removal maximally disrupts a network. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 
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Output : 

Single Meta-Network. 

 
Custom 

Description : 

Computes a custom report with user selected measures and output tables, 
pictures, and figures. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

A single Meta-Network. 

 
Drill Down 

Description : 

Computes the drill down from a selected organization and then to a selected 
agent. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 
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Output : 

A single Meta-Network. 

 
Geospatial Assessment 

Description : 

Finds nodes that are co-located based, and counts the number of nodes that 
appear at location points. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

A single Meta-Network. 

 
Group Talk 

Description : 

Analyzes the relationship between agents and knowledge. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 
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Output : 

A single Meta-Network. 

 
Hot Topics 

Description : 

Analyzes semantic network output from AutoMap. 

Why Use This Report : 

When you have semantic network data or lists of concepts, networks derived 
from email content, or texts or documents of any sort. 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

Single Meta-Network, multiple Meta-Network comparison. 

 
Immediate Impact 

Description : 

Computes the key actors of the network, and then isolates them individually 
to determine the effect on measure values. 

Why Use This Report : 

This report allows the user to engage in what if analysis about the 
immediate impact of removing one or more nodes. Comparative statistic 
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techniques are used to assess the network with and without the nodes in 
question. 

The user identifies a network, identifies which node or nodes to remove, and 
then ORA computes the consequent changes in the network by removing 
those nodes in terms of overall network structure and key entities. A feature 
of this report is that the user can save the meta-network with the removed 
nodes and then assess the modified network with any of the other reports. 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

Single Meta-Network. 

 
Influence Net 

Description : 

Displays the influence network and gives high level statistics on its structure. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

A single Meta-Network. 
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Key Entity 

Description : 

Identifies key entities and groups who by virtue of their position in the 
network are critical to its operation. 

Why Use This Report : 

This report performs a network-level report to find Overall Complexity, 
Social Density, Social Fragmentation, Communication Congruence, 
Knowledge Congruence, Performance as Accuracy, and Avg Communication 
Speed. (Replaces the Event Analysis, Intelligence, and Location Analysis 
Reports). 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

Single Meta-Network, side-by-side comparison, multiple Meta-Network 
comparison. 

 
Large Scale 

Description : 

Computes all network analysis measures. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 
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Using the "don't run the time consuming measures" : 

Output : 

A single Meta-Network. 

 
Local Patterns 

Description : 

Find link patterns in a network, such as Star, Checkerboard, and Clique. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

A single Meta-Network. 

 
Locate SubGroups 

Description : 

Identifies the subgroups present in the network using various grouping 
algorithms. Most algorithms only work on a single network at a time 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 
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Output : 

 
Management 

Description : 

Identifies over- and under- performing individuals and assesses the state of 
the network as a functioning organization. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

A single Meta-Network, multiple Meta-Network comparison. 

 
Merchant Marine 

Description : 

Analyzes the relationship between crew members, owners, vessels, and 
locations of the Merchant Marine Vessel data. 

Why Use This Report : 

Used with a special data-set developed by CASOS.  

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 
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Output : 

A single Meta-Network. 

 
Missing Links 

Description : 

Compute possible missing links in a network. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

A single Meta-Network. 

 
Optimizer 

Description : 

Adapt the link structure of a Meta-Network to maximize or minimize selected 
measure values. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 
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Output : 

A single Meta-Network. 

 
Part of Speech 

Description : 

Describe the distribution of concepts by part of speech in one or more 
networks. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

Single Meta-Network, multiple Meta-Network comparison. 

 
Potential Errors 

Description : 

Detects potential errors in agent to agent interactions based on the expected 
interactions from cognitive similarity and expertise. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 
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Output : 

A single Meta-work. 

 
Public Health 

Description : 

Analyzes health department data to find potential problems. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

A single Meta-Network. 

 
QAP/MRQAP Analysis 

Description : 

Computes QAP and MRQAP Correlation and Regression (Dekker and Y-
Permutation methods) on input networks. 

MRQAP : Used for multivariate cases if your dependent variable is 
continuous or count data (like in a negative binomial case), you should use 
MRQAP. If your dependent variable is binary, you should use ERGM (P*) 
which is forthcoming in ORA. One can perform MRQAP on data that have a 
dichotomous dependent variable (basically, this is equivalent to using a 
linear probability model). You do need to interpret your results accordingly. 

QAP Analysis : Computes QAP Correlation and Regression (Dekker and Y-
Permutation methods) on input matrices. QAP is designed as a bivariate test 
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(only two variables). Generally, QAP is perfectly fine for almost any bivariate 
network problem. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

A single Meta-Network. 

 
Semantic Network 

Description : 

Analyzes one or more semantic networks, computing central networks and 
key concepts and links. 

Why Use This Report : 

Assesses the connection among concepts. Will derive networks from email 
content, texts, or documents of any sort. 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

Single Meta-Network, side-by-side comparison. 
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Shortest Path 

Description : 

Computes the shortest path between two entities and general statistics on 
the paths. The sphere of influence of each entity is also computed. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

A single Meta-Network. 

 
Simmelian Ties Analysis 

Description : 

Calculates the number of Asymmetric, Sole-Symmetric, and Simmelian Ties 
in unimodal networks computes standard measures on them. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

A single agent by agent or actor by actor network. 

Using the "don't run the time consuming measures" : 

Output : 
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Sphere of Influence 

Description : 

For each individual, identifies the set of actors, groups, knowledge, 
resources, etc. that influence, and are influenced, by that actor. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Any network. But it's most interpretable if you have an agent by agent and 
also have another network such as agent by knowledge or agent by 
resources or agent by location. 

Using the "don't run the time consuming measures" : 

Output : 

Single Meta-Network. 

 
Standard Network Analysis 

Description : 

Calculates the standard network analysis measures (Degree Centrality, 
Betweenness, etc). 

This report calculates the standard network analysis measures such as 
Degree Centrality, Betweenness Centrality, etc. This report can be used on 
any "square network" where all the nodes are of one type; e.g., a people x 
people or resource x resource network. The standard network analysis 
measures typically provide an analyst with a broad overall picture of the 
structure of the network. If the user selects two or more networks, this 
report will compare the results. 
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Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

Single Meta-Network, side-by-side comparison. 

 
Statistical Change Detection 

Description : 

Analyzes the changes in network-level measures over time using a Statistical 
Process Monitoring (SPM) control chart. Control limits are determined based 
on a user defined level of risk. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

Single Meta-Network, multiple Meta-Networks. 

 
Statistical Distribution 

Description : 

Fits statistical distributions to a network based on measure values. 
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Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

A single Meta-Network. 

 
Tactical Insight 

Description : 

Analyzes the top agent nodes across time periods, tracking locations and 
measure values. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

At least three networks. 

Using the "don't run the time consuming measures" : 

Output : 

Single Meta-Network, Multiple Meta-Network comparison. 

 
Trails 

Description : 
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Analyzes the trails that an entity class makes through another entity class, 
for example, how vessels pass through ports. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

At least two networks. Also requires data in trails format so who/what was 
where when. Could also be who/what interacted with who/what when. 

Using the "don't run the time consuming measures" : 

Output : 

A single Meta-Network. 

 
Trails Analysis 

Description : 

Analyzes the trails that are found in the Trails Viewer. It does this by 
analyzing the trails of one nodeclass as it makes its way through another 
nodeclass (e.g. how vessels pass through ports). 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

A single Meta-Network with multiple Meta-Network comparison. 
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Unique Trails Report 

Description : 

Analyzes the path of an entity class through locations over time. 

Why Use This Report : 

What networks are in the meta-network : 

When are needed to run report : 

Using the "don't run the time consuming measures" : 

Output : 

A single Meta-Network. 
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	Entity Level Measure is one that is defined for, and gives a value for, each entity in a network. If there are x nodes in a network, then the metric is calculated x once each for each node.
	Graph Level Measure is one that is defined for, and gives a value for, the network as a whole. The metric is calculated once for the network.
	Examples are Centralization, Graph Hierarchy, and the maximum or average Betweenness
	Some reports use a predefined set of measures, and these are not affected by the Measure Manager selections (for example, the Intel, Context, Located SubGroups, Sphere of Influence, and Immediate Impact reports). The Risk Report, however, uses only th...
	The following sets of entities (with their abbreviated symbol) are used throughout the document: Agent (A), Knowledge (K), Resource (R), and Task (T). The following networks defined on these entity sets are used throughout the documentation.


	Input:
	This lists each of the Networks that are required as input to the measure. If a measure takes as input a specific network from the Meta-Network, such as the Agent x Knowledge (AK) matrix, then it is listed. If the measure runs on any square (unimodal)...
	Each input matrix can have one or more of the following requirements:
	square: the matrix must have the same number of rows as columns
	binary: it must be binary data (i.e. any links in the network are assumed to have a weight of one)
	symmetric: the network must be undirected
	ORA does the following when a network does not meet one or more of the above requirements:
	square: measure is not computed
	binary: measure is computed, and edge weights are ignored (all edges are given value one)
	symmetric: measure is computed, and the matrix is first symmetrized using the union method
	A complete list of all measures available in ORA, along with references, input and output specifications, can be found in the following ORA Measures sections.
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	NOTE : Task Completion Overall is a combination of the Task Completion Knowledge and the Task Completion Resource.
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